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Preface

Thank you for purchasing the WINCAPSII. It is designed for efficient program development and
verification of the DENSO robot on your PC connected to the robot controller (NetwoRC).

WINCAPSII also makes it possible to verify robot programs and data at a remote location via
telephone line.

On your PC, WINCAPSII allows you to simulate robot motions, variables, I/Os or manage
program files in units of project, helping you easily develop and manage programs.

Before using WINCAPSII, read this manual carefully to safely get the maximum benefit from
your WINCAPSII system.

Version compatibility between WINCAPSII and robot controller software (OS)
WINCAPSII is compatible with the same or earlier versions of the robot controller OS.

WINCAPSII version 1.0 is compatible with robot controller OS version 1.0.
WINCAPSII version 1.1 is compatible with robot controller OS versions 1.0 and 1.1.
WINCAPSII version 1.2 is compatible with robot controller OS versions 1.0, 1.1, and 1.2

If your Robot Controller is newer than WINCAPS 1l in software version, upgrade the
WINCAPS Il version using the DENSO Robot NetwoRC CD packaged together with the
Robot Controller.

WINCAPSII version is printed on the label of the WINCAPSII floppy disk or compact
disk. For the checking procedure of robot controller OS version, refer to the OWNER'S
MANUAL of your robot.
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Important

To ensure operator safety, be sure to read the precautions and instructions in "SAFETY
PRECAUTIONS" pages 1 through 9.

NOTICE TO USER

DENSO WAVE INCORPORATED grants you a non-exclusive, non-transferable license to use
WINCAPSII ("Software").

1. COPYRIGHT

(1) The Software is protected by copyright laws and international copyright treaties, as well as
other intellectual property laws and treaties.

(2) All title and copyrights in and to the Software, the accompanying printed materials, and any
copies of the Software are owned by DENSO WAVE INCORPORATED.

2. GRANT OF LICENSE
(1) You may use one copy of the Software on a single computer at one time.

(2) You may either make one copy of the Software solely for backup or archival purposes, or
install the Software on a single computer provided you keep the original solely for backup or
archival purposes.

3. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS
(1) You shall not rent, lease, sell, sublicense, assign, or otherwise transfer the Software.

(2) You shall not reverse engineer, decompile, disassemble, merge, modify or translate the
Software.

4. LIMITED WARRANTY

(1) If the Software disk is defective or the accompanying documentation is defective (e.g.,
omissions), the entire and exclusive liability and remedy shall be limited to either the repair or
replacement of the Software. This warranty is limited to two month period following your
receipt of the Software.

(2) In no event shall DENSO WAVE INCORPORATED be liable for any consequential,
incidental or special damages, including any lost profits or lost savings, even if a DENSO
WAVE INCORPORATED representative has been advised of the possibility of such
damages, or for any claim by any third party.
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The WINCAPS Il package consists of the following.

Software

Instruction Manuals

< CD-ROM version>

WINCAPS Il GUIDE
(this book)

<Floppy disk version>
%

—

NN

Note: The CD-ROM
version contains this
book in the PDF file
format.

5. Required operating environments

The following operating environments are required for running WINCAPSII smoothly.

Table 3-5 Operating Environments for the PC Teaching System Software

CPU Pentium or higher capacity

(O1S) Windows 95 or upper version (See Note 1.)

Memory 32 MB or more (64 MB recommended)

Hard disk A free area of 80 MB or more is required at installation.
Monitor resolution 640 x 480 or higher

Note 1  WINCAPS cannot run properly on earlier versions of Windows 95.

The version of Windows 95 can be checked with [Control Panel —
System — Information]. If A, B or Cis not displayed (no symbol) at
the end of the version information (4.00, 95B), update your
Windows 95 with the Windows 95 Service Pack 1 that is available
from the Microsoft's web site.
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Before Using WINCAPS 11

1. Release restrictions on WINCAPS Il functions

Without entry of User ID, WINCAPS Il does not operate except “PRO1”, which is designed to
operate for the trial purpose. On activation of WINCAPS I, the license information screen appears.
Enter User ID printed in the license card.

2. Store the license card with care

The User ID printed in the license card is your purchased product number. The User ID is needed
when you receive after-sales service. Keep the license card with care.
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How the documentation set is organized

The documentation set consists of the following six books. If you are unfamiliar with this robot series,
please read all four books and understand them fully before operating your robot.

BEGINNER’S GUIDE

Explains the outline of DENSO robot, operation with the teach pendant, and programming
with WINCAPS Il by giving practical examples. Use this guidebook when you want to know
the fundamental usage of the robot.

INSTALLATION & MAINTENANCE GUIDE

Explains the outline of robot, installation of the robot components, and their maintenance and
inspection procedures.

SETTING-UP MANUAL - operation of the teach pendant, mini-pendant and operating panel -

Explains the basic operations and auxiliary functions of your robot, and operation of optional
equipment.

WINCAPS Il GUIDE - this book -

Explains how to use the personal computer teaching system, which allows you to develop and
manage the robot operation programs from your PC connected to the robot and the robot
controller.

PROGRAMMER’S MANUAL
Explains the programming language (PAC), programming method with PAC, and command
specifications.

ERROR CODE TABLES

Lists the error codes displayed on the teach pendant, mini-pendant, operating panel, or
personal computer screen when an error occurs in the robot or WINCAPS II. This book also
provides explanation of and remedy for individual errors.
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How this book is organized

This book is just one part of the documentation set. It consists of SAFETY PRECAUTIONS, ten
chapters, appendices, and index

SAFETY PRECAUTIONS

Defines safety terms and related symbols and provides precautions to be observed. Be sure to read
this section before operating your robot.

Chapter 1 Outline of Personal Computer Teaching System

Describes the configuration of the personal computer teaching system and its features.

Chapter 2 Setting Personal Computer Teaching System

Describes how to make connections and setting of the personal computer teaching system.

Chapter 3 Starting Teaching System and Knowing Each Manager

Describes the procedures for starting and terminating the personal computer teaching system and
outlines the functions of each Manager.

Chapter 4 System Manager

Describes the functions and operation of the system manager that constitutes the nucleus of
WINCAPSII software to be used for the personal computer teaching system.

Chapter 5 Operating PAC Program Manager

Describes PAC Program Manager of WINCAPSII software functions.

Chapter 6 Operating Variable Manager

Describes Variable Manager of WINCAPSII software functions.

Chapter 7 Operating DIO Manager

Describes DIO Manager of WINCAPSII software functions.

Chapter 8 Operating Arm Manager

Describes Arm Manager of WINCAPSII software functions.

Chapter 9 Operating Vision Manager

Describes Vision Manager of WINCAPSII software functions.

Vi
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Chapter 10 Operating Log Manager

Describes Log Manager of WINCAPSII software functions.

Index

Vii






SAFETY PRECAUTIONS

SAFETY PRECAUTIONS

Be sure to observe all of the following safety precautions.

Strict observance of these warning and caution indications are a MUST for preventing accidents, which
could result in bodily injury and substantial property damage. Make sure you fully understand all
definitions of these terms and related symbols given below, before you proceed to the text itself.

A WARNING Alerts you to those conditions, which could result

in serious bodily injury or death if the instructions
are not followed correctly.

A CAUTION Alerts you to those conditions, which could result

in minor bodily injury or substantial property
damage if the instructions are not followed
correctly.

Terminology and Definitions

Maximum space: Refers to the volume of space encompassing the maximum designed movements of
all robot parts including the end-effector, workpiece and attachments. (Quoted from the RIA*
Committee Draft.)

Restricted space: Refers to the portion of the maximum space to which a robot is restricted by limiting
devices (i.e., mechanical stops). The maximum distance that the robot, end-effector, and workpiece
can travel after the limiting device is actuated defines the boundaries of the restricted space of the
robot. (Quoted from the RIA Committee Draft.)

Motion space: Refers to the portion of the restricted space to which a robot is restricted by software
motion limits. The maximum distance that the robot, end-effector, and workpiece can travel after the
software motion limits are set defines the boundaries of the motion space of the robot. (The "motion
space" is Denso-proprietary terminology.)

Operating space: Refers to the portion of the restricted space (or motion space in Denso) that is
actually used by the robot while performing its task program. (Quoted from the RIA Committee Draft.)

Task program: Refers to a set of instructions for motion and auxiliary functions that define the specific
intended task of the robot system. (Quoted from the RIA Committee Draft.)

(*RIA: Robotic Industries Association)



1. Introduction

2. Installation Precautions

2.1 Insuring the proper
installation environment

2.1.1 For standard type

2.1.2 For dust-proof, splash-
proof type

2.2 Service space

This section provides safety precautions to be observed during
installation, teaching, inspection, adjustment, and maintenance
of the robot.

The standard type has not been designed to withstand
explosions, dust-proof, nor is it splash-proof. Therefore, it
should not be installed in any environment where:

(1) there are flammable gases or liquids,

(2) there are any shavings from metal processing or other
conductive material flying about,

w

there are any acidic, alkaline or other corrosive gases,

N

there is cutting or grinding oil mist,
it may likely be submerged in fluid,

(2]

there is sulfuric cutting or grinding oil mist, or
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there are any large-sized inverters, high output/high
frequency transmitters, large contactors, welders, or other
sources of electrical noise.

The dust-proof, splash-proof type is an IP54-equivalent dust-
proof and splash-proof structure, but it has not been designed
to withstand explosions. (The wrist of the VM-D-W or VS-E-W
is an IP65-equivalent dust-proof and splash-proof structure.)

Note that the robot controller is not a dust- or splash-proof
structure. Therefore, when using the robot controller in an
environment exposed to mist, put it in an optional protective
box.

The dust-proof, splash-proof type should not be installed in any
environment where:

(1) there are any flammable gases or liquids,
(2) there are any acidic, alkaline or other corrosive gases,

(3) there are any large-sized inverters, high output/high
frequency transmitters, large contactors, welders, or other
sources of electrical noise,

C

it may likely be submerged in fluid,

—
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there are any grinding or machining chips or shavings,

—
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~

any machining oil other than DENSO authorized oil is in
use, or

Note: DENSO authorized oil: Yushiron Oil No. 4C (non-
soluble)

(7) there is sulfuric cutting or grinding oil mist.

The robot and peripheral equipment should be installed so that
sufficient service space is maintained for safe teaching,
maintenance, and inspection.



SAFETY PRECAUTIONS

2.3 Control devices
outside the robot's
restricted space

2.4 Positioning of gauges

2.5 Protection of electrical
wiring and
hydraulic/pneumatic
piping

2.6 Positioning of
emergency stop
switches

2.7 Positioning of
operating status
indicators

The robot controller, teach pendant, and operating panel should
be installed outside the robot's restricted space and in a place
where you can observe all of the robot's movements when
operating the robot controller, teach pendant, or operating
panel.

Pressure gauges, oil pressure gauges and other gauges should
be installed in an easy-to-check location.

If there is any possibility of the electrical wiring or
hydraulic/pneumatic piping being damaged, protect them with a
cover or similar item.

Emergency stop switches should be provided in a position
where they can be reached easily should it be necessary to
stop the robot immediately.

(1) The emergency stop switches should be red.

(2) Emergency stop switches should be designed so that they
will not be released after pressed, automatically or
mistakenly by any other person.

(3) Emergency stop switches should be separate from the
power switch.

Operating status indicators should be positioned in such a way
where workers can easily see whether the robot is on
temporary halt or on an emergency or abnormal stop.



2.8 Setting-up the safety
fence or enclosure

2.9 Positioning of rope or
chain

A safety fence or enclosure should be set up so that no one can
easily enter the robot's restricted space. If it is impossible,
utilize other protectors as described in Section 2.9.

(1) The fence or enclosure should be constructed so that it
cannot be easily moved or removed.

(2) The fence or enclosure should be constructed so that it
cannot be easily damaged or deformed through external
force.

(3) Establish the exit/entrance to the fence or enclosure.
Construct the fence or enclosure so that no one can easily
get past it by climbing over the fence or enclosure.

(4) The fence or enclosure should be constructed to ensure
that it is not possible for hands or any other parts of the
body to get through it.

(5) Take any one of the following protections for the entrance/
exit of the fence or enclosure:

1) Place a door, rope or chain across the entrance/exit of
the fence or enclosure, and fit it with an interlock that
ensures the emergency stop device operates
automatically if it is opened or removed.

2) Post a warning notice at the entrance/exit of the fence
or enclosure stating "In operation--Entry forbidden" or
"Work in progress--Do not operate" and ensure that
workers follow these instructions at all times.

When making a test run, before setting up the fence or
enclosure, place an overseer in a position outside the
robot’s restricted space and one in which he/she can
see all of the robot’'s movements. The overseer should
prevent workers from entering the robot's restricted
space and be devoted solely to that task.

If it is not possible to set up the safety fence or enclosure
described in Section 2.8, hang a rope or chain around the
perimeter of the robot’s restricted space to ensure that no one
can enter the restricted space.

(1) Ensure the support posts cannot be moved easily.

(2) Ensure that the rope or chain’s color or material can easily
be discerned from the surrounds.

(3) Post a warning notice in a position where it is easy to see
stating "In operation--Entry forbidden" or "Work in progress
--Do not operate" and ensure that workers follow these
instructions at all times.

(4) Set the exit/entrance, and follow the instructions given in
Section 2.8, (3) through (5).



SAFETY PRECAUTIONS

2.10 Setting the robot's
motion space

2.11 No robot modification
allowed

2.12 Cleaning of tools

2.13 Lighting

2.14 Protection from objects
thrown by the end-
effector

2.15 Affixing the warning
label

The area required for the robot to work is called the robot's
operating space.

If the robot’s motion space is greater than the operating space,
it is recommended that you set a smaller motion space to
prevent the robot from interfering or disrupting other equipment.

Refer to the "INSTALLATION & MAINTENANCE GUIDE"
Chapter 4.

Never modify the robot unit, robot controller, teach pendant or
other devices.

If your robot uses welding guns, paint spray nozzles, or other
end-effectors requiring cleaning, it is recommended that the
cleaning process be carried out automatically.

Sufficient illumination should be assured for safe robot
operation.

If there is any risk of workers being injured in the event that the
object being held by the end-effector is dropped or thrown by
the end-effector, consider the size, weight, temperature and
chemical nature of the object and take appropriate safeguards
to ensure safety.

Place the warning label packaged
with the robot on the exit/entrance
of the safety fence or in a position
where it is easy to see.

AWARNING
oy |-
[ |

cause serious injury.
safety fence during
automatic operation.
®Press emergency stop
n, before enteri
—] button, before entering

this safety fence.




3. Precautions
while robot is
running

3.1

Creation of working
regulations and
assuring worker

adherence

A

Warning

Touching the robot while it is
in operation can lead to
serious injury. Please ensure
the following conditions are
maintained and that the
cautions listed from Section
3.1 onwards are followed
when any work is being
performed.

AWARNING

Moving robot arm can
cause serious injury.

v ®Do not enter this
safety fence during

automatic operation.
®Press emergency stop
[—] button, before entering

this safety fence.

1) Do not enter the robot's restricted space when the robot
is in operation or when the motor power is on.

2) As a precaution against malfunction, ensure that an
emergency stop device is activated to cut the power to
the robot motor upon entry into the robot's restricted
space.

3) When it is necessary to enter the robot's restricted
space to perform teaching or maintenance work while
the robot is running, ensure that the steps described in
Section 3.3 "Ensuring safety of workers performing jobs
within the robot's restricted space" are taken.

When entering the robot’s restricted space to perform teaching

or

maintenance inspections, set "working regulations" for the

following items and ensure workers adhere to them.

(1)
()

(6)

Operating procedures required to run the robot.
Robot speed when performing teaching.

Signaling methods to be used when more than one worker
is to perform work.

Steps that must be taken by the worker in the event of a
malfunction, according to the contents of the malfunction.

The necessary steps for checking release and safety of the
malfunction status, in order to restart the robot after robot
movement has been stopped due to activation of the
emergency stop device

Apart from the above, any steps below necessary to
prevent danger from unexpected robot movement or
malfunction of the robot.

1) Display of the control panel (See Section 3.2 on the
following page)

2) Assuring the safety of workers performing jobs within
the robot's restricted space (See Section 3.3 on the
following page)

3) Maintaining worker position and stance

Position and stance that enables the worker to confirm
normal robot operation and to take immediate refuge if
a malfunction occurs.
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4) Implementation of measures for noise prevention
5) Signaling methods for workers of related equipment
6) Types of malfunctions and how to distinguish them

Please ensure "working regulations" are appropriate to the
robot type, the place of installation and to the content of the
work.

Be sure to consult the opinions of related workers, engineers at
the equipment manufacturer and that of a labor safety
consultant when creating these "working regulations”.

3.2 Display of operation To prevent anyone other than the worker from accessing the
panel start switch or the changeover switch by accident during
operation, display something to indicate it is in operation on the
operating panel or teach pendant. Take any other steps as

appropriate, such as locking the cover.

3.3 Ensuring safety of When performing jobs within the robot’s restricted space, take
workers performing any of the following steps to ensure that robot operation can be

jobs within the robot's stopped immediately upon a malfunction.

restricted space (1) Ensure an overseer is placed in a position outside the
robot’s restricted space and one in which he/she can see
all robot movements, and that he/she is devoted solely to
that task.

@ An emergency stop device should be activated
immediately upon a malfunction.

@ Do not permit anyone other than the worker engaged
for that job to enter the robot’s restricted space.

(2) Ensure a worker within the robot's restricted space carries
the portable emergency stop switch so he/she can press it
(the robot stop button on the teach pendant) immediately if
it should be necessary to do so.



3.4 Inspections before
commencing work
such as teaching

3.5 Release of residual air
pressure

3.6 Precautions for test
runs

3.7 Precautions for
automatic operation

Before starting work such as teaching, inspect the following
items, carry out any repairs immediately upon detection of a
malfunction and perform any other necessary measures.

(1)
()
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Check for any damage to the sheath or cover of the
external wiring or to the external devices.

Check that the robot is functioning normally or not (any
unusual noise or vibration during operation).

Check the functioning of the emergency stop device.
Check there is no leakage of air or oil from any pipes.

Check there are no obstructive objects in or near the
robot’s restricted space.

Before disassembling or replacing pneumatic parts, first release
any residual air pressure in the drive cylinder.

Whenever possible, have the worker stay outside of the robot's
restricted space when performing test runs.

(1)

At start-up

Before the robot is to be started up, first check the following
items as well as setting the signals to be used and perform
signaling practice with all related workers.

1) Check that there is no one inside the robot’s restricted
space.

2) Check that the teach pendant and tools are in their
designated places.

3) Check that no lamps indicating a malfunction on the
robot or related equipment are lit.

Check that the display lamp indicating automatic operation
is lit during automatic operation.

Steps to be taken when a malfunction occurs

Should a malfunction occur with the robot or related
equipment and it is necessary to enter the robot's restricted
space to perform emergency maintenance, stop the robot’s
operation by activating the emergency stop device. Take
any necessary steps such as placing a display on the
starter switch to indicate work is in progress to prevent
anyone from accessing the robot.
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3.8 Precautions in repairs

4. Daily and periodical
inspections

5. Management of
floppy disks

(1)
()

@)

(4)

Do not perform repairs outside of the designated range.

Under no circumstances should the interlock mechanism
be removed.

When opening the robot controller's cover for battery
replacement or any other reasons, always turn the robot
controller power off and disconnect the power cable.

Use only spare tools authorized by DENSO.

Be sure to perform daily and periodical inspections. Before
starting jobs, always check that there is no problem with the
robot and related equipment. If any problems are found,
take any necessary measures to correct them.

When carrying out periodical inspections or any repairs,
maintain records and keep them for at least 3 years.

Carefully handle and store the "Initial settings" floppy disks
packaged with the robot, which store special data
exclusively prepared for your robot.

After finishing teaching or making any changes, always
save the programs and data onto floppy disks.

Making back-ups will help you recover if data stored in the
robot controller is lost due to the expired life of the back-up
battery.

Write the names of each of the floppy disks used for storing
task programs to prevent incorrect disks from loading into
the robot controller.

Store the floppy disks where they will not be exposed to
dust, humidity and magnetic field, which could corrupt the
disks or data stored on them.
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Outline of Personal
Computer Teaching
System

This chapter describes the configuration of the
personal computer teaching system and its
features.






Chapter 1 Outline of Personal Computer Teaching System

1.1 Features of Personal Computer Teaching
System

The personal computer teaching system is designed to make program
development and verification efficient by connecting a personal computer to the
robot controller.

It is possible to use this system to verify the robot program and/or data from a
remote point using the telephone line.

The WINCAPSII software, when installed on a personal computer, provides
advanced functions that include robot motion simulation, variables and 1/O in
the software, and program file management of each project. These features
are most efficiently exercised in the development and/or control of programs.

Note: For information regarding the specifications of the necessary
personal computer and for an outline of the personal computer
teaching system software function, refer to “General Information
about WINCAPSII Personal Computer Teaching System Software”
in Owner’s Manual (Installation & Maintenance).

1.2 System Configuration

The following three methods are available for connecting the robot controller to
the personal computer:

(1) RS232C connection
(2) Ethernet connection
(3) Modem connection

Each of these connection methods is explained below.

1-1
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1.2.1 RS232C Connection

This connection method uses an RS232C standard serial communication port.
Figure 1-1 shows the position of the RS232C communication port on the robot
controller.

Use the cross cable that conforms to the specifications described in
“Communication Cable” of Owner’s Manual (Installation & Maintenance).
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— g — — =
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?? = == [OE__]
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5 anfC B EBOOE B |C=s050
B> W\

P4 o

r— A F—5 ° Oo

o\o O Oﬂ.

N— .~
RS232C

Communication port

Fig. 1-1 RS232C Communication Port on Robot Controller
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Chapter 1 Outline of Personal Computer Teaching System

Figure 1-2 shows the configuration of the personal computer teaching system
connected with RS232C.

Personal computer

RS232C cable

Robot controller

Printer cable Y e Between
= the main body

o

A
¥ XX i 9
@ ==
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8 EEDDEI E=mreres
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i—1] EE' P g2
o |0 ;—E j@b
~—
Power cable
Printer
Operating panel Teach pendant
[\

@ (o} s | o | )
&
() dDj
©| fafs
B ® fafs}
D
(] ap
o DODO0O00O

_J

Fig. 1-2 Configuration of Personal Computer Teaching System Connected with RS232C
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1.2.2 Ethernet Connection

This connection method uses an Ethernet communication network.

To effect this connection, ensure that the personal computer is compatible with
Ethernet and can be connected to the network.

The robot controller must be equipped with an Ethernet board (option).

Note: Refer to “Ethernet Board” in Owner’s Manual (Installation &
Maintenance) regarding Ethernet specifications.

(=]

|—|
[ 720 OO |

o =" h Ethernet
o ooolPTJd P T
@)

< P—d
FC— FCH FC— ﬂooo
o el @
N? ) —
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Fig. 1-3 Location of Ethernet Board

Figure 1-4 shows the configuration of a personal computer teaching system
connected with Ethernet. 10Base2 or 10BaseT may be used for connection.
Determine the connection to the network by consulting with the network

administrator.

Notes: (1) When directly connecting a personal computer and robot
controller with 10BaseT, prepare a cross cable. When
connecting through a hub, use a straight cable.

(2) Multiple personal computers may be connected to the
network, but they cannot establish communication with the
robot controller simultaneously.
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1. Example 1 - Cross cable

Personal computer

Communication cross cable

Printer cable

CD—-ROM

Example 2 - Straight cable

Personal computer

Robot controller
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Printer cable
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Straight cable
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Fig. 1-4 Configuration of Personal Computer Teaching System Connected with Ethernet
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1.2.3 Modem Connection

This subsection describes how to connect the robot with a remote personal
computer through the telephone by connecting a modem to the RS232C
communication port of the robot controller.

This connection method requires a serial communication port obtained by
connecting a modem to the personal computer.

Figure 1-5 shows the RS232C communication port of the robot controller to
which the modem is connected.

Refer to “Communication Cable” in Owner's Manual (Installation &
Maintenance) regarding the communication cable for connection with a
modem. Select the cable that meets the specifications of the modem to be
used.

Modular wall

Robot controller

= Cable to
the main body

o

A
K = [OOE ]
o o 2ew:le]o):w
—_
| o G e [ w— |
o [0

RS232C Power cable

Operating panel
Teach pendant

[—\
qb (] | e } e | e |

©
_0000080

lvjvjv,w/v]}

TEL

Fig. 1-5 Connection of the Robot Controller and Modem
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Chapter 1 Outline of Personal Computer Teaching System

Figure 1-6 shows the configuration of the personal computer teaching system
connected with a modem.

Telephone

Modular wall Modular wall

Modem

Telephone Telephone
set set
RS232C
y
RS232C
/ ===t Robot controller
Personal
computer -
P Hon = :m— N
5 - ] g EHOORFE |—orr
e °
B R I——
b | ;—% 9@2 Cable to
the main body

Printer cable

Printer

0000000

Fig. 1-6 Configuration of Personal Computer Teaching System Connected with a Modem
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1.3 Security

For data control security reasons, the personal computer teaching system
divides users into two levels to limit operation and information that can be can

accessed.
Higher order users are identified via password to allow access to higher
operation and information.

1.3.1 User Level

Table 1-1 indicates user levels.

Table 1-1 User Level

User level Description

Operator Not allowed to modify contents. No password is required.

May modify contents except system critical items. Password is
required for access. For initial access enter an optional
password. This will be automatically registered as the
password.

Programmer

Note: The range of accessible information varies with the user level. If
necessary information is not printed by printing operation, select
Re-Login from the Tools menu of the System Manager to change
the user level and proceed with printing again. For information
regarding Re-Login, refer to “4.3.3 Re-Log In”.
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________________________________________________________________________________________________________________|

1.3.2 Password

The user will be prompted to enter a password in the following cases:

o When starting WINCAPSII

¢ Immediately upon selecting Set in each Manager

¢ Immediately upon selecting Print in each Manager
Once correctly entered, the password will not be requested before the session
is over.

When a password is required, the Password window as shown in Fig. 1-7 will
appear. Select the user level from the popup menu and enter the password
correctly as required. Press OK to proceed.

When using the system for the first time, enter an optional password. It will be
automatically registered.

Note: A distinction is made between upper and lower case letters in the
password.

QSEFZID - Operatar j

Fas swclrd:l
Cancel |

Fig. 1-7 Password

To change the user level during processing, select Re-Login from the Tools
menu of the System Manager, change the user level and enter the password
again.

ll:l [m] | B3

Set Communication

IEhange Easawond
Fe-Login

Bead FD Image
Wirite FD Image

Fig. 1-8 Re-Login
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#. Paszsword

Password:

QK Cancel |

Fig. 1-9 Password

Note: The user level is referred to when opening dialogue boxes.
To change the user level when the dialogue box has already been
opened by Set or Print command, close the dialogue box once,
and reopen it. The new user level will then be enabled.




Chapter 2
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Setting Personal
Computer Teaching
System

This chapter describes how to connect and set
the personal computer teaching system.






Chapter 2 Setting Personal Computer Teaching System

2.1 Installing WINCAPSII Software

Install the WINCAPSII software on the personal computer to use the personal
computer teaching system.

Note (1):

Note (2):

Note (3):

If the WINCAPSII software is already installed on the computer,
first uninstall the existing WINCAPSII software and then
reinstall it. For uninstall procedure, refer to “2.1.2 Uninstall”.
Always install or uninstall the software after quitting all the
applications currently running. Shared components in
operation cannot be installed or uninstalled. If a shared
component that WINCAPSII is to use is being used by another
application, the install/uninstall process may fail.

During installation of WINCAPSII, the message "Error has occurred
during file copying" may appear depending upon the PC
environments. This is because any other application is using the file
to which WINCAPSII is attempting to overwrite. Ignore the message
and continue installation.
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2.1.1 Installation Procedures
Install the WINCAPS Il according to the following procedure.

} STEP 1 I Terminate all the currently running applications.

Insert the WINCAPS Il CD-ROM in a CD-ROM drive of your personal
} STEP 2 computer.

Denso NetwoRC screen appears. Select “Install WINCAPS II” from the

menu.

If the screen does not appear, proceed to the STEP 3.

Note: f you install the WINCAPS Il from the floppy disks, proceed
to the STEP 3.

Click Start at Windows 95 and then click Run. Type the WINCAPS I
} STEP 3 installer name in the Open box and click OK.

WINCAFS /] Setup

#3 WINCAPS |l Setup

@ Wielcome ko the WINCAPS [l installation program.
Lo

Setup cannot ingtall system filez or update shared fles i they are in uze.
Before procesding, we recommend that pou close any applications you may
be running.

Exit Setup

Drive E is for CD-ROM (Example)

Note: When loading software from floppy disks, insert DISK-1 into
a floppy disk drive and then select Setup.exe file.
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Click on OK in the WINCAPSII Setup window to start the WINCAPSII
} STEP 4 Setup program.

WINCAFS /1 Setlup

¥ WINCAPS Il Setup

@ ‘welcome to the WINCAPS I installation program.
P

Setup cannot inztall system flez or update shared files I they are in uze.
Before proceeding, we recommend that you close any applications you may
be running.

Enit Setup

} STEP 5 The directory where WINCAPSII will be installed is indicated at
Directory.

If OK, click on |
To change the directory (not recommended), click on Change
Directory.

Click thiz button to inztall WINCAPS || software to the specified destination
directony.

Directony:
’7E:'\F'n:|gram Filez\Wincapz2 Change Directory

Exit Setup
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» STEP 6

2-4

Enter a desired directory for installation. Click on OK to start

Installation.
Hereafter, proceed with your operation interactively according to the
messages displayed on the screen.

#% Change Directory

Enter or select a destination direchary.

Path:

Iu::‘»F'n:ugram Filez

Directanes:

Ok

| & Program Files
[ Accessonies
(2 Camman Files

A Helpwarkshop

£ Mizrazaft Office ha

Canicel

Drives:
| = & [PCDD5_J7] =




» STEP 7

» STEP 8

» STEPO |

Chapter 2 Setting Personal Computer Teaching System

Installation starts and the progress is indicated via a bar graph.

= WINCAPS 1l Setup
Destination

C:%Proaram %sw M CAPS 2ypacman. b

i s

Cancel

When installation is completed, the following message will appear on
the screen. Click on OK.

WINCAPS Il Setup

WINCAPS || Setup was completed succeszsfully,

Restart Windows 95.
WINCAPSII is then ready for use.
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2.1.2 Uninstall

Note: Always quit all the applications currently running before you install
or uninstall software. Shared components, if they are running,
cannot be installed or uninstalled. If a shared component that
WINCAPSII is to use is being used by another application, the
install/uninstall process may fail.

Click on Start at Windows 95 and select and open Control Panel from
} STEP 1 the Settings menu.

} STEP 2 Double click on Add/Remove Programs in the Control Panel window.

B9 Control Panel =] 3
File  Edit “iew Help

I@ Contral Panel j | ‘ E‘I | X|"I I: £
i o il '_- wrm I - ;
E fﬁ

Acceszsibility Add Hew Eﬁaayﬁéﬁ'ﬁé‘g Date/Time Deplay Find Fast
Options Aardware ;| Progams
@ O el

k.epboard tail and Fax  Miciozaft kdail b odenns kouze tluiltimedia e
Postotfice
1| | 2

|21 objectis) W
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The dialogue box for Add/Remove Programs Properties appears on
} STEP 3 the screen. Click on Install/Uninstall tab and select WINCAPSII.

Add/Remove Programs Properties |

Inztall/Uninztall |Windnws SEtupl Startup Diskl

Toinstall a new program from a floppy disk or CO-ROM
drive, click Inztall.

Irnstall... I

The following software can be automatically removed by
YWindows. To remove a program or to modify itz inztalled
components, select it from the lizt and click
Add/Remove.

Microzaft Office 37, Profeszzional E dition :l
kicrozoft Wisual C++ 5.0
kizrozaft Wizual SourceSafe Va0
PacketCD Reader Driver

Faint Shop Pro 5.01 Evaluation
SnhagltdZ w43

Yizual Bazic 5.0 Enterprize Edition

Add/Bemove... |

0k, Cancel a1 |

} STEP 4 I Click on Add/Remove .... .

Click on Yes in the Application Removal dialogue box. (All non-
} STEP 5 shared components are deleted.)

Application Removal |

& Are you sure you want to completely remove WIRNCAPS || and all of itz components?
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» STEP 6

» STEP 7

» STEP 8

2-8

Uninstall begins.
If the Shared Component window appears in the middle of the screen,
click on Remove None. (Shared components are not deleted.)

Shared Component E

Shared File

CAWIMDOWSHSYSTEMYPDATARLOCK

sUIe you wank ko remove i, click the Bemowe button,  Othensize, click the keep

Thiz iz a shared component. and there may be other applications using it |f vou are
@ buatton,

If wou want to remave al shared companents, click the Bemowe All buttan, [f vau da
not want to remove any shared companent, click. the Remove Mone buttan,

Keep Bemove Fiemove Al

Upon completion of uninstall, a dialogue box for confirming
completion of processing will appear on the screen. Click on OK.

" . |
Application Removal |

Frogram installatan remowved

Upon completion of uninstall, restart Windows 95.

Note: Files created by WINCAPSII (such as *.pac, *.ini, etc.) are not
deleted by uninstall operation. Delete files manually as

needed.
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2.2 How to Connect Personal Computer and
Controller

This section describes each of the three types of connections between the
personal computer and the controller.

Note: Always turn both the personal computer and the controller OFF
before proceeding with connection work. Otherwise the equipment
may be damaged.

2.2.1 RS232C

This subsection describes RS232C connection. Use the COM2 port on the
robot controller for communication with the personal computer.

For connection between the computer and other peripheral equipment, refer to
respective instruction manuals.

2.2.1.1 Connecting Cable

} STEP 1 Connect an RS232C communication cross-cable to the robot
controller. Insert it securely in the controller and tighten the screws.

N\

Connection of Robot Controller and
RS232C Communication Cable
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» STEP 2

2-10

Connect the other end of the RS232C communication cross-cable to
the communication port on the personal computer. Insert it securely
in the computer and tighten the screws.

|

Connection of Personal Computer and
RS232C Communication Cable
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2.2.1.2  Setting Robot Controller

Set up the robot controller to use the RS232C port for the personal computer
teaching system. Make this setting using the teaching pendant.

Press F6 Set on the teaching pendant basic screen.
» STEP 1
m @ @ 1 [ﬁ VM -6083D Joint W@ T e| | 1%

@ SHORT
CuT
Set |

® A‘ Program firm | Yision 1/0 | OpePanel

The Settings (Main) window will appear on the screen.

™M g 5 0w 60830 | Joint WoTol] 1%

Mk

Settings (Main)

@[] 2

Mem Info Set Com. Maint.
[F41 [F5] [F6]

B @

Options. Savel Savefile
[F71 [F81 [F9]
Cancel: Close this window @wuﬂr
® A‘ Load! | Log. | FD. | Mem Info| Set Com.| Maint. |
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Press F4 Set Com.
} STEP 2 The Communications Setting Menu appears on the screen.

M @ @ B w sos0 | oint woTol] 12

Communications Setting Menu

7 7 i
| =] 8] 2| 2
Permit. SeriallF  Modem fiddress  Gateway
CF11 [F21 CF31 [F41 CF5]
2]
HiSpeed!
[F71

Cancel: Close this window @smcrﬁrr
@ A‘ Permit . | SerialIF| Modem fiddress | Gateway
} STEP 3 Press F2 Serial IF.
The Set RS-232C window appears on the screen.

(r)

2 STEP 4 Select COM2 and press F5 Change. |
Q @ ! @ ¥H -6083D Joint HOT o W
()

192¢¢ bps None 8 bit | 1 bit CR

38490 bps None 8 bit | 1 bit CR

1920¢ bps None 8 bit | 1 bit CR
19200 bps None 8 bit | 1 bit CR

Cancel OK

F5: Change the selection. OK: Exit with saving I

.&‘

| | Default.| Change.

The Select Transmission Rate window appears on the screen.



Chapter 2 Setting Personal Computer Teaching System

Select the transmission rate and press OK.
» STEP 5 -

Q @ @ @. ¥YH -6083D | Joint MW OT 9| IT

(" 9609 bps
(® 19200 bps
it | CR
(" 38400 bps it | CR
(™ 57660 bps it | (R
it | CR
(" 115209 bps
Cancel 0K OK
Select the transmission rate you want. @smckurr
® &‘ |
The screen returns to the Set RS-232C window.
} STEP 6 Check the display contents and press OK.
The set transfer rate becomes valid.

Q @ ) d w -se83D Joint W@T e| | 1%
19200 bps None 8 bit | 1 bit | CR
192¢¢ bps None 8 bit | 1 bit CR
1920¢ bps None 8 bit | 1 bit CR
19200 bps None 8 bit | 1 bit | CR

Cancel OK
F5: Change the selection. OK: Exit with saving 1
@ &‘ | | Default.| Change.
The screen returns to the Communications Setting Menu window.



Press F1 Permit. in the Communications Setting Menu window.
» STEP 7

Q @ @ @. ¥YH -6083D | Joint MW OT 9| IT

()

—

Communications Setting Menu

7 i i

L] @& ‘ L £

Permit. SeriallF  Modem Address Gateway
LF11 LF21 LF3] LF4] LF5]
£

HiSpeed!

LF7]

Cancel: Close this window QEﬁ“?E

@ A‘ Permit. | SerialIF| Hodem Address | Gateway

The Communication Permission Settings window appears on the screen.

Q @ @ @. ¥YH -6083D | Joint MW OT 9| IT

Communication Permission Settings

Read/urite \

Disable
Disable

Read/uwrite

Read/urite

Cancel | OK |

F5: Change the selection. OK: Exit with saving 1

@ Fiy ‘ Change.

} STEP 8 Select COM2 and press F5 Change.
The Change Permission Settings window appears on the screen.

(=)



» STEP 9
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Select the necessary permission settings.

() 2 o @ w eesm | Joint WoTol] 1%

Cd

Communication Permission Settings

Change Permission Settings

(" Disable

("~ Read only

(@ Read/uwrite

Cancel | OK |
0K

. . . . SHORT
Select communication permission you need. i

* 4 —

The meanings of the permission settings are as follows:
- Disable: Communication port is not used.
- Read only: Personal computer is enabled to read the robot controller
data. Itis not allowed to send data to the robot controller.
- Read/Write: Data exchange is allowed between the personal computer
and robot controller.

When creating a program, select Read/Write.
When supervising only variables or I/O values by automatic operation of a
ready program, select Read only.

Upon making a selection, press OK.
The screen returns to the Communication Permission Settings window.

Note: You cannot select Read/Write Enabled for both RS232C and
Ethernet simultaneously.
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Check the display contents and press OK.
} STEP 1 O The permission setting is enabled.

=}
@ Y @ @ v 6354 XY NOT0||

Communication Permission Settings

Read/urite
Read/uwrite
Disable
Disable

Read/urite
Disable

Cancel | OK |

F5: Change the selection. OK: Exit with saving 1% 8
° .| —

The screen returns to the Communications Setting Menu window.

Mg @ B o eesn | downt HoTof 1%

Change.

Communications Setting Henu

<| @ g «

7

Permit.. SeriallF  Modem Address  Gateway
[F11 [F21 [F3] [F41 [F5]

4]

HiSpeed!

LF7]

Cancel : Close this window ﬁfﬂmﬁﬁ

Address | Gateway

[ ] A| Permit. | SerialIF| Modem

} STEP 1 1 'I;:\zsdsis%?anycfelttjv:ri\g?) the basic screen.
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2.2.1.3 Setting Personal Computer

Set the personal computer to enable the installed WINCAPSII software to
communicate with the robot controller. Make this setting at your computer.

Start the System Manager from Programs by clicking on Start at
} STEP 1 Windows 95.
The System Manager starts up and the System Manager window appears
on the screen.

Note: For the method of starting System Manager, refer to “3.1
Starting Personal Computer Teaching System” on page 3-1.

} STEP 2 Click on Set communication button @
The ROBOTalk Manager starts up and the ROBOTalk Manager window
appears on the screen.
If a password has not been input, the Password dialog box will appear on

the screen. Enter the password. For the method of entering a password,
refer to “1.3.2 Password”.

¥ IRA-0000 - System Manager M=l |

File Toolz Window Help

1|2 9|4 @[

|5y5tem Manager |5tar'|dir‘|g by

Setting communication

Click on the ROBOTalk tab.
} STEP 3 The ROBOTalk Manager window will change as follows:

€ ROBOTalk Manager E

™,

ROBOTalk | R5232C | Teleghne |  Ethemst | Comm.Log

~Communication Dewvice

o BEZ3ZC ~ Telephone " Ethernet

~Optional Settings

|
Timegut: ~ J 4000 | msec.
|
Fetry: — 1 , E|times
I
Communication  — 1 . R times
Retny:
CIk Cancel | Stop | Update
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Select RS232C(R) in the Communication Device column.
} STEP 4 Set the data as shown below in the Optional Settings column.
Timeout : 4000 msec
Retry : 5 times
Communication retry  : 5 times

Click on RS232C tab.
} STEP 5 The ROBOTalk Manager window will change as follows:
@ ROBOTalk Manager

ROBOTak | R$Z3ZC Teleghone |  Ethemst |  Comm Log

—Optional Setting —

CObkA Part: SOk
Baud Fate: {13200
Farity Bit: IN - Mo parity
Data Bit Length: ;8
Stop Bit Length: |1

| K | K KN K

otrnal | !

]4 | Cancel | Stop | Update

Select a communication port to use on the personal computer in the COM
Port column. Select it according to the specifications of the personal
computer.
For the Baud Rate column, select the same speed as is set for the robot
controller.

} STEP 6 I %I]i:kRgrlgg'ﬁlk Manager window closes.

This completes the communication settings for the personal computer.
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2.2.1.4 Connecting to the Robot Controller

If RS232C is selected as the communication device in the preceding item
2.2.1.3 “Setting Personal Computer”, the Setting communication button @ for
the system manager will appear as shown below:

¥ IRA-0000 - System Manager M= E3

File Toolz “Window Help

BT Y

| Systern Manager | Standing by

Fig. 2-1 Setting communication Button (RC232C)

When the respective managers are started from the system manager button
and set for connection, corner marks _| will appear on each manager button.
For information on how to connect each manager, read the descriptions on the
operation of each manager in chapters 5 through 10.
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2.2.2 Telephone Line

A telephone line needs to be set up for the personal computer and robot
controller for telephone communication.

2.2.2.1 Connecting Modem

To make connection via a telephone line, a modem must be installed.

To do this, use Modems on the Control Panel in Windows.

For the connection of a personal computer and modem, refer to the respective
instruction manual as it varies depending on the hardware.

2-20



Chapter 2 Setting Personal Computer Teaching System

2.2.2.2  Setting Robot Controller

Press F6 Set on the basic screen of the teach pendant.
} STEP 1 The Settings (Main) window will appear on the screen.

F6 M@ o B w608 | Joint Ho Tl 12

e

Settings (Main)

vl 8| e||e]| <

Log. FD. Mem Info Set Com. Maint.
[F21 [F3] LF4] CF51 LF6]
Options. Savel Savefile
LF7] CF8] CF9]
Cancel: Close this window ﬁfﬁmﬁﬁ
® A | Load! | Log . | FD. | Mem Info| Set Com.| Maint. ‘
Press F4 Set Com.
} STEP 2 The Communications Setting Menu window appears on the screen.

| Joint we Tl 1%

M ¢ o @ wm -

Communications Setting Menu

| 2| £

Permit. SeriallF  Modem Address Gateway
LF11 LF21 LF3] LF4] LF5]

2]

HiSpeed!

LF7]

Cancel: Close this window @smckurr

Address | Gateway

® A‘ Permit. | SerialIF| Modem
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» STEP 3
)

AN

» STEP 4
)

» STEP 5
)

2-22

Press F3 Modem.
The Set Modem window appears on the screen.

M g @ @ w -sesa

Select the modem port to be initialized

(¢ CoM2
[ (" CoM3

(" COM4

Joint H 0T o] 1%

[OK] : initialize

.a‘

B

Select the communication port of the controller to which the modem

is
Select COM2 and press OK.
The following system message appears.

connected.

M ¢ @ @ wm —ees3p Joint W0 T o] 1%

Mk

System Message

MWill initialize the modem connected to COM2I

Cancel | 0K |

SHORT
CUT,

Check the system message and press OK.
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2.2.2.3  Setting Personal Computer

} STEP 1 Click on Setting communication button @I of the System Manager.
The ROBOTalk Manager starts and the ROBOTalk Manager window
appears on the screen.

If a password is not yet input, the Password dialog box appears. In this
case, input the password. For the method of entering a password, refer to
“1.3.2 Password”.

Double-click on the Telephone tab.
} STEP 2 The ROBOTalk Manager window will change as follows:

@ ROBOTalk Manager

ROBOTak |  RS22C | Teleghone |  Ethemet | Comm.Log

Q&

~Optional Setting —

kodem: I j

Locatian: IDefauIt Location _:] '
TEL Number: |
[T Automatic Answer
cotbioder | Setbial | ondook ||

]4 | Cancel | Stop | Update

} STEP 3 I Enter each item by referring to the descriptions in Table 2-1 and click
on OK.

Table 2-1 Telephone Optional Setting

Items Description
Modem Modem used for remote connection
Location Information of current location (Information on the
dialing party)
TEL Number Telephone number of the other party (called party)
Automatic Answer Call receiving side will be checked.
Set Modem Makes detailed modem settings.
Set Dial Modifies or adds location information.
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2.2.2.4 Connecting to Robot Controller

Upon selecting the telephone line for the communication device as a result of
the setting operation in the preceding item “2.2.2.3 Setting the Personal
Computer, the Setting communication button @ of the System Manager will
appear as shown below:

¥ IRA-0000 - System Manager |_ =] x|
File Toolz 'Window Help

o 298| @ 2|

|S\,rstem Manager |5tanding by

Fig. 2-2 Setting communication Button (Telephone)

When the respective managers are started from the system manager button
and set for connection, corner marks _| will appear on each manager button.
For information on how to connect each manager, read the descriptions on the
operation of each manager in chapters 5 through 10.
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2.2.3 Ethernet

Setting is required to enable communication between the personal computer
and the robot controller by connecting them via Ethernet.

2.2.3.1 Connecting Cable

The personal computer and the robot controller need to be connected via an
Ethernet network. For information regarding this connection, refer to “1.2.2
Ethernet Connection”.
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2.2.3.2  Setting Robot Controller

Set the robot controller to use the Ethernet port for the personal computer
teaching system. Make this setting using the teach pendant.

Specify the permission setting.

In the present stage, you cannot set the IP address (your IP address) and gate
address (gateway IP address).

Press F6 Set on the basic screen of the teach pendant.
» STEP 1 |

™ MY @ @ w e Joint_H o To] 1%
|

o

Set ‘

firm | Yision 1/0 ‘ OpePanel

® A | Program

The Settings (Main) window appears on the screen.

MY @ 8w e |l weTol 1%

Settings (Main)

al ©| 8| s||<| «

Load! Log. FD. Mem Info Set Com. Maint.
[F11 [F21 [F3] LF4] CF51 LF6]
Options. Savel Savefile
LF7] CF8] CF9]
Cancel: Close this window @mcﬁr
® A| Load! | Log . | FD. | Mem Info| Set Com.| Maint. ‘
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Press F4 Set Com.
} STEP 2 The Communications Setting Menu window appears on the screen.

MY @ 8w e |l weTol 1z

Communications Setting Henu

5 - 4
| | & ‘ £ A
Permit.. SeriallF  Modem Address  Gateway
[F11 [F21 [F3] LF4] CF51
4]
HiSpeed!
LF7]
Cancel: Close this window ﬁfﬁmﬁﬁ
® A | Permit. | Seriallf Modem Address | Gateway

Press F1 Permit.
} STEP 3 The Communication Permission Settings window appears on the screen.

F1 () Y @ @ w ees3 Joint W o Tol] 1%

Communication Permission Settings

Read/write
Disable
Disable
Disable

Read/urite

Cancel OK |

F5: Change the selection. OK: Exit with saving 1%
® Fi ‘ | | Change.
Select Ethernet and press F5 Change.
} STEP 4 The Change Permission Settings window appears on the screen.

(=)
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» STEP 5

2-28

Select Read/Write.

() Y @ @ wm -sesad Joint WO T o] 1%

Cd

Communication Permission Settings

Change Permission Settings

(" Disable

("~ Read only

(@ Read/uwrite

Cancel | OK |

. . . . SHORT
Select communication permission you need. i

* 4 —

The meanings of the permission settings are as follows:

When using Ethernet, select Read/Write.

¢ Disable: Communication port is not used.

e Read only: Personal computer is enabled to read the robot controller
data. Itis not allowed to send data to the robot controller.

o Read/Write: Data exchange is allowed between the personal computer
and robot controller.

Upon making section, press OK.
The screen returns to the Communication Permission Settings window.

Note: You cannot select Read/Write Enabled for both RS232C and
Ethernet simultaneously.
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Check the display contents and press OK.
} STEP 6 The permission setting becomes valid.

Joint W0 T o] 1%

M ¢ o @ wm -

Communication Permission Settings

Read/urite
Disable
Disable
Disable

Read/uwrite

| Read/urite

Cancel | OK |

F5: Change the selection. OK: Exit with saving 1

° 4 —

The screen returns to the Communications Setting Menu window.

i:g, @ (2 [;1 ¥YH -6083D |Joint N@Te||7

Change.

Communications Setting Menu

e ¢ g
PA = ‘ PA it
Permit. SeriallF  Hodem Address  Gateway
CF11 [F2] [F3] LF4] CF51
4]
HiS5peed!
LF7]
Cancel: Close this window ﬁfﬁm?$
] A| Permit. | SerialIF| Modem Address | Gateway

2-29



Press F4 Set Address.
} STEP 7 The Set Controller IP Address window appears.

™M ¢ @ @ wm ees Joint W0 T 0] 1%

A

Set Controller IP Address

o ‘ IP address 168. ©. 2 J

Perm Subnet mask 205 255 255, @

g Cancel | OK |

HiSpeed!
CF71

OK: Finishes this setting. Cancel: Cancels new entry 1
® Fiy | | Change.
Press F5 Change and enter a required address.
} STEP 8 In the example here, IP Address is set to 192.168.0.1 and Subnet Mask to
255.255.255.0.

(=)

g?q @ @ @. ¥ -6083D | Joint WO T 9| IT

Set Controller IP Address

o ‘ IP address A68. 0. R| B
Pern  Subnet mask 255 .255.55 . 7/ [ 8 [ 9
LF1
4 5 6
g Cancel |
4 1 2 3
HiSpeed!
[F71 @ CANCEL 0K
OK: Take in new entry. Cancel: Discard new entry 1

® -~

Press Cancel twice.
} STEP 9 I The display returns to the basic screen.
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2.2.3.3 Setting Personal Computer

» STEP 1

» STEP 2

Click on the Setting communication button @l of the System
Manager.

The ROBOTalk Manager starts and the ROBOTalk Manager window
appears on the screen.

If a password is not yet input, the Password dialog box appears on the
screen. In such a case, enter the password. For information regarding how
to enter a password, refer to “1.3.2 Password” on page 1-9.

Click on the Ethernet tab.

@ ROBOTalk Manager

ROBOTak | RS232C |  Teleghons

B

~Optional Setting

Cantraller [P |192.153.D.1

Connection Part: [4112

Local Port: [0

]4 Cancel Stop Update
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» STEP 3

2-32

Enter data in Controller IP, Connection Port, and Local Port at
Optional Setting and then click on OK.

Controller IP is the IP address of the party at the destination. Match it to
the desired party for connection. (For example, an IP address such as
192.168.0.1).

Communication Port is the local port number of the opposite party at
destination. Match it to the desired party for connection. (For example,
4112).

Local Port is the port number for own use. In principle it should be over
1024 and may be freely set if it does not infringe on others within the same
network.

Note: The following relationships have to be established for the
Ethernet connection: Own Connection Port = Local Port of
the other party.

Own Local Port = Connection Port of the other party

If connection is limited to the ROBOTalk Manager and robot
controller, the local port will be automatically replaced with
an appropriate value by setting zero (0) in the Local Port on
the ROBOTalk Manager side.

Table 2-2 Ethernet Optional Setting Option

Items Description
Controller IP IP address or host name of the opposite party
Connection Port Fixed at 4112
Local Port Fixed at 0
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2.2.3.4 Setting Network Environment

» STEP 1

To effect connection by Ethernet, it is necessary to set up Windows 95. The
network environment setting procedures will be described here preconditioned
on the fact that the network card (adapter) is installed,

First, add TCP/IP to the protocol to be used in the network environment.

Next, set up an IP address for the TCP/IP.

For the installation of the network card (adapter), refer to the instruction
manuals of the respective network cards (adapters).

Select Settings and Control Panel in this order from the START of
Windows 95.
The Control Panel window will appear on the screen.

B3 Contiol Panel [_ [ =]
File Edit “iew Help

[ &A1 Contral Panel . =l 5$||ﬂ| El E - |50 | = _
ERER-E NS

EEE
Arcessibiity add Wew  Add/Remove  Dated/Time Display Fonts Jopstick.
Oiptiote Hardware Programs
@ 3 0 BN <

K.epboard Modams b ouse Multimedia

& @ =

Printers Regional Sounds Syztem

Pazzwords PC Card
[PCHCLA)

o |

‘Eunﬁgures nebwork, hardware and goftware,
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Click on Network in the Control Panel window.

} STEP 2 The Network dialog box will appear on the screen.
Network |

Corfiguratian | Identiﬁcatiunl Access Euntru:nll

The following netwark components are installed:

E; Cliert for Microzoft Networkz

Add.. | Bemowe | Froperties |

Prirmary Metwork Logon:
Clignt for Miciosoft Networks j

File and Print Sharing... |

- Diezcription

(1] I Carcel

currently installed network components, click on Add.

} STEP 3 Click on the Configuration tab. If the TCP/IP item is not found in the
If TCP/IP exists, jump to STEP 6.
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The Select Network Component Type dialog box appears on the
} STEP 4 screen. Select Protocol click the type of network component you

want to install and click on Add.

Select Network Component Type K E3

Clizk the bype of network, cormpohent you want bo install:

= Client Add...

=i s dapter

Y Protocal Carcel I
@ Service

Protocol iz a language’ a computer uges, CompLbers:
muzt uze the same protocol fo communicate.

The Select Network Protocol dialog box will appear on the screen.

} STEP 5 Select Microsoft from Manufacturers. Select TCP/IP in Network
Protocols that appears on the right-hand side and click on OK.
This results in the addition of the TCP/IP protocol.

Select Network Protocol

o Click the Metwark. Protocol that you want o install, then click OF. If you have
25 an inztallation dizk faor thiz device, click Have Dizk.

Manufacturers: Mebaark Pratocols:

5 Banvan TIPS P-compatible Protocal
i Digital Equipment [DEC) - Microsaft DLC

i IBM 5 NetBE LI

T Microsoft Y TCPAP

T Movel

W SunSoft

Have Dizk. .. |

] I Cancel |
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» STEP 6

2-36

Again select the Configuration tab in the Network dialog box. Then,
select the TCP/IP item from the following installed network
components and click on Properties.

Metwork l

Corfiguration | Identiﬁcatiunl Arcoezs Euntru:nll

The following netwark components are installed:

g Clierk for Microsoft Networks

S IBM Etherlet T0BASE-T 154 Adapter
& IP=/S5P<-compatible Pratacal

[ MetBEL

T TCP/P
File and printer sharing for Microzoft Mebwaork s

| Add... I Bemowve | Properties J

Prirmary Metwork Logon:
i Clignt for Miciosoft Networks j

File and Print Sharing... |

- Degcrption—————————— :
TCF/IP iz the protocol pou uge to connect to the [nternet and i
wide-area networks. i

(1] Carcel
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Select IP Address tab and click to specify an IP address. Then input
} STEP 7 required data in IP Address and Subnet Mask.

For the actual values of the IP address and subnet address, inquire to the

network administrator in charge of the pertinent network.

If the network is local (for example, an environment for connecting the

personal computer and the robot controller only), the IP address can be set

as desired. Therefore, the IP address will be tentatively set here to

192.168.0.1 and the subnet address to 255.255.255.0.

Click on OK and the IP address setting is completed.

Note (1): When making connection to a wide area network (for

example an in-house network), always inquire to the
network administrator before setting the IP address and
subnet mask.
If an IP address used for the local area network is
connected to the wide area network (for example the in-
house network) without first invalidating it, confusion
may be occur in the connected network.

Note (2): No redundant IP addresses are allowed within the same
network. When making a connection to a widely shared
network, care should be taken not to allow an IP address
to be redundant with another terminal. The following are
examples of IP addresses that have the least probability
of redundancy with another terminal:
192.168.0.2 to 192.168.0.xxx (xxx represent 003 to 999.)

TCP/IP Properties HE|
Bindings I Advanced I [HS Canfiguration |
G ateray | WINS Corfiguration IF Address

An IP address can be automatically azsigned to this computer,
[F wour network. does not automatically azsign IP addresses, ask
wour network, administratar for an address, and then bype it in
the space belaw.

" Obtain an P address automatically

—{% Specify an IP address:

IP Addiess:  [192.168. 0 . 1] |

SubnetMask: | 255.255.255. 0 |

(1]4 I Cahizel
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» STEP 8
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Lastly select Identification tab and input a computer name and a
workgroup.

The computer name may be entered as desired, but give it the same name
here as the login name entered at Windows startup.

The work group will be tentatively made to read fa.denso.co.jp.

Click on OK.

This completes the network environment setting.

Refer to the Windows 95 instruction manual or ask the network
administrator for further information.

Metwork l

Configuration  |dentification I.&ccess Euntru:nll

E Yfindowves uges the following information bo identify pour
=1 computer on the network. Please type a name for this
computer, the workgroup it will appear in. and a shart
descrption af the caomputer.

Computer name: I

W ork group: Ifa.densc-.-:u:-.ip
Computer [WINCAPSII ..
Descrphor:

(1] I Carcel
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2.2.3.5 Connecting to Robot Controller

If Ethernet is selected for the communication device according to “2.2.3.3
Setting Personal Computer” and “2.2.3.4 Setting the Network environment’
thus far described, the Setting communication button @l of the System
Manager will be displayed as shown below:

¥ IRA-0000 - System Manager M= B

File Toolz “window Help

2| B8 @

|5~;5tem Manager |Standir'|g by

Fig. 2-3 Setting Communication Button Display (Ethernet)

When the respective managers are started from the system manager button
and set for connection, corner marks _| appear on each manager button. For
information regarding how to connect each manager, read the descriptions on
the operation of each manager in chapters 5 through 10.
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Starting Teaching
System and
Knowing Each
Manager

This chapter describes the procedures for
starting and terminating the personal computer
teaching system and outlines the functions of
each Manager.






Chapter 3 Starting Teaching System and Knowing Each Manager

3.1 Starting Personal Computer Teaching
System

Let's start and run the WINCAPS Il on your personal computer in order to
input, edit, and verify the robot operation programs.

Starting the System Manager

» STEP 1

DENSO application software WINCAPS |l for personal computer teaching
system consists of the following function modules.

PAC Program Manager

Variable Manager

DIO Manager

Arm Manager

Vision Manager

Log Manager

Communication Setting Manager

All these function modules are controlled by the System Manager. That is, all
the functions of WINCAPS Il should be called from the System Manager before
they are implemented.

To use the personal computer teaching system, start the System Manager first.

Click Start at Windows 95. Point to Programs, and then click System
Manager in the WINCAPS Il folder.

v SystemM anager B |

@ Connect with the controller?

Cormmunication Device : R5232C
Optional Settingz : COM1, 383400bps, M - Mo Panty, 8, 1
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» STEP 2

» STEP 3

» STEP 4

» STEP S

3-2

The WINCAPS Il Information window appears. Read the information and
click OK.

License key Information
Pleaze enter your license key.

License Key: | add |

Licenze key Bemove |

Cancel

Note: If you click the check box “Omit this message” at the lower
left of the screen, the above window will not appear from the
next startup operation.

The License Information window does not appear until you enter your
license key. Enter User ID printed in the license card and click OK.

Note: For detail on entering the license key, refer to 4.5.3 License
Key. Once you enter your license key, this window will not
appear from the next startup operation.

When starting the System Manger after initial installation of WINCAPS I,
create a program bank.

Note: When the dialog box “Create Program Bank” appears,
specify the files to be used in the program bank according to
the procedure described in “5.6.2.3 Updating Program
Bank”.

You need to create a project when activating the WINCAPS Il for the first
time after installation, because no system project has been defined.

Note: If a dialog box “Create New Project” appears, create a project
for the robot to be connected by referring to “4.2.1. New

Project”.
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} STEP 6 When the WINCAPS Il is activated the second time and after, the dialog
box "Open Project" appears. Select a desired project. The default is the
previously used project.

The Password window appears. Select the user level from the pop-up
} STEP 7 menu, enter the password if necessary, and then click OK.

@ Paszsword

User|0- Operatar j

Bassword:

Note: For the password, refer to “1.3.2 Password”.

The dialog box appears with the message “Connect with the controller? ”.
} STEP 8 Click No.

i .SystemManager

@ Connect with the controller?

Communication Device : RS232C
Optional Settings : COM1, 38400bps, N - No Parity, 8,1

The System Manager is activated and the System Manager window
appears. The icon buttons are used to activate the modules classified by
the function.

To use each of these function modules, click the required module icon or
select the required function from the command menu in the System
Manager window.

. |RA-0000 - System Manager M= E3 |

File Toolz ‘Window Help

1|2 @< @[

|5y5tem Marager |5tar‘u:|ir‘|g by
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3.2 Terminating Personal Computer
Teaching System

To terminate the personal computer teaching system, you need to terminate
the programs of both personal computer and Robot Controller.

3.2.1 Terminating Personal Computer

Clicking the close box at the upper right of the System Manager window
} STEP 1 will terminate all the software for WINCAPS Il running on your personal
computer.

¥ |RA-0000 - System Manager M= E3 |

File Tool: ‘Window Help

Mew Project...
Open Project.. Chrl+0
Save Project Chl+5

Save Project Az Chil+d
Tranzfer Project...  Chil+T

Project infarmation

E xit

Terminate the Windows 95 and turn off the personal computer, if
} STEP 2 necessary.

3.2.2 Terminating Robot Controller Connected with Personal
Computer

} STEP 1 Turn off the power switch.

S‘OO
009®9

\

Power switch of the Robot Controller
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3.3 Function Outline of Each Manager

The application software for the personal computer teaching system consists of
the various Managers classified by their functions. The following table lists the

function outline of each Manager.

Manager

Functions

Reference

System Manager:

Totally controls the
personal computer
teaching system.

1. Starts each Manager.
2. System project management
® Creates a new project.
® Opens an existing project.
® Saves a project.
® Transfers a project.
® Terminates the personal computer teaching system.

3. Sets the communication devices and their operating
conditions.

Changes password.
Reads data from or records data onto the floppy disk.
Enters the license key.

412
413,42

4.3.1

432
434,435
454

PAC Program
Manager:

Totally supports the
program
development using
the robot language.

S e ok

File operations

® Creates a new program project.
Opens an existing program project.
Saves a program project.
Sets the parameters used for the project.
Receives/transfers the program data.
Prints program data.

Creates an executable program.
® Terminates PAC Program Manager.
2. Program editing
® Edits program.
® Searches and replaces character-string in program.
® Jumps to another line.

w

Program Management
® Creates a program and adds it to the project.
® Saves a program file with another name.
® Adds an existing program to the project.
® Removes a program from the project.
® Imports and exports a program.
® Changes the order of displayed programs.
4. Makes various settings for PAC Program Manager.

5. Uses the program bank.
* An existing program can be registered or used as a
part.

6. Command builder
* Supports proper inputs of commands and arguments in
program editing.

5.2

5.3

54

5.6
5.6.2

5.6.3

3-5




Manager Functions Reference

Variable Manager: 1. Monitor the variables. 6.4
Backs up or 2. Operates the variables data. 6.1.3
\rgorggésé tLTsed by 3. Prints the variables table. 6.2.6
the Robot 4. Backs up data in the variables table. 6.2.4
Controller.

5. Creates a macro definition file for variables. 6.2.7

6. Transfers the variables table between personal 6.2.5
computer and the Controller.

7. Sends messages via RS232C. 6.5.2

DIO Manager: 1. Monitors the I/O status. 743
Monitors the 1/0O 2. Changes the I/O status according to dummy input. 7.4.4
S O ata | 3. Prints the 1O table. 7.26

4. Backs up the I/O table data. 7.2.3

5. Creates the macro definition file for assigning I/O data. 7.2.7

6. Transfers the I/O table between the personal computer 7.2.5
and the controller.

Arm Manager: 1. Monitors the current position of robot arm. 8.4
Monitors the current | 2. Views the work number and the tool number. 8.5
\r:gr(l)(t ﬁamggflgﬁg’ 3. Gets the current position into pose data. 6.4.4
tool number. 4. Simulates robot movements. 8.6.2

5. Sets the parameters related with the robot arm. 8.6.1

6. Defines the tool coordinate system. 8.6.1

7. Defines the work coordinate system. 8.6.1

8. Defines the area. 8.6.1

9. Object tree 8.6.3
* Defines the object drawn in the robot display.

10. Converts pose data. 8.6.4

* Type conversion among P, J, T type data
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Manager Functions Reference

Vision Manager: 1.  Opens the image data. 9.2.7
Supports creation of | 2. Connects with the Robot Controller. 9.3.1
using PAG 3. Creates a macro definition file for vision. 9.4.2
language. 4. Displays the camera image. 9.4.6
5. Edits the window. 9.4.3
6. Edits the search model. 944
7. Executes the camera CAL. 9.4.5
8. Uses the image analysis tool. 94.6

LOG Manager: 1. Browses log data. 10.1

Gets the log (robot ® Errorlog
operation record)

into personal ® Operation log

computer and ® Control log
manages the log o
data. ® Communication log
2. Creates new log file. 10.2.1
3. Receives the log data from the controller. 10.2.5
4. Prints the log. 10.2.6
5. Searches and replaces the character strings. 10.3.7
6. Control log 104.3
(Records the control log so that the operation can be
replayed using the Arm Manager.)
7. Displays the version of each robot controller part. 10.6.3
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Chapter 4
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System Manager

This chapter describes the function and operation
of the System Manager, which constitutes the
nucleus of the WINCAPSII software used in the
personal computer teaching system.






Chapter 4 System M anager

4.1 Outline of System M anager

4.1.1 Outline of Functions

WINCAPSII application software for the personal computer teaching system
consists of various managers with their own respective functions, as stated

below:

* System Manager: Overall control (including communication setting)
¢ PAC Program Manager: Program editing control

 Variable Manager Variable information control

* DIO Manager: I/O information control

¢ Arm Manager: Robot action information control

« Vision Manager: Vision information control

¢ Log Manager Log information control

The System Manager makes controls the overall data files controlled by other
managers, as a system project. It also controls communication setting and
password setting.

Respective managers can be used by calling them from the System Manager.
To start the System Manager, select the System Manager program with the
Start key of Windows. When started, the main screen of WINCAPSII and the
System Manager window appear on the screen.

For starting procedure details, refer to Chapter 3 “3.3.1 Starting System
Manager” in this manual.

¥ |RA-0000 - System Manager !EIE

File Toolz “Window Help

o |E 98 @0

Systerp Manager |5tar‘u:1{r‘|g by

Displays object of system/ )
manager operation Displays the content of Status bar
system manager operation

Fig. 4-1 WINCAPSII Main Screen
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4.1.2 Tool Bar

¥ IRA-DDDD - System Manager M= E3

Tool bar File Tool: Window Help

N

[~ et ) Communication
PAC Program | '{,ﬁtik ‘ [~ set button
Manager button I~ )

\

SySteyﬁ/ Maﬂa)ﬁler | Sta;\{dir‘lg b“.-’\ \

\
Variable Manager button / \ Log Manager button
DIO Manager Vision Manager
button Arm Manager button
button

Fig. 4-2 Tool Bar

PAC Program Manager Button %]

Click on this button to start the PAC Program Manager.

For descriptions on the operating procedures of the PAC Program Manager,
refer to Chapter 5 “Operating PAC Program Manager” and Chapter 3 “3.5
Entering and Editing Programs” in this manual.

When the PAC Program Manager is connected to the Robot Controller, the
button icon changes to #&] .

Variable Manager Button

Click on this button to start the Variable Manager.

For Variable Manager operating procedures, refer to Chapter 6 “Operating
Variable Manager” and Chapter 3 “3.14.1 Starting Variable Manager” in this
manual.

When Variable Manager is connected to the Robot Controller, the button icon

display changes to .

DIO Manager Button /€|

Click on this button to start DIO Manager.

For the procedures for operating DIO Manager, refer to Chapter 7 “Operating
DIO Manager” and Chapter 3 “3.13.1 Starting DIO Manager” in this manual.
When the DIO Manager is connected to the Robot Controller, the button icon

changes to (4] .

Arm Manager Button &

Click this button to start the Arm Manager.

For the procedures for operating Arm Manager, refer to Chapter 8 “Operating
Arm Manager.”

When the Arm Manager is connected to the Robot Controller, the button icon

changes to @l
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Vision Manager Button &

Click on this button to start the Vision Manager.

For Vision Manager operating procedures, refer to Chapter 9 “Operating Vision
Manager” in this manual.

When the Vision Manager is connected to the Robot Controller, the button icon

display changes to @l ]

Log Manager Button

Click on this button to start the Log Manager.

For Log Manager operating procedures, refer to Chapter 10 “Operating Log
Manager” in this manual.

When the Log Manager is connected to the Robot Controller, the button icon

display changes to .

Set Communication Button €|

Click this button to set communication.

To set Communication, refer to Chapter 4 “4.3.1 Set Communication” and
Chapter 2 “2.2 How to Connect Personal Computer and Controller” in this
manual

“Set Communication” button display changes for each selected communication
device:

| | \When not in connection
wi | Connected via RS232C

Connected by telephone line via modem

!" Connected by TCP/IP via Ethernet
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4.1.3 System Project Management

When developing a program using WINCAPSII, in addition to the program
data, a number of data such as variables and parameters that accompany the
operation of the program have to be processed.

With WINCAPSII, the System Manager manages programs and the related
groups of data, in terms of a system project. This management information is
stored in the system project file (SPJ file). The system project file controls all
information needed for operating a unit of the robot.

4.1.3.1 WINCAPSII-Generated Files

Fig. 4-3 shows the relationship among the files, which are generated and
managed by their respective WINCAPSII managers, for the purpose of data
storage.

Files other than the program bank file are placed in the project folder,
immediately after a system project is newly created. The program bank file is
placed in the folder named ProgramFiles\Wincaps2, if the default exists where
WINCAPSII application is installed.

For example, if a project named IRA-0000, which appears initially by default is
generated, this project is generated in the folder named ProgramFiles\Wincaps2 by
default. Files other than the program bank files are placed in the project folder
named IRA-0000. Fig. 4-4 shows the position of files generated and managed
by WINCAPSII.

Note: Each Manager has a current folder. These Managers output their
respective control files to their current folders.
Immediately after newly creating a system project, all the
Managers use the same current folder.
When respective Managers newly create files, the current folder
will not be changed, unless the folder is changed.
If the current folder is changed, a reference path for the input file
will be required using #INCLUDE statement and other file input
commands.
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)
System Manager
(including
communication
setting) -
System project file
*8PJ | (including communication setting)
Program Variable DIO Arm Vision Log
Manager Manager Manager Manager Manager Manager

- - ) - >

Variable DIO file Arm file Vision file Log file

file

var_tab
* BNK h
Model
Program  Program Micro *MDL data file
bank file  project file NS arm_cnf com_chf
definition file h I I;
Arm configuration Confi .
macro definition file on |lg_urat_|on macro
definition file
#* LNK # PAC || Program file
—| dio_tab | Micro
Make file h Definition file )
) vis_tab
.h
| g i Macro
ntermediate file . inition fi
dio_cnf definition file
.h
vis_chf | Configuration
Configuration macro h macro
definition file definition file
* MAP #NIC
Cross Execution *.bmp
reference file format file
Bit map file

Fig. 4-3 Files Generated and Managed by WINCAPSII



[:' Program files

C' Wincaps 2

[:| Ira-0000
G
M~
| | «sPy
S———r
N
M~
| |«LoG
e
AN
I
L |-vis

N—

*MDL

|
)&

— | +.DIO
N
J—
-
———— |+.VAR

S —
Y
M~

| |«PPJ

#.h

5
]

#BNK I Program bank file

System project file

(including communication setting)

Log file

Vision file

Model data file

Arm file

DIO file

Variable file

Program project file

Program file

Macro definition file

Fig. 4-4 Position of Files to Be Generated and Managed by WINCAPSII




Chapter 4 System Manager
_______________________________________________________________________________________________________|

4.1.3.2 File Management by System Manager

The System Manager manages the relation of data files generated by other
groups of Managers. The system project file (*.spj) generated by the System
Manager has data files which are referenced by each Manager.

When starting each Manager, the System Manager specifies the reference
data files for the started Manager. Therefore each Manager can use the groups
of programs or variables that differ by project, without confusion.

The Set Communication is a function incidental to the System Manager and,
therefore, it does not have its own data file. The Set Communication
information is included in the system project file.

The system project file has an extension code “.SPJ”.
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414 MenulList

The System Manager command menu has the following tree structure:

File
New Project
Open Project
Save Project
Save Project As
Transfer Project
Project information
Exit

Tools
Set Communication
Change Password........... (Programmer Level)
Re-Login
Read FD Images
Write FD Images

Window
PAC Manager
Variable Manager
DIO Manager
Arm Manager
Vision Manager
LOG Manager

Help
License Key
System Extension
About System Manager

Fig. 4-5 System Manager Menu Tree

4-8



Chapter 4 System Manager

4.2 File Menu

The System Manager FILE menu contains commands for controlling the
project, besides the command for exiting the System Manager.

¥ |RA-0000 - System Manager M= E3 |

File Tool: ‘Window Help

Mew Project...
Open Project.. Chrl+0
Save Project Chl+5

Save Project Az Chil+d
Tranzfer Project...  Chil+T

Project infarmation

E xit
Fig. 4-6 File Menu

Note: The New Project and Open Project menu commands are invalid
when any of PAC, DIO Arm, Vision and LOG Managers is
connected.

4.2.1 New Project

This command is used for creating a new system project.

After selecting this command, the Create New Project dialog box appears on
the screen. Input default data, after changing it as may be needed, and click
on OK. If Cancel is clicked, the command closes the box without creating a
project.

{#l Create New Project

Bohot Series ; |l o

Type:|HM-4070D

Configuration : | Standard

Cancel

KN (K

Mew Falder

|
M

Ex-Jdoint: |Disenakle
Stroke| 200mm j

Details

Eroject Mame:|\vM-40700
Ealder Name:| CHPROGRAM FILE S\WINCAPS 2, 2'
Dutput-Code:|"erl &
Facility Twpe:| 0 - Standard

L«

Fig. 4-7 Create New Project Dialog Box
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¢ Robot Series: Select a desired robot series.

e Type: Select a robot type from "Robot Series."

¢ Environment: Select environment according to the selected robot.

¢ Additional Axis: Select whether there is an additional axis.

e Stroke: Displayed for each robot type as required. Select this
item according to the selected robot.

¢ Project Name: Enter the project name.

¢ Folder: Describes a folder for storing the project. You can
select a folder path by clicking the Folder button.

e OQutput Code: Sets a version of the execution program to be created
according to the version of the connected controller.

e Facility Type: Select a facility type. A program library necessary for

the type selected here is automatically added to the
PAC program manager. If Standard is selected,
nothing will be added.

e New Folder: After clicking, the New Folder Window appears. The
new folder can be created by entering the folder name.

Mew Folder
Type a new falder name.
Cancel |
c:%Program Fileshwincaps2®
Fig. 4-8 New Folder Window
e Details: After clicking, the Details window appears. Specify, in

this WINDOW box, the default data reference files of the
respective Managers. The default data is created in the
process of Create New Project. Set the respective

“« »

reference files using “...” Clicking on Initialize returns
the specified reference file to the default setting. It is
usually not necessary to change the detail setting.

IF Details

~Default File Name
BAC Manager: [o\Program Files\ANCAPS2\EESfoacm .|
“ariable Manager|C:‘~,Pruqram FilesWWwiNCAPS2 ERR=var.md J
[B]]n! ManagerlC:RPquram FilesWwiNCAPS2EEE-dio.md _I
Arm Manager: |C:"-,Pr|:|qram FilesWwiMNCAPS2YEEE-arm. m _I
Wision Manager: |C:"-,Pr|:|qram FilesWWwWiNCAPS2YEER-is md J
LOG kdanager: |C:".,Pr0qram FilesWwiNCAPS2EER-log.md _I

oK Cancel | Inilialize |

Fig. 4-9 Details Window
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4.2.2 Open Project

This command opens the existing projects.
When this command is specified, the Open project window appears.

Open Project

Loak, IaHs-e j gl F::
] H5-E.5pj

File name: H5-E Open I
Files of twpe: | SPJ File(*.spi) =l Cancel |
A

Fig. 4-10 Open Project Window

The files that contain the project management information have the extension
file name “.spj”. Select a file having the “.spj” extension for the project name.
Click on the Move up one holder level button or the folder in the display
box, and you can change the path.

When you click on a file having an “.spj” extension, the file name is entered in
the File name box. Click on Open to opens the project.

To close the dialogue box without opening the project, click on Cancel.

4.2.3 Save Project

This command saves the currently opened project information.

4.2.4 SaveProject As

This command stores the currently opened project as another one. All files
used for the current project are copied to the new project.

Note: Do not select “Floppy (A:)” as place saved in.
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__________________________________________________________________________________________________________________|
4.2.5 Transfer Project

This command transmits the system project data. In the Robot Controller, this
command is used for backing up the data.

Data may be transmitted in a batch, or may be transmitted in parts by selecting
each Manager data from the transmission table.

Note: To transmit data selectively under the control of a manager other
than the System Manager, you can use the Transmit command in
the File menu of each respective Manager.

& Batch Tranzfer of All Data E1

—Tran -
P orooram data <A Manane) Transrmit »
v All wariable data <Wariable Mans < Becaive
v Al DO data <DIO Managers
¥ &Ml arm data <4rm bManager>

Cancel

v All wision data <Vision Manager
¥ All log data{Feceie Onlyi<log |

Selact All

Fig. 4-11 All Data Batch Transfer Window

4.2.6 Project Information
Displays the set robot type or the project information for each Manager.

Project information |

TG Pobor e VM-6083D
Property | Walue |
iSustern project [SPJ): CAWINCAPS2APROJECT YM-608305M-60830. 5pj
PP file CAWIMCAPS 24PROJECT $WM-E08330 % 1 -B0830 . ppj
YR file CAWIMCAPS 24PROJECT Wb -B0830 % 1 -B0830 war
DI file CAWINCAPS 2\PROJECT YWM-60830% 160830 dio
AR file CAwIMCAPS 2PROJECT WWh-E0830 % M -E0830 . arm
15 file CAWIMCAPS 24PROJECT WWh-B0330 % 1-B083D viz
LOG file CAWIMCAPS 24PROJECT WWh-E0830 % 1 -60830 log
Cloze |

Fig. 4-11-1 Project Information Dialog Box

4.2.7 Exit

This command terminates the WINCAPSII application software.
The functional managers opened from the System Manager are simultaneously
terminated.
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4.3 Tools Menu
€ 1RA-0000 - System Monoger _ MIBIES |

File | Tools Window Help
Set Communication

[
5‘5 utl
Change Pazsword

Syst Re-Login

Bead FO' Image
Wwirite FO' Image

Fig. 4-12 Tools Menu

4.3.1 Set Communication

When you select “Set Communication” in the Tools menu, the ROBOTalk
Manager dialog appears.

Click on the set communication button @l to display the ROBOTalk Manager
dialog.

The ROBOTalk Manager dialog box is used to set the communication device
and communicating conditions, and to perform service processing of the
communication protocol for the robot. This dialog box is also used to monitor
the communication state and save the communication log.
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% ROBOT alk Manager E

RDBI]TaII:T RI23C T Telephmne T Ethernet T Coirroen, Lig )

~ Communication Device
' BS232C " Telephone " Ethernet

~ Optional Seftings

|
Timegut ~— 5 | 4000] meec
|
Retrye — 0 | E|times
|
Comrmunication  — b | 5| times
Fetry:

Stop | Update

Ok |

Fig. 4-13 ROBOTalk Manager Window

Clicking on the ROBOTalk tab enables you to make settings, as described in
the following section downward.

When all the settings have been completed, click on OK.

When you lick on Cancel, the ROBOTalk Manager dialogue box is closed
without any change of set values.

Press Stop in such cases where you want to interrupt transmission from the
personal computer, no response is returned from the other party, or you want
to stop the ongoing transmission.

Update is a button for confirming the contents until now. Clicking on OK closes
the Communication Manager. Use Update to check the set data without
closing the Communication Manager.

Note: The OK and UPDATE (A) buttons are invalid when one of the PAC,
Variable, DIO, Arm, Vision or LOG Managers is in connection or the
user level is set to “0-Operator”.
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ROBOTalk

Chapter 4 System Manager

Click on ROBOTalk tab in the ROBOTalk Manager window, and the screen
shown in Fig. 4-14 appears.

‘% ROBOTalk Manager [ x|

™

Rl]BI]TaIkT RI232C T Telephone T Ethernet T Eu:;n‘:sn'n.Lng

— Caornmunication Dewvice
v BE232C " Telephone " Ethernet

~Optional Settings

I

Timegut. — 5 | 4000fmeec
|

Retre: — 0| E|times

S [ 5ltimes

Communication
Fetry:

0K |

atop | Update

Fig. 4-14 ROBOTalk

Communication Device

Select a communication device to use for communication with the Robot
Controller by clicking on a desired device.

The Set Communication button icon @I in the System Manager changes to the
communication device selected here.

RS232C is selected.

Telephone line is selected.

!" Ethernet is selected.

Setting Option

Timeout: Sets the waiting time, for error judgment when no
response is received from the Robot Controller.
Default: 4000 msec.

Retry: Sets the number of retries, when a timeout error is
generated in communication.
Default: 5 times

Communication retry:  Sets the number of retries when an error is generated
in communication.
Default: 5 times
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[2] RS232C
Click on RS232C tab of the ROBOTalk Manager window to display the screen
shown in Fig. 4-15.

Set the required data on this screen to enable connection between the
personal computer and the Robot Controller directly with the RS232C cable.
‘® ROBOTalk Manager
ROBOTak | H§233C Teleghone |  Ethernet | Comm Log |
3
~Optional Sefting———————— 1
COM Part: |COM! =
Baud Rate: {19200 =
Earity Bit: N - Mo parity ;j
Data Bit Length: {5 j
Stop Bit Length: |1 :j
Ok Cancel i atop i Update
Fig. 4-15 RS232C
COM Port
Select the communication port to be used on the personal computer. When you
click on the arrow j the options appear in a pull-down menu.
Baud Rate
Select the baud (communication) rate. When you click on the arrow =], the
options appear in a pull-down menu.
Note: The faster the communication speed, the more frequently the
communication error tends to occur.
Parity Bit
Select the parity check bit. Click on the arrow | to display the options in a
pull-down menu.
Data Bit Length
Select the data bit length for communication. Click on the arrow =] to display
the options in a pull-down menu.
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Stop Bit Length

Select the stop bit length. Click on the arrow *] to display the options in a pull-
down menu.

Normal

Set all RS232C related items to normal settings.
Communication port : COM1

Baud rate 119200
Parity bit : N-No parity
Data bit length :8

Stop bit length 1

[3] Telephone

Click on Telephone tab in ROBOTalk Manager dialogue box to display the
screen shown in Fig. 4-16.

Set the required data on this screen to enable connection between the
personal computer and Robot Controller using a telephone line.

% ROBOTalk Manager E2

ROBOTak |  R52RC | Telephome |  Ethermet | CommLsg |

3

— Dptianal Setting

Modem: IStandard 19200 bps Modem j

Locatiar: INEW Location j

TEL Mumber: [5554221]
[T Automatic Answer

SetModem |  SetDial | crboork |

Ok | Cancel | Stop | Update

Fig. 4-16 Telephone Tab

Modem

The above dialog box shows the currently selected modem. Click on the arrow
] to display the options in a pull-down menu.

By clicking on Modem icon in the control panel, you can select a registered
modem.

For how to use the Modem in the control panel, refer to the instruction manual
for Windows 95.

Location

Select the location where the personal computer is used. Clicking on the arrow
=] to display the options in a pull-down menu.
You can select a registered location by the following dial settings:
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TEL Number

Enter the telephone number of the other party to which you intend to connect.
Only enter the numerical characters. Hyphen, bracket, or the other signs are
not usable for entry of telephone number.

Automatic Answer

If you put a checkmark in Automatic Answer check box, the personal computer
automatically answer the calls.

Set Modem

This column shows the property of the selected modem.
For details on modem property setting, refer to the instruction manual for
Windows 95.

Set Dial

This column displays the dial property.
For details on dial property setting, refer to the instruction manual for Windows
95.

ONHOOK

Press the ONHOOK button to disconnect the telephone connection.

Note: Connection with a telephone line is possible only when the modem
is installed. For details on modem installation, refer to Chapter 2
“2.2.2 Telephone Line” in this manual.
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[4]

Ethernet

Click on Ethernet tab on the ROBOTalk Manager dialogue box to display the
screen shown in Fig. 4-17.

Set the required data on this screen to enable connection between the
personal computer and Robot Controller using Ethernet.

% ROBOTalk Manager

ROBOTak | Ri2seC | Tolsghone

%

vy

- Optional Setting

Contraller [P: [192.168.0.1

Connection Part: 34112
Local Part: iU

0] ] Cancel Stop Update
Controller IP

Enter the IP address or the host name of the opposite station.

Connection Port
Enter the port number of the opposite station. Always set this number to 4112.

Local Port

Enter the port number of the personal computer.
Always set this number to 0 (zero).
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[S] Communication Log

Click on Comm. Log tab on the ROBOTalk Manager dialogue box to display
the screen shown in Fig. 4-18.

The communication log function is used for checking the communication state.
Use this function for checking the line condition, should you have a
communication error.

@ ROBOTalk Manager ]|

ROBOTak | Rs23C |  Telephone | Ethemet |Comm. Log

Total Mumber of Trassmited Packets:
Taotal Mumber of Received Packets:
Mumber of ransmited MNAKs: [ 1

Mumber of Peceived NAKs: [

Mumber of Received MNAKs (Standhy): E
Nurnber of Timeout Occurrences: [ 0

k. Cancel Stop Update

Fig. 4-18 Communication Log

Total Number of Transmitted Packets: Total number of packets transmitted
by WINCAPSII

Total Number of Received Packets: Total number of packets received by
WINCAPSII

Number of Transmitted NAKs: Number of NAKs (error packets)
transmitted by WINCAPSII

Number of Received NAKs: Number of NAKs (error packets)

received by WINCAPSII

Number of Received NAKs (Standby): Number of NAKs (error packets)
received by WINCAPSII except the
errors caused in response to the
transmitted packets

Number of Timeout Occurrences: Number of timeouts except the timeout
errors caused in response to the
packets transmitted by WINCAPSII

Note: If timeout occurs for reasons other than connection failure, extend
the timeout duration as noted in Chapter 4 “Setting Option” on
page 4-15.
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_______________________________________________________________________________________________________|

4.3.2 Changing Password (Programmer Level)

To change the password, select Change Password from the Tools menu. The
Changing password window appears.

@, Changing password

User Changed tl:u:i1 - Programmer j

old Passwurdt!

Blew Paaswnrd:]

SErify e Passwnrd:]

I Cancel

Fig. 4-19 Changing Password Window

At User Changed to, select the user level whose password is to be changed.
At Old Password, enter the previous password.

At New Password, enter a new password.

At Verify New Password, re-enter the new password for verification.

After correctly entering all the items, click on OK.

To cancel change of password, click on Cancel.
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4.3.3 Re-LogIn

Use this function when changing the user level.

Select Re-Login from the Tools menu in the System Manager.
} STEP 1 The password window appears on the screen.

¥ IRA-0D00 - System Manager M= E |

File | Toolz “Window Help

Set Communication

I
@,
Change Pazsword

syst G Y

Bead FD Image
Wirite FO' Image

} STEP 2 Select the user level from the popup menu.

2. Password

CE. Cancel

Input the password correctly and click on OK.
} STEP 3 The user level has been changed.

2. Password

Userl1 - Pragrammer j

B

Fassword:

] Cancel |

Note: If you press Cancel without entering password, you will be
requested to enter the password when you specify the data
setting, printing, or communication commands.
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4.3.4 Reading FD Images

Data may be exchanged by using a floppy disk as the media between the
Robot Controller, instead of data transmission using communication.
When reading data from a floppy disk, read the FD images.

Select Read FD Image from the Tools menu.
} STEP 1 The dialogue appears requesting you to end the System Manager.
Click on Yes.

i .SystemM anager <]

D ata will be merged with the project by ending the System Manager. End the System Manager?
If hio, execuke FD reading and reopen the project.
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} STEP 2 Click on Next.

" FDTool ver 1.1.3

Heading data from AWM etwaB L,

Wil create new folder far new project to be constructed. Inthe caze of
merging, data will be merged to exitting project.

" Creating rew system project

r—f* Merging to existing project

1| |2 \Program FilesVwl NCAPS 24 RA-0O004 R-0000 spj ol

| E . -
Hack Mexty Cancel

Creating new system project: A folder and a system project file are

newly created. The read data is
merged in that project.

Merging to existing project: The read date is merged in the
existing project.

Reference: Select an existing system project.

Back: Return to the initialize the screen.

Next: Proceed to the read a data object
select screen.

Cancel: End

Select a data object and click on Next.

} STEP 3 Select the data attached with a check mark as the object.

" FDTool ver 1.1.3

Select object data by manager. Al the data managed by selected

manager will become object,
Select all |

- Object data
All program data <PAC Manager:
|| All variablz data <ariable Managers
1Al D0 data <DI0 M anager:

AN A data <A Manager:

] All vigion data <Mision Manager:

I ] Al Log data <Log Manager:.

 <Back e Cancel
Select All: Select all object data for reading.
Back: Return to the system project select screen.
Next: Read from the floppy disk.

Cancel: End
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» STEP 4

The following message appears requesting you to insert the floppy
disk. Insert the floppy disk containing the read data into the floppy
drive and click on OK.

+ FDTOOL

@ Insert [#1:] disk.

If the floppy disk has different data from the object being read, a message
appears prompting you to change disks. Replace with the correct disk and
click on OK. Clicking on Cancel returns the display to the object data
select screen.

: FDTOOL E|

& Insert -#1 disk. Mrong disk iz inserted.]
Cancel |

If the floppy disk is neither inserted nor formatted, an error message
appears. Insert the correct disk and click on OK.

: FDTOOL

& Either digk iz not ingerted or formatted. Inzert the disk.

When the correct disk is inserted, the object data is read. Reading
progress is indicated with a bar graph.

% FDTool ver 1.1.3

Al program data reading

AiMetwoR CUWUTOEXEC PAC

AERENENNNENNNENENEN

cBEsk Hexis Cancel
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» STEP 5

When the data is read normally, an indication to that effect appears.
Click on Complete.

W' FOTool ver 1.13

Riead dats from A \WebwoR Ch

file C:%Frogram Filestwincaps2h Ra-00004 Bb-0000. zpj
and, each data updated

[Eaneel |

||

4.3.5 Write FD Images

» STEP 1

4-26

Data can be exchanged by using a floppy disk as the media between the
personal computer and the Robot Controller, instead of data transmission
using communication.

When recording data to a floppy disk, write the FD images.

Select Write FD Image from the Tools menu.

A dialogue appears requesting you to save the project. Click on Yes.
Save the data using the same method as selecting Save Project
command in the File menu.

i .SystemManager E

@ To create FO' data from the project being edited, you must save the project. Do pou want to save now?

Note: Always save the project data. If FD image is written without
saving the project data, the present state may not be
written.
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Click on Next.

» STEP 2

" FDTool ver 1.1.3

FRead data from A:WHetwoR Ch.

file C:YFROGRAR FILESYMWIRCAPS 24111 RA-0007 U Ra-0001 2n|
and, each data updated

cHaGk Earze]
Reference: Select an optional system project.
Back: Return to the initial screen.
Next: Proceed to the write object data select screen.
Cancel: End
Select the object data and click on Next.
} STEP 3 Select data by attaching a check mark for the write object.
" FDTool ver 1.1.3

Select object data by manager. Al the data managed by selected
manager will become object,

- Object data
All program data <PAC Manager: Select |

|| All variablz data <ariable Managers
1Al D0 data <DI0 M anager:

AN A data <A Manager:

] All vigion data <Mision Manager:

I ] Al Log data <Log Manager:.

 <Back e Cancel
Select All: Select all object data for writing.
Back: Return to the select screen of the system project.
Next: Write to a floppy disk.
Cancel: End
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» STEP 4

4-28

The following message appears requesting you to insert formatted

floppy disk. Insert a formatted floppy disk into the floppy drive and
click on OK.

:_FDTOOL
|/": inzert fomatted disk.
1 Diisk, Mo, will be
[#1].

If the inserted floppy disk already has data on it, the system asks if it is OK
to delete it.

Clicking on Yes deletes the file on the floppy disk.
Clicking on No returns the display to the object data select screen.

+ FDTOOL

@ [01-2-199182604] Time stamp data already exists. OF. to delete?

If the floppy disk is neither inserted nor formatted, an error message
appears. Insert the correct disk and click on OK.

: FDTOOL :

& Either dizk iz not inzerted or formatted. Insert the disk.

Cancel | |

When the correct disk is inserted, the object data is read. Reading
progress is indicated with a bar graph.

% FDTool ver 1.1.3

Al program data writing

ITFCNF.DAT

<Bask Hesi> Cancel




» STEP 5

Chapter 4 System Manager

When data is written normally, an indication to that effect appears.
Click on Complete.

" FDTool ver 1.1.3

Wwiote data to AW etwoB Ch
‘wirite data time stamn becomes [01-2-199182604]

<Baok | Complete” : Eane]
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4.4 Window Menu

¥ IRA-0000 - System Manager M= E |

File  Tools | window Help
- PAC Manager
Eg%ix ﬁ Yariable Manager
DI0 b anager
M Ay M anager
Yizian Manager
LOG Manager

Fig. 4-20 Window Menu

4.4.1 PAC Manager

Start the PAC Program Manager.

The PAC Program Manager may be started by clicking on the PAC Program
Manager button %&Tl .

For details on the PAC Program Manager, read Chapter 5, “Operating PAC
Program Manager” and Chapter 3, subsection 3.5 “Entering and Editing
Program” on page 3-22, of this instruction manual.

When PAC Program Manager is connected to the Robot Controller, the button
icon display changes to iisl .

4.4.2 Variable Manager

Start the Variable Manager.

The Variable Manager may be started by clicking on Variable Manager button
:

For details on the Variable Manager, refer to Chapter 6 “Operating Variable
Manager”. For operating procedures, refer to Chapter 3 “3.14.1 Starting
Variable Manager” in this manual.

While Variable Manager is connected to the Robot Controller, the button icon

display changes to .

4.4.3 DIO Manager

4-30

Start the DIO Manager.

The DIO Manager may be started by clicking on DIO Manager button @l .

For details on the DIO Manager, refer to Chapter 7 “Operating DIO Manager”.
For operating procedures, refer to Chapter 3 “3.13.1 Starting DIO Manager” in
this manual.

While DIO Manager is connected to the Robot Controller, the button icon
display changes to gl .
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4.4.4 Arm Manager

Start the Arm Manager.

The Arm Manager may be started by clicking on Arm Manager button ﬁl .

For details on the Arm Manager, refer to Chapter 8 “Operating Arm Manager”.
While the Arm Manager is connected to the Robot Controller, the button icon

display changes to il .

4.4.5 Vision Manager

Start Vision Manager.

Vision Manager may be started by clicking on Vision Manager button @l .

For details on the Vision Manager, refer to Chapter 9 “Operating Vision
Manager”.

While Vision Manager is connected to the Robot Controller, the button icon

display changes to @l .

4.4.6 LOG Manager

Start LOG Manager.

LOG Manager may be started by clicking on the LOG Manager button .

For details on the LOG Manager, refer to Chapter 10 “Operating LOG
Manager”.

While LOG Manager is connected to the Robot Controller, the button icon

display changes to .
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45 Help Menu

The Help menu provides useful information on how to use WINCAPSII.

¥ HS-E - System Manager == =]

Eile  Toolz  Window | Help

o —— Licenze Information
i |B]

avetem Extension
|5y5tem Marager |5ta| About Syztem Manager

Fig. 4-21 Help Menu

L
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4.5.1 License Key

Register the license key of your WINCAPS Il. This registration allows you to
use all the WINCAPS Il functions.

Enter the User ID printed in the license card and click Add.

» STEP 1

Please enter your licenze key.

Lieree o I xxxxxxxxxxxxxxx Add
Licenze key Bemove |

Ok I Cancel

Confirm that the entered User ID is displayed in the license key list

} STEP 2 and then click OK.

Fleaze enter your licensze ke,

Licenze Key: |

Bemove |

Lizenze key

0k Cancel
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45.2 System Extension

Even in WINCAPSII Version 1.9 or later, you may resist or delete optional
functions that the robot controller will use.

When WINCAPSII and the controller are in connection, select the “System
Extension” of the Help Menu. The System Extension screen appears.

Systom Extension
Pleaze enter |0 Number and click [Add] or [Remowve] button.
|0 Mumber : | £dd |
ﬁystem Eutension 134737320 Bemove |
Cloze |

After inputting the specified ID Number, resist or delete the optional function by
pressing the “Add” or “Remove” button.

Examples of optional functions

Optional function ID No. Reference manual
Tip compliance control | 6519 | PROGRAMMER'S MANUAL Chapter 3
Supervisory task 1111 | SETTING-UP MANUAL Chapter 3

4.5.3 About System Manager

Displays the version information of WINCAPSII on the screen.
Use this for verifying the WINCAPSII version for maintenance and other.

i About Yersion |

@ WINCAPS I
' System bManager

YWersion 1.7.0-015

Warning: Thiz product iz protected by Japan Copyright Law and
International Agreement. Reproduction of whale or part of this
product ar digtribution of copies without written consent
cohztitutes violation of copyright.

Swyztem Info...

Fig. 4-23 About System Manager
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Operating PAC
Program Manager

This chapter describes how the PAC Program
Manager, within WINCAPSII software, functions
and is used by the personal computer teaching
system.







Chapter 5 Operating PAC Program Manager

5.1 Outline of PAC Program Manager

5.1.1 Outline of Functions

The PAC Program Manager is a comprehensive support tool for developing
structured robot language for the PAC program. In addition to general
functions of the text editor, the Program Manager enables you to create
programs with ease, using the PAC language command builder, program bank
and other tools.

The PAC Program Manager starts when the System Manager #it| button is
clicked on or from the Window menu.

Upon starting the PAC Program Manager, the PAC Manager window appears
on the screen.

2 CAWINCAPSINBINAWS-0013W5 -001 _ppj - PAC Manager

Tool bar File Edt Program Actions Tools Help
Dlﬁ-lgl@l@lﬁ'l |Current T|| El @l
Mo |File [kodified |Program [ Title
N PROT000.pac 37242000 4:40:538 Phd FRO1000 <Title>
1|PRO1007.0ac 3202000 44124 P FRO1001 <Title>
2EPROT002. nac 34202000 4:41:35 PM PRO100E <Title>»
*
PAC 5130 -
STRAN Y1312
[CAWINCAPSIDBm\YE-00 \PRO 1002 pac]
=
] \
File name registered Program title

to the project
Fig. 5-1 PAC Manager Window

Program name: Displays the program name registered to the project.
Program title: Displays the title information registered with I TITLE statement in the program.

5.1.2 Tool Bar
NEW PROGRAM Button =

Newly registers the program to the project

ADD PROGRAM Button &/

Adds an existing program to the project.
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SAVE PROJECT Button &

Saves the state of all programs and projects currently being edited.

CREATE EXECUTION PROGRAM Button &

Creates a program in the executable format from the program registered to the
project.

SYNTAX CHECK button &

Checks the syntax of the selected program.

TRANSMIT Button =/

Transmits data between the Robot Controller and the personal computer.

SELECT ACTION OBJECT List [cwren 3]

Selects the action object. The following are the action object types:

Current:  Action object for action in the currently selected program.

Project: Action object for action in all of the current programs.

Group: Action object for action in the current group program.

This function is designed for execution with all action object actions that have
selected items, other than CONNECT and STOP in the action menu.

Note: For the group setting, refer to Chapter 5 “5.2.5.4 Group” in this
manual.

STOP Button #]

Stops the creation of the execution program.

HELP Button </
Displays the descriptions of commands (COMMAND HELP).
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5.1.3 Basic Usage

The following illustrates the basic flow of the PAC Program Manager.
Figure 5-2 shows the monitoring program operation flow.
Figure 5-3 shows the program creation design flow.

Select a program Refer to “SELECT ACTION OBJECT List” on page
that you want to 5-2.
monitor

Start monitor

'

Refer to “5.6.4 Program Monitor”.

Fig. 5-2 PAC Program Manager Basic Usage (Monitor)
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5-4

Add new program

,

E— Program input

,

Creating execution
format file

.

Number of
errors =0

Transmit program

'

Program start

No

Refer to “5.4.1 New”.
To renew a project, read “5.2.1
“New Project”.

Refer to “5.6.3 Command Builder”.

Refer to “5.2.8 Make Exec. Program”.

Refer to “5.2.6 Transmit Project”.

For operation of the teach pendant,
read “1.5 Automatic Operation” in Owner’s
Manual (Setting-up).

Fig. 5-3 PAC Program Manager Basic Usage (Design)
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5.1.4 File Management

Figure 5-4 illustrates the types of files that can be managed with the PAC
Program Manager. Descriptions of each file are given below:

Program
Manager

3
#* LNK
Program bank Make file Program project
file file

*.PAC Program file

* RIC Intermediate

N

* MAP #NIC | Execution

format file

Cross
reference file

Fig. 5-4 Files Managed with PAC Program Manager
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5.1.4.1

5.1.4.2

5.14.3

5.14.4

5-6

Program Project File (*.PPJ)

Program Project refers to a group of programs used simultaneously.

Only one program project can be opened at a time.

The Program project file saves the program source file reference information,
included in the program project.

The program project file extension is “.PPJ”.

The System Manager controls which program project to use with the currently
selected system project. The System Manager specifies which program
project file to use when it starts the program manager.

When the program project is changed with PAC Program Manager, data
concerning the System Manager program project file is automatically changed.

Program Source File (*.PAC)

Program Source File refers to the file used to save individual programs
sources.

One program source file for each program source.

The file extension is “.PAC”.

One program source file may be registered to multiple program projects. In
this case, changing a program source file from a program project will affect
other projects.

Intermediate File (*.RIC)

A file that accommodates intermediate code is automatically generated when
converting a program to an executable.
The file extension is “.RIC”.

Program Bank File (*.BNK)

Saves the library programs to be used by the program bank.
One program bank file saves all the programs to be used in one library.
The file extension is “.BNK”.
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5.1.4.5 Executable File (*.NIC)

Accommodates format program data execution.
The file extension is “.NIC”.

5.1.4.6 Cross Reference File (*.MAP)

A file that accommodates cross reference is automatically generated when
converting a program into an executable.
The file extension is “.MAP”.

5.1.4.7 Make File (*.LNK)

A file that accommodates link information is automatically generated when
converting a program into an executable.
The file extension is “.LNK”.
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5.1.5 Menu List (PAC Program Manager)

The PAC Program Manager command menu has the following tree structure:

File
New Project (Programmer Level) *1
Open Project (Programmer Level) *1
Save Project
Save Project As (Programmer Level) *1
Set Project
Transmit Project (Programmer Level)
Print
Make Exec. Program
Make Macro Definition File
Close

Edit
Undo
Cut
Copy
Paste
Delete
Select All
Search
Replace
Jump line No

Program

New

Save

Save As

Add

Release

Check

Import

Export

Rearrange
File Name
File Date
Program Name

Actions
Show
Hide
Stop

Tools
Options
Program Bank
Command Builder
Program Monitor

Help
About PAC Manager

Fig. 5-5 PAC Program Manager Menu Tree

*1 Displayed only when the display option file extension menu is checked. To
set the display option, first login again at Programmer level, then select
Tool, Options, and View and check the option file extension menu.
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5.2

5.2.1

5.2.2

5.2.3

5.2.4

Chapter 5 Operating PAC Program Manager

File Menu (PAC Program Manager)

PAC Program Manager File menu is shown below:

1" C:\WINCAPS 2\PROJECTMRA-OC

File Edit Program Action: Tool: H

MNew Project

Open Project...

Save Project

Save Project Az ..

Set Project. ..

Transzfer Project... Chrl+T

Erirt. .. Chil+F

take Exec. Program

Make Macro Defintion File

Cloze

Fig. 5-6 File Menu

New Project (Programmer Level)

Create a new program project and simultaneously save it to the new program
project file.

Open Project (Programmer Level)

Select and open the program project file.

Save Project

Save the program project information currently under editing to the program
project by overwriting.
Clicking on the SAVE PROJECT button | provides the same function.

Save Project As (Programmer Level)

Save the program project information currently under editing to the new
program project file. Optionally, name the new program project file to avoid
redundancy.
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5.2.5 Set Project (Programmer Level)

Creates project settings.
Upon selecting Set Project from FILE menu, the Set Project dialog box

appears.
Click on OK to register the change content. To erase the change content, click

on Cancel.

5.2.5.1 Document

Click the Document tab to enter the document name used when creating the
project.

&, Set Project |

Enn:l-eltéT Frogram TlnterpreterT Group TReIated File‘

Title: |Palletizing

This projectfile was created by the FAC Wizard automatically. |
Madify the program name, variable name, DIO definition table or the
algarthm if wou need.

[How to execute]

0. Editthe program if you need.

1. Create the excutable file.

2. Transpaort all files.

3. Teach F&0 1o P55 using Pendant.

[ |

Ok | Cancel

Fig. 5-7 Document Tab (Set Project) Dialog
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5.2.5.2 Program

Click the Program tab to set the variable parameters to be used by the project.
For details on the parameters, refer to “Appendix” in Owner's Manual

(Programming).

&, Set Project

=]|

Document T éPrngra-ST InterpreterT

Group

| Related File |

Fropey

SetWalue

Approximate values comparing &
Deletion of frace code

Deletion of oywcle time calculation
Deletion of arrangement range ct
Deletion of error interrupt process
Language mode

F.

g
1000

JE R N e R N |

Ik,

Cancel

Fig. 5-8 Program Tab (Set Project) Dialog

Note: The asterisks (*) under the property are the parameters of which
settings are prohibited because of the programmer level selected
when you log in to the WINCAPS II.
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__________________________________________________________________________________________________________________|
5.2.5.3 Interpreter

Click the Interpreter tab to set the parameters to be used by the project
execution program.

Set the variable parameters to be used by the project. For details on the
parameters, refer to “Appendix” in Owner’s Manual (Programming).

=]|

DncumentT Frogram TéllterpreterT Group TReIated File‘

&, Set Project

Fropey setWalue
* 128
* 2hb
* 1
* 32
Continue/Festoration (0:MNao 1:Cor 1
Automatic position restoration 1
oafety start mode(1:Enabla 1:510 0
Time for Check(TC)(s) k0

R Y 1 R ¥ LI O r

0] Cancel

Fig. 5-9 Interpreter Tab (Set Project) Dialog

5.2.54 Group

Click the Group tab to group the programs.
After setting the groups, all the programs registered to the groups can be
handled as action objects.

W, Set Project E
Docurnent T Prograrm T InterpreterT Eruup I Related File |

MNo.| Group Name |Member
<Group 02
<Group 1>
<Group 22
<Group 32
<Group 4>
<Croup 53
<Group B2
<Group 7>

;| AL |2

DK | Cancel

Fig. 5-10 Group Tab (Set Project) Dialog
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Set up the groups using the following procedures:
Register the group name.
} STEP 1 Input an optional group name.

Input the group members.

} STEP 2 Input the program names to be registered to the group.
Input a semi-colon at the end of each program name.
(Example) PRO1; PRO2; PRO3;

5.2.5.5 Related File

Click the Related File tab to register the include files of own creation or related
files, created with other application software here.

Registered files may be opened by double clicking. This automatically starts
the created application.

W, Set Project E

Docurnent T Progranm T InterpreterT GroLip Related File'

Felated Eiles List:

Eelease

=]

e

il

¥ Open using Special Texd Editar

Ok

Cancel |

Fig. 5-11 Related File Tab (Set Project) Dialog Box

Add button: Adds a created file to the project.

Release button: Releases, from the project, files selected from the
Related File List.

New button: Creates a new file and starts the dedicated editor.

Open button: Opens the file selected from the Related File List.

The file may be opened by double-clicking.
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5-14

If you put a checkmark at Open with Special Text Editor, the dedicated text
editor is used. If the application software used to create the file is not defined,
the file is opened with the normal editor.

Fj C:\Program Files\WINCAPS 24IRA-0000\vnoname1_txt =] E3

Bl &=

fidef ine Hode 1
fidef ine Type 3

L3l | CAPE | NUM IR o

Fig. 5-12 Operation with Dedicated Editor

. Saves the file currently being edited.

= D

. Cuts out selected range data. Cut data can be used with the Paste
command.
The same operation can be accomplished with [Ctri]+[X].

. Copies selected range data. The copied data can be used with the Paste
command.
The same operation can be accomplished with [Ctrl]+[C].

. Pastes cut or memorized data by copying to a specified location.
The same operation can be accomplished with [Ctrl]+[V].

®
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5.2.6 Transmit Project

Program data may be transmitted or received only when the Robot Controller is
in connected communication state.

When the Transfer dialog box appears, select the data to be transmitted and
click on Transmit or Receive to send or receive data.

The same result can be achieved by clicking on the Transmit button & .

@ Transfer E3

—Laocal —FRemaote

<Frogram Table> Transmit> | [ e S

<Interpreter Tahble> . <Interpreter Takle
£ Beceive

{Crossreference Te Executable

<Execution Frogram

AutoExec Cancel VISTBL3?

prozg AUTOEXEC

prol select All PRI

Idio_tab.h TSFRO_E00

Iwar_tab.h TSPRO_250

TSFRO_7A0 Ll

Fig. 5-13 Transmit Dialog Box

5.2.6.1 Program/Interpreter Table

¢ Program table

Shows the project setting data described in “5.2.5.2 Program” on page 5-11.
o Interpreter table

Shows the project setting data described in “5.2.5.3 Interpreter” on page 5-12.

5.2.6.2 Map/Executable Program

e Map File
This file is needed when you refer to the variables or the other data used in
the executable program.
The map file is referred to when the program is executed. Therefore, treat the
file in pair with the executable program.

¢ Executable Program
Program in the executable format created from the programs registered in the
project.

5.2.6.3 Program Source

e Source File
PAC program (*.PAC) needed for creating an executable program.
Your personal computer (remote side) displays all the PAC programs
currently stored in the Robot Controller, while the Controller (local side)
displays all the PAC programs registered in the project.

e Header File
This file is referred to by the PAC program (*.PAC). Specify the header file
name with the “#INCLUDE” statement in the program.
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5.2.7 Print

Prints the program list and the parameter table of the PAC Program Manager.

5.2.7.1 Print Object

The Print Manager dialog box appears on the screen. Select the Print Object
tab. Select the item to be printed and click on Print to print the specified data.

!'_- Print Manager

Print DhjEl::tT Cptian ]

Frinterin ~ Canon LBFP-740 LIFS4

SelectAll |
v <Project>
Iv| AutoExec
v proz
v| aro
Print Cancel | E=rEnieny | Set

Fig. 5-14 Print Object Tab (Print Manager) Dialog Box

e Select All: Selects all objects for printing at one time.

o Set: The printer data setting dialog appears. In this dialog, set the
required printing conditions.

e Preview: Enables viewing the printing state before actual printing.

e Cancel: Closes the dialog box without printing.

e Print: Prints the selected object.

Supplement: If you wish to print only the specified page, see preview

and click on the print button | & .

Note: Preview is not usable if several objects are selected for printing.
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B2 <Program: Mi=1 E3

3

PAC Manager widEiE

<Piogiamr ; Moan s o - *po_mrh’

Pmgerip Valic rlacm homalenc
o olurps | rmichls T [Fr_00 T [
e mlype F »miohi=s lom W0 STk 1
o ofiggs Drocla s [P _pd CEL 1
o ofgpe Veoicila s [P _povEr 1
o olips Frmdila i [P 1
o elpe | smichls 1un oo 1WT 1

Eﬂ T of 1 3 I B I l:ant:ell él’lﬂﬂl Elusel Eofg Tatz

Fig. 5-15 Preview Window

4] ¥ : Moves the cursor to the top/end of the page.
il Ll . Moves the cursor to the preceding/following page.
@l . Selects the display size (Reduced/Standard/Expanded)

@l . Sets the printing conditions.
You can specify the printing range (in pages) of the object file.

Print

Printer; Swstem Prnter [Canon LBP-740
LIPS4]
[~ Print Range —— 1 Cancel ;

- 1 Eages . Copigs: ﬁm—w
| Eranm: i'i T ;'I I .
i L . ¥ Callate Copies

Fig. 5-16 Print Widow
B3 @] : Exports the object file.

Outputs destination after converting to a specified file format.

E xport

Format; D estination:

| Disk file =]

(] i Cancel i

Fig. 5-17 Export Window
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5.2.7.2  Option
Selecting the Option tab displays print options.

Print Object | ©Option: |

[ Print Continuoushy
¥ Print Line No.

Frint Cancel Frewview Set

Fig. 5-18 Option Tab (Print Manager) Dialog

¢ Print Continuously : When this box is checked, several programs are
continuously printed without change of page.

e Print Line No. : When this box is checked, the line numbers are also
printed.

5-18



Chapter 5 Operating PAC Program Manager

5.2.8 Make Exec. Program

Translates a program file, contained in the project, into an executable format.
Consecutively displays the state of execution to the message display.

The contents of errors generated during translation are displayed in the
message pane. Double-clicking on the error line in the message pane jumps

the display to the location of the error.
The same function is available by clicking on the Make Exec. Program button

=l

£.F C:\Program Files\WINCAPS 24 RA-0000% RA-0000. ppi - PAC Manager
File Edt Program Action: Took Help

,éclll Dlﬁ-lﬂl@l@l ICurrem ‘rl ﬁl@l

[ils] Filename kodification |Frogram name State |Line Mo, [Cyvcle| Tile
) fN sy eT et atateg: =/ 5/99 B4 [AulnExec 0 I
1|pro.pac 318/99 2:30: prog aroZ
2| prol.pac 318/99 2:33; prol arol
3
PAC WV1.10 =
SLINE V1Ll
[CAProgram Filest W IN CAPEAIRA-000 K IRA-N000.mic]
[ |

Message Pane
Fig. 5-19 Message Pane

5.2.9 Make Macro Definition File

5.2.10 Close

This button allows you to create the header file that defines the parameter
numbers.

You can refer to the parameter values from the program using the defined
macro names.

e Macro definition file for interpreter: itp_cnf.h

¢ PAC definition file: pac_cnf.h

Ends the PAC Program Manager and closes the PAC Manager window.
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5.3 Edit Menu (PAC Program Manager)

This Edit menu functions as a standard editing menu, adopted from application
software for Windows 95. The editing object consists of character strings,
handled in the program editing window.

Edt Program  Action: Too

e [Str{+z
Cut Chrl+
Copy Cirl+1Z
Fazte Clrl+
Delete Del
Select All

Seaich ... Cir+F
Beplace. . Ctrl+H

dumnp line Mo.... Chrl+d

Fig. 5-20 Edit Menu

5.3.1 Undo
Cancels the previous operation and restored the initial state.

5.3.2 Cut
Cuts out selected range data. The cut data can be used with the PASTE
command.

5.3.3 Copy

Temporarily memorizes selected range data. The temporarily memorized data
can be used with the PASTE command.

5.3.4 Paste

Pastes the cut data or temporarily memorized data, by copying to a specified
location.

5.3.5 Delete

Deletes selected range data. The cut data cannot be used with the PASTE
command.

5.3.6 Select All

Selects all the data currently displayed in the active window.
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5.3.7 Search

When you select Search from the Edit menu, the Search dialog box appears

on the screen.
Specify the necessary items and click on Find Next. The specified character

string is then searched for.
The found character string is displayed in reverse video.
To close the dialog, click on Cancel.

i Search E

Eind What [Move =] [ FindNext |
Object Search IWhDIe 'I Cancel |

" Project
& Current Program
" Selected Bange

[T Match Case

Fig. 5-21 Search Dialog Box

¢ Find What : Enter a character string that you want to search.

e Search : Specify the searching direction. If you select Whole, the
search is carried out downward to the bottom end and then
continued from the top of the data downward.

¢ Object : Select the searching range from whole project, current
program and selected range.
e Match Case : If this box is checked, a search is carried out with
distinction

between upper and lower cases.
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5.3.8 Replace

5-22

This function replaces the specified character string with a separately specified

character string.

When the Replace dialog box appears, specify the necessary items and click
on Find Next. The found character string is displayed in reverse video.

Click on Replace, and the found character string is replaced.

If you click on Replace All, all the occurrences of the selected character string

will be replaced.

i Replace
Eind What [Move ~] | FindNext |
Feplace With: I j Cancel |
Object Search IWhDIe "l |
" Project Beplace
&+ Current Program Feplace ﬁlll

" Selected Bange

[ Match Case

e Find What
¢ Replace with
e Search

¢ Object

e Match Cases

Fig. 5-22 Replace Dialog Box

. Enter a character string to be searched.
: Enter a character string to be replaced with.
: Specify the searching direction. If you select Whole, the

search is carried out downward to the bottom end and
then continued from the top of the data downward.

. Select the searching range from whole project, current

program and selected range.
If this box is checked, the search is carried out with

distinction between upper and lower cases.
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5.3.9 Jump To

Displays a specified line of a specified program.
When the Jumping Line No. dialog box appears on the screen, specify all
necessary items and click on GOTO. The specified program is displayed and

the cursor is set to the head of the specified line.

B Jumping Line No. I
' Frogram MName: IﬂuutDExec j
| Line Mao.: [10]

GOTO Cancel

Fig. 5-23 Jumping Line Number Dialog Box

e Program Name: When clicked on, the program file names appear in a
pulldown menu for selection.
e Line Number:  Input to specify a line number.
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5.4 Program Menu

5.4.1 New

5.4.2 Save

5-24

Manages the program files.

EmEm Actionz  Toolz

e Chrl+M
Save Chrl+5
Save Az

Add Chrl+0
Releaze

Check

Irpart Clrl+l
Expart Chrl+E
Rearrange r

Fig. 5-24 Program Menu

Creates a new program file and adds it to the project.

A new file is added to the end of the PAC Program Manager file name list and
the Edit window automatically opens.

The same function is available by clicking on the new program button [J] .

Saves the selected program file.
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5.4.3 Save As

Saves a program file with a new file name.
When the Save Project As dialog box appears, specify the path, program name
and click on Save to save the program.

Save Project As

Save in: i £ Ira-0000

|#] autoerec pac

File name: i| Save ;
Save az type: iF'ﬂ-.E program(* pac) j Cancel !

Fig. 5-25 Save Project As Dialog Box

Note: To newly save the program, save the current content to a program
source file under a separate name. Update the program project
reference information so that is references the new program
source file. If retaining the program project reference information,
as it was and creating a file under a separate name, use Export.
For details, refer to Chapter 5 “5.4.8 Export” in this manual.
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5.44 Add

5.4.5 Release

This function adds the existing program to the current project.

When the Adding program dialog box appears, specify the path, program name
and click on Open.

The same function is available by clicking on the add program button =)
When specifying several programs simultaneously, click on the files while
pressing the shift key or the control key.

Adding program

Laak ir: ;Eﬂlra-EIEIDEI :j f_:f-i
autoexec. pac

File name: || Open I
Filez of ype: IF'.-“-‘-.I: programl® pac) j Cancel |

Fig. 5-26 Add Program Dialog Box

Note: When sharing one program among several program projects, use
the Add Program function. If the program is changed but you do
not want to affect other projects, use Import. For details, refer to
Chapter 5 “5.4.7 Import” in this manual.

Releases the currently selected program file in the program project.

The program file remains as it is, but it is no longer contained in the project.
Reference information for the program is deleted from the program project
reference information.

Note: A project must have at least one program. It is not possible to
release all the programs.

5.4.6 Syntax Check

5-26

This button allows you to check the syntax of the selected program. If an error
is found, the message pane displays the error. Double-clicking the Error Line
makes the cursor jump to the corresponding error position.
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5.4.7 Import

Registers a specified file name to the program project after copying it to the
folder in which the project is contained.
If imported, the program is not shared with other program projects.

Note: When sharing one program among several program projects, use
the Add Program function. For details, refer to Chapter 5 “5.4.4
Add” in this manual. In this case, note that change of the shared
program in a project will affect the other projects.

5.4.8 Export

Saves a selected program as a new program source file, under a specified file
name.

Note: With export, program project reference information remains
unchanged and a separate file is created. When updating to refer
to a new program source file, use Save As. Refer to Chapter 5
“5.4.3 Save As” in this manual.

5.4.9 Rearrange

Changes the order of the displayed program files.
According to your selection, the files are arranged in the order of file name, file
date, or program name.

[REEENE Action: Tool: Help

(= Crrl+f
Save Chil+5
Save Az

Add Chrl+0
Belease

[mpark Chrl+l
Expart Chl+E

Eile M ame
File [ ate
Program Marne

Fig. 5-27 Rearrange
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5.4.9.1 File Name

Rearranges the program files in order of file name; the file names are listed
according to the ASCII code.

5.4.9.2 File Date

Rearranges the program files in order of date; recently updated or created files
come to the top.

5.4.9.3 Program Name

Rearranges the program files in order of program name; the program names
are listed according to the ASCII code.

Note: When Rearrange is executed, the date check option is temporarily
turned OFF. This means all the source programs will be compiled

again when Compiling is executed. For details, refer to Chapter 5
“5.6.1.3 Make” in this manual.

5-28




Chapter 5 Operating PAC Program Manager

5.5 Actions Menu (PAC Program Manager)

5.5.1 Show

5.5.2 Hide

5.5.3 Stop

The Actions menu has the following commands. The tool bar of Program
Manager has the buttons that correspond to these commands and have the
same effect.

Bctions Too

Shows
Hide

Stop

0|28 & Bl [curent =] <l

Fig. 5-28 Action Menu and Buttons

Displays the edit window of the program selected from the Select action object
list.

The edit window also appears when you double-click on the program file name
in the list.

Closes the active edit window of the program selected from the Select action
object list.

The edit window is also closed when you click on the close box in the Edit
window.

Stops program creation specified by Make Exec. Program in the File menu.
When stopped in the middle, the message pane shows “Interrupted”.
The stop button ] has the same function as the Stop command.
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5.6 Tools Menu (PAC Program Manager)

5.6.1 Options

Used to set the operating conditions of PAC Program Manager.
After selecting Options from the Tools menu, the Options dialog box appears
on the screen.

Note: Items that can be edited differ by user level. For restrictions by
user level, refer to Chapter 1 “1.3 Security”. To change the access
level in the middle of program editing, refer to Chapter 4 “4.3.3 Re-
Log In” in this manual.
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5.6.1.1

Editor

Chapter 5 Operating PAC Program Manager

-ﬁI- Options |
—Faont ~Takb
Font Marme: IFiXEdSFS j Tah Intervals: | b
Size: |'| Z "l
— Option Switch
colar W Program Jump
Fareground: IEHan::k j " Automatic Cuick
Hint
Background: IWhite j Automatic
v -
Compiling
K Cancel
Fig. 5-30 Editor Tab (Options Dialog Box)
e Font Name: Specifies the font to use for text editing. Clicking on
the arrow *| displays the list of selection items.
e Size: Specifies the font size. Clicking on the arrow j displays

¢ Foreground:

e Background:

e Tab Intervals:

e Program Jump:

e Automatic Quick Hint:

¢ Automatic Compile:

the list of selection items.

Specifies the color of the foreground. Clicking on the
arrow =| displays the list of selection items.

Specifies the color of the background. Clicking on the
arrow =| displays the list of selection items.

Specifies the distance (in millimeters) from one tab
position to the next.

If you execute Search by Key in the File menu with
this option set at valid by specifying the program
name or label name, the specified program name or

label name is displayed.

With this option switch ON, a quick hint appears to
help your text input.

With this option switch ON, the Program Manager
automatically checks the syntax after the program is
stored.
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<Program name>

"TTITLE "'{Title}"

"¢TITLE “'PRO1™

PROGRAM PROS PROGRAM PRO
CALL TAKEARH
GOSUB =LAST HOUE P, P[pHome], S=58
EHD SPEED 1408
CALL dioWaitAndSet({ioParts, ioPartsick)
#LAST: CALL pro2
RETURH SELECT CASE I[iPartsId]
CASE -1
CALL dioSetAndWYait{ioErrQR, ioErrQl
CASE 1
GOSUB =PlacePartsA l
4] | - k]
[31ma |CaPs | | TS o [ 11me CAPS | MM |TnS A

Execute Search by Key

<Label name>

"ITITLE ""{Title>"

PRO1 Edit Window Appears

"fTITLE "'{Title}"

PROGRAM PROS PROGRAM PROS
GALL PRO1 CALL PRO1
cosue EEN GOSUB =LAST

END END

#LAST: *LASTE

RETURH RETURH

[ 10me |CAPS | WM |1Ms w |7 line CAPS |NTOM |INg w

Execute Search by Key

Fig. 5-31 Program

2} C:\Program Files\WINCAPS 2\IRA-0000\piol.pac =] E3

"*TITLE “prol”
#include “dio_tab.h"
#include "var tab.h"
PROGRAM proi

Shift to “*LAST:”

Jump

DEFART [DEFPART tInterpolation method>.[¢Pass star displacements [¢<Depart |engths [ ¢kotion optiond [LNEXT]

END

[Sline [CAPS [T [THS 7

Quick hint

Fig. 5-32 Automatic Quick Hint



5.6.1.2

Make

Chapter 5 Operating PAC Program Manager

Click the Make tab to set the conditions for execution program.

E T

| Compiler | Displayl

—Execution Filename

[CaINCAPS 2\ PROJECTYRA-DDODY RA-DDO0 nic

— Option Switch

[ 2000
W Inspect Date Mame Table: | 2000
BT

~Takle Size
Symbal Table: | 32000

BEearrangement | 15384
Tahkle:

0] | Cancel

Fig. 5-33 Make Tab (Options Dialog Box)

e Execution Filename: Specifies a file name when renaming the execution file.

¢ Date Inspection:

e Symbol Table:

e Name Table:

¢ Rearrange Table:

By default, a program project file name having the
extension “nic” is specified. If you do not wish to
overwrite this file or wish to unify all the projects in an
executable file name, change this value.

If this switch is checked, only the changed programs are
converted into execution form by depression of Make
Exec. Program, shortening the program creation time.
Sets the size of working range for storing information on
symbols.

Sets the size of working range for registering information
on names such as label name. This range is used to
register information on all names handled by the program
files included in the executable file.

Sets the size of working range for determining the
absolute addresses.
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If execution file is not specified

(default)

ira-0000.ppj —ll ira-0000.nic
If execution file is specified
Ira-OOOOppj ﬁ SpeCIerd flle
name

Fig. 5-34 Option for Renaming an Executable File




5.6.1.3

Compiler

Chapter 5 Operating PAC Program Manager

Click the Compiler tab to Make settings for creating an execution program.

¥E Options

]|

..............................

...........................

— Dption Switch ~Tahkle Size
Block Table: [ 100
Line Tahle: IW
¥ Explicit Type Declaration |0 Takle: |—5|j|
¥ Inspect Constant Bange Diim Tahble: 150
O G Eree Chain: IW
|'|4|:|-\-"EH.4 j Mame Tahle: IW

Ok | Cancel

Fig. 5-35 Compiler Tab (Options Dialog Box)

¢ Explicit Type Declaration:  Error will occur unless local variables are

explicitly declared with a specification statement
or postfix. If this option is found invalid, without
explicit descriptions, it will be regarded as a
single accuracy variable.

e Inspect Constant Range: Checks the range of an argument with the

¢ Output Code:

e Block Table:

e Line Table:

¢ |O Table:

e Dim Table:

e Free Chain:

e Name Table:

statement described as constant when creating

the execution program.
Sets the software version of the robot controller. Depending
upon the version, the output codes of the execution program
will differ. If the version specified here is different from the
actual software version of the connected controller, an error
will occur at the time of communication.
Sets the size of working range for storing the nested state of
loops and conditional statement, etc.
Sets the size of working range for registering line information.
The numerical value of this table is equal to the number of all
the lines that can be compiled. The same value is equal to the
nest level allowed for compiling.
Sets the size of working range for registering information on
IO variables. The numerical value of this table is equal to the
number of defined IO variables.
Sets the size of working range for registering information on
array variables. The numerical value of this table is equal to
the number of array variables that can be defined.
Sets the size of working range for registering information
address link. This is the range used for solving label
addresses, jumping address of branch and loop commands,
and global variables.
Sets the size of working range for registering information
concerning label and other names. This is the range used for
registering information on reserved words and user-defined
labels, etc.
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5.6.1.4 Display (Programmer Level)
Makes the SHOW/HIDE settings of display options.

-ﬁI- Options |
Editor | Make | Compiler Displayl

sion kenu

¥l Transmit all PAC program together.

0] Cancel

Fig. 5-36 Display Tab (Options Dialog Box)

¢ File Expansion Menu: Used to extend FILE (F) menu of the PAC Program
Manager. For details, refer to Subsection 5.1.5,
“Menu List” in this chapter.

¢ Batch Transfer of PAC Programs:
This option allows you to select all the PAC programs
so that the project can be transferred at a time. To
transfer the programs one by one, set this check box
empty.

5.6.2 Program Bank

5.6.2.1 Outline of Functions

This is the function for registering or using a program as an individual part to
share a created program with other robot applications.

When you select Program Bank from the Tools menu, the Program bank dialog
box appears on the screen.
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Select the program name

Chapter 5 Operating PAC Program Manager

Input character string of desired input

£% Program Bank -C:\WINCAPSIIABINVPacB ank1921 bnk

2| & 2L al R »% &
[
Finl ‘hat: [ / A N | Program title
- Name of program
IConventmnaI langu vl Program Info |Argument Info | Documentl ngraml maker
aspChange Program Title ([End load setting State the date
nolAfin Made by|SENS0 wAvE NCORPORATER | 4~ State the E-mail
ndApra 21 address
ndDepa Date: p
ndinb S — State the program
nel - = |~ nametobe
ndOnk Link Module: T concatenated
Eggﬂgos Include File:| <pacman.h> L State the file name input
L TC Call Program: N to the program
heTrang =l N State the program '
— N, name to be called in the

registered to the class

Shows the argument
name in the selected

program

Fig. 5-37 Program Information - Program Bank Dialog Box

g“‘] Opens the registered program bank.

E] Saves a new library to the program bank. (Programmer Level)
ﬂ Adds a library to the project. (Programmer Level)

ﬂ Registers a library to the program bank. (Programmer Level)
E] Saves the current program bank. (Programmer Level)

g| Deletes a registered program. (Programmer Level)

@] Registers a new class to the program bank. (Programmer Level)
@] Changes the registered class name. (Programmer Level)

@l Gets another program bank. (Programmer level)
ICDn\:entiDnaI Iangu'I Selects the class. For details on library program, refer to Part 2
“Command Reference” in Owner’s Manual (Programming).

&5 Program Bank -C:\WINCAPSII\BIN\PacBank1921.bnk [_ (O] x|
=&l B a8 nlE &
Find YWhat: - e Shows the
I I_I argument type
— Program Info | Document| by ograml used in the
aspACLD [<] Ypraperty Argurmeft |fault Value selected
aspChange Bnd load mass (g) 1 / 0 program
nclAdfin - =
ndipra End load center of gravity positio| 1
ndDepa End load center of gravity positio| 1 80 \\
ndlnb End load center of gravity positio| 1 100
ngg . Shows the
neldn
ndonbl default
ndPutPos argument value
ndTC in the selected
ndTrang H program

Fig. 5-38 Argument Information - Program Bank Dialog Box
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#% Program Bank -C:\WINCAPSIIABIN\PacBank1921_bnk

=& B al® nl2| &l

EindWhat | R
Displays the ICDnventiDnal Ianguj Program Infnl Aroument Info Dncument ngraml
descriptions of the ESa [Function]
selected program aspChange End load setting
Writing enabled. ndApra [Format]

ndDepa. laspACLD (<End load mass>, <End load center

ndink

nolJf [Explanation]

ndOnb This statement provides the equivalent func

neCnbl Set the internal load acceleration for prog

ndPutPos set with this internal load acceleration.

ndTC FHAanan Anrdni+4danl

ndTrang ;I ‘| | _'I

Fig. 5-39 Document — Program Bank Dialog Box

Shows the selected program. Writing enabled.

&5 Program Bank -C:A\WINCAPSIIABINAPacBank1921 bnk

b4

&

Find ‘What: |

ICDnventlanaI IanguJ Program Infnl Argument Info | Docfment

S A **TITLE “End load setting’

aSpChange "tAUTHOR “'DEN50 WAVE IMCORPORATED™

noAfin '"*ARG 1, "End load mass {g)", 1, "8"

nd&pra "tARG 2, "End load center of gravity positi
nd0epa "tARG 3, "End load center of gravity positi
ndlnb ‘ARG 4, “End load center of gravity positi
nod Jf HINCLUDE <{pacman.h>

nelOnk ttpragma optimize{"ac", on)

ncdOnbl

ndPutPos PROGRAM aspACLD{myPl%, myX6%, my¥e%, myZed)
prC LETEW cnrsrD, 19, e

nd T rang Ll 1] | LI

Fig. 5-40 Program — Program Bank Dialog Box
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5.6.2.2 Basic Usage

[1] AddingLibrariestoa Project

) STEP 1 I Select a class.
} STEP 2 I Select a program.
> STEP 3 Click on the & button.

STEP 3 STEP 2

&5, Program Bank -Z:\WINCAPSIIABINAPacB 70k 1921 _bnk

STEP 1 ~ Endwhat

ICmentional lang

aspChange
ndafin
nddpra
ndDepa
ndink

ndJf

ndOnh
ndonil
ndFutFos
ndTC
ndTrang =l

Program Info |Argumem Info | Documentl ngraml

Program Title |End load setting

Made by [DENSO WAVE INCORPORATED

Date:

E-rnail:

Link hModule:

Include File:|<pacrnan.h>

Call Prograrm:

[ 2] Registering a Program to Program Bank

) STEP 1 I Select a class.
» STEP 2 I Click on the &8 button.

Select a program to be registered.
» STEP 3 |
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} STEP 4 Click on Register.

STEP 2 STEP 1

el Sig bl s
EIHIE&? a2 ol <
Einel What /|/ =l Eearch |

ICDnventiun Ianguj Program nfo IArgument Info | Document | Program|

=101 %]

spChangE Program Tille [End 1oad seting |
ndléin
ndink
nelJf ~ Copy from
ndOnkb -
Fonbl Emgramlw |
ndPutFos -

rg
ndTrang Inlelp / |
nd+/com
/et "'"
nd/is -

. Copy to
. ;}A\Jame@mvemonn language | |

Fiadistar I Cancel |

STEP 3 STEP 4

[3] Deleting Program Registered to Program Bank

} STEP 1 I Select a program to be deleted.
} STEP 2 I Click on the ﬁl button.
} STEP 3 Click on Yes.

STEP 2

& =10] x|
=& B2 alR 5wl o

EindWhat | 2

Comventional Ianguj Program Info |Ar51mem Info | Document | Program|

ndPutFos AI

ndTrang Fragram Tille [pra1

nefveam i .DensoPacManager <]
nefvclt

2§¥EVSE ® Do you wank bo delete prol
nodvhiv'SE

ndvput o |

neivrst

nev'zet tabh
nodv TypE Call)imgram:

\

/ \\
STEP 3
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5.6.2.3 Updating Program Bank

You can freely customize the program bank by adding or deleting programs.
However, the number of libraries, which is supplied to each version as a
standard, increases each time you upgrade the software version.

When you update WINCAPSII to a newer version, you need to import program
bank related contents customized in the old version into the newer one.
WINCAPSII Version 1.9 or later allows you to do it easily by providing the Auto
and Manual importing facilities.

If you use either of those facilities, WINCAPSII will unconditionally import class
libraries added or customized in the old version into the current program bank.

[ 1] Autoimporting facility

» STEP 1

» STEP 2

When you open the program bank at the first time after updating WINCAPSII,
the Auto importing facility is executed. Even if you do not update the program
bank at this time, you can freely update it by the Manual importing facility.

If an old library is detected, the following massage appears.
When you want to update it, select the “Yes” button.

i .PacManager

The old libramy [C:APROGRAM FILES WM CAPS 24PacBank 728 brk) was detected. Do pou want to merge with the
current library ?

Yes |

If the importing facility finds a class library that has the same name as
one already stored in the current program bank but has different
contents, then the following message appears, prompting you to
confirm overwriting.

If you want to use the old library, select the “Yes” button.

v .PacManager ]

@ The contents of ClearSrvid onitor are different. Do pou want to replace it
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[ 2] Manual importing facility

The manual importing facility is executed by clicking the “Merge Program Bank”
button.

} STEP 1 Click the & putton on the tool bar of the program bank.

| | &

“Merge Program Bank” button.

} STEP 2 The “Open Program Bank” screen appears/

Select the program bank that you want to merge.

Open Program Bank
Loak i Ia Bin
Cormpiler [ Update
Hz-e . PacBank 2 bk
IRAM-DUMP . PacBank1 E|1 E.brk.
Rabastar ] PacBank1917.brk
RobatType PacBank1318.brk
S ample PacBank1921.brk
File name:  |PacBank19012brk Open |
Files of type: IF'rn:lgram Bank(® brik] =] Cancel |
A
If the importing facility finds a class library that has the same name as
} STEP 3 one already stored in the current program bank but has different

contents, then the following message appears, prompting you to
confirm overwriting.

If you want to use the old library, select the “Yes” button.

i _PacManager E

@ The contents of ClearSretonitor are different. Do wou want to replace it 7
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5.6.3 Command Builder

5.6.3.1 Outline of Functions

Select a class.

/ LETA “ariahle name I
Select a command nam LETF 1 +1

registered in the class

— Assignment statermig 3' ¥ EI g Elﬂl @

Assists correct input of commands and arguments, when making and/or editing
a program.

When you select the Command Builder from the Tools menu, the Command
Builder dialog box appears on the screen.

Enter an argument value
used in the selected program.

Argument name of the selected command

/ Command Builder

Fropery \ Setf/alue

Arithmetic expression

LETJ

LETO

LETF

LETR

LETRX _
LETRY

LETRZ H

| BT

Fig. 5-41 Command Builder Dialog Box

E4] Shows the previous class.
¥ Shows the next class.
ﬂCopies the set value of the selected argument to the clipboard.

8| Pastes the clipboard data at the Set Value.

| Executes the program related by a LINK command in the USER
PROGRAM class.
Executes the program related by a respective command in the other class.
If no related program is found, clicking is invalid.

[ Pastes the command selected in the class to the program being edited
& Displays the help data for command reference.
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5.6.3.2 Basic Usage

This subsection describes the method of editing program using the command
builder. The following is an example program line:

MOVE P, P1, S =50 MOVE PTP TO P1 AT 50% INSIDE SPEED

Move the cursor to a desired input position in the Program Edit
} STEP 1 window.

Open the command builder and select the Robot control statement
} STEP 2 from the class selection list.

Select the MOVE command from the command list.

» STEP 3
4

» STEP 4

Enter the argument values of the selected MOVE command as
follows:

*'" Command Builder

Fobot contral stath ;fIJ Elg QI_I ﬁ

HOLD Prl:npeny Setvalue
ﬂE%FéTUPT Interpolation method =
JDECEL Pose @0 F1
JSFEED Fose @0 P2
MC hotion aption 100
RESETAREA MNEST

ROTATE

ROTATEH

SETAREA

CoFEFM ;I

Click on the ﬂlbutton.
The command is entered in the cursor-located position of the program
being edited. (Enter comments from the keyboard.)

» STEP 5

MOVE P, P1, S =50
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5.6.4 Program Monitor

5.6.4.1 Outline

This command monitors the execution progress of programs. As shown below,
the running step is displayed in red, helping you debug efficiently.

.2 Monitor =] E3

Fioect Program  fction Tool

%  AUTO ~ M&MUAL  + TEACHCHECK 5T0P |

001 : 'ITITLE "PROOL" -
002 PROGRAM PROL
003

004 :  Takearm
aas MOVE P,P1
00c ;. MOVE P,PE

a0y . Givearm
o0s
nno «» Frin LI
Eraaremiese! Eriarity [Eartmie Dlsplay Hide
Hilt Stepsiop Cycleston B Step-hac! Sten-fanard
|PRO1 | Lined 4

Fig. 5-41-1 Monitor Window

5.6.4.2 Menu

The command menu of the Program Monitor is shown below.

Project *1

Program
Display
Hide

Actions

Tools
Settings

* Menus exclusively prepared for vision equipment (uVision-21). In
WINCAPSII for standard robots, these menus cannot be selected.
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5.6.4.3 Program menu
The Program menu of the Program Monitor is shown below.

Brogram  Zction Tool

Heset B
Eriarity =4
Gtarhingine
Dizplay Fi1
Hide F12

Fig. 5-41-2 Program Menu

Display/Hide: Displays or hides the contents of programs. If Display is
executed, the contents of a program selected in the program status list will
appear; if Hide, the program status list will appear.

5.6.4.4 Tool menu

The Tool menu of the Program Monitor is shown below.

Tool

Settings. .

Fig. 5-41-3 Tool Menu

Settings: Sets the operating environment of the program monitor. If Setting is
executed, the Settings window will appear.

Monitor tab: Sets the timer intervals at which the program monitor gets data
from the controller. The initial value is 1000 ms.

ﬂ- Setlings E3

. Momtor | General |

............................

~Options
|
Tirner Intersals: — ) 1000 ms

] Cancel

Fig. 5-41-4 Settings Dialog Box (Monitor tab)

Note: If you set the monitor intervals short, the frequent communications
operations with the controller may load the Program Monitor. If
the Program Monitor cannot operate smoothly, set the monitor
intervals longer. (Recommended value: 1000 ms)
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General tab: Makes general settings for the Program Monitor.

¥ Settings E1

—atep-motion
[T Show message to make sure hefore programs running.

—Mlonitor

W Getlastest data with the mode changes.

] Cancel

Fig. 5-41-5 Settings Dialog Box (General tab)

Step-motion: Determines whether or not the confirmation message will
appear before the execution of a program step.

Monitor: Determines whether or not the Program Monitor will get the latest
data stored in the controller every time the controller changes the mode.
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5.6.4.5 Operating procedure

This section describes how to monitor the program [PRO1].

Click a program ([PRO1] in this example) to be monitored by Program

} STEP 1 Monitor.

L. Monitor M= E

Froect Program ~chon Toal

® [ om0 © MANUAL ¢ TEACHCHECK 5TOP |

Mo Program | Status
PRO1 On halt |2
FROZ Onhalt |2 0000 128
PROTD On halt

[=]

i

Eiagranieset Eiizri [Eantiue Display G T

Hizlk Slep-sioy Eicle-ston i Step-bac Slea-fanmard

| #

Fig. 5-41-6 Selecting a Program

Click the Display button to show the contents of the selected

} STEP 2 program. The running step is displayed in red.

s Monitor |- O] %]

Praject Program Action Tool

| s © MANMUAL ¢ TEACHCHECK STOP |

001 @ 'ITITLE "PROOL" o
002 ¢ PROGRAM PROL
003 :

004 @ Takearm
oos ;. MOWE PP1
005 @ MOWVE P,P2
o007 @ Givearmn

003 :
nno « Ern LI
Erogranieset By Comimue M Displap " Hide
Hizlt Steo-sop Cyelestan i Stepbach Steofanyard
[PROI | Line? v

Fig. 5-41-7 Displaying the Contents of the Program
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5.7 Help Menu

Use the Help menu to view descriptions on how to use WINCAPSII.

Help

Lizenze Fey

About Syztem kM anager

Fig. 5-42 Help Menu

5.7.1 About PAC Manager

Displays the version information on PAC Program Manager.
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Operating Variable
Manager

This chapter describes the Variable Manager
functions, in the WINCAPSII software, that may
be used with the personal computer teaching
system.






Chapter 6 Operating Variable Manager

6.1 Outlineof Variable Manager

6.1.1 Outline of Functions

The Variable Manager provides variable data backups and monitoring
functions for the Robot Controller.

Through connection with the Arm Manager and/or the Vision Manager off-line
teaching is possible.

After starting the Variable Manager the Variable Manager window is displayed.

Tool bar Variable scope

[ﬁ C:\Program Files\WINCAPS 25\ BA-0000MWHA -QDOD. var - Yanable Manager

File Edit Actions \ Took Help
|M =] 2] J<Global Aizble> =]
Typel [ Tome F| Type & | Type V| Type P | Type T| Type T| Type & |

Mo Walue |Usage |Ma|:n:|

Rl SN N e
o e o o o o0

[100 | 4
Fig. 6-1 Variable Manager Window

6.1.1.1 Selecting Scope

Selects object variables from the variable scope list.

Global variables and local variables can be selected.

Note: Local variables can be selected only when WINCAPSII is online with the
robot controller.

6.1.1.2 Typel (Integer Type) Variables
Clicking on the Type | tab displays a list of Type | (Integer type) variables.

6.1.1.3 TypeF (Single-precison Real Number Type) Variables

Clicking on the Type F tab displays a list of Type F (Single-precision real
number type) variables.

6.1.1.4 TypeD (Double-precision Real Number Type) Variables

Clicking on the Type D tab displays a list of Type D (Double-precision real
number type) variables.

6.1.1.5 TypeV (Vector Type) Variables
Clicking on the Type V tab displays a list of Type V (Vector type) variables.
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6.1.1.6 TypeP (Position Type) Variables
Clicking on the Type P tab displays a list of Type P (Position type) variables.

6.1.1.7 TypeJd (Joint Type) Variables
Clicking on the Type J tab displays a list of Type J (Joint type) variables.

6.1.1.8 TypeT (Homogeneous Conversion Type) Variables

Clicking on the Type T tab displays a list of Type T (Homogeneous conversion
type) variables.

6.1.1.9 TypeS (Character Sring Type) Variables

Clicking on the Type S tab displays a list of Type S (Character String type)
variables.

6.1.1.10 Local Variables

If WINCAPSII is online with the robot controller, you may monitor and modify
local variables in each program by switching the scope of variables.
Note: For details, refer to “SETTING-UP GUIDE".

[ D:\HM-40702D\HM-40702D var - Variable Manager

File Edit Actions Toolz Help
IE" El 7| | EERE

Type I |Tw:|e F | Type D | Type | Type P | Type ] | Type T | Type S | Type 10

Narne “Walue |Refer

1,1 2 I 4
6.1.2 Tool Bar
£| CONNECT button. For functions, refer to Chapter 6 “6.4.1 Connect” in this
manual.

SNAPSHOT button. For functions, refer to Chapter 6 “6.4.2 Snapshot” in
this manual.

MONITOR button. For functions, refer to Chapter 6 “6.4.3 Monitor” in this
manual.

7] TRANSMIT button. For functions, refer to Chapter 6 “6.2.5 Transfer File” in
this manual.

i' INPUT POSE button. For functions, refer to Chapter 6 “6.4.4 “Get Pose” in
this manual.

ﬁ| MOVE button. For reference, refer to Chapter 6 “6.4.5 Move” in this
manual.
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6.1.3 Basic Usage

When designing

Determine number Refer to Chapter 6 “6.1.3.1 Determining Number of
of variables Variables”.

Set application and
macrg’ﬂame ofeach | Refer to Chapter 6 “6.1.1 Outline of Functions”.

variable

Creating macro Refer to Chapter 6 “6.2.7 Create Macro Define
definition file File”.

i
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When monitoring

Connect to the
Robot Controller

l

Select type and
range of variables to

monitor

Start monitoring

l

Change values as
may be required

i

Refer to Chapter 6 “6.4.1 Connect”.

Refer to Chapter 6 “6.4.3 Monitor”.

Refer to Chapter 6 “6.4.3 Monitor”.

Refer to Chapter 6 “6.1.1 Outline of Functions”.



Chapter 6 Operating Variable Manager

6.1.3.1 Determining Number of Variables

You can change the number of variables in either of the following two methods:

B Setting with Pendant
Set the variable number with the pendant.
} STEP 1 For the data setting procedure, refer to Owner’'s Manual (Setting-up).

Click on the connect button 4f| in Variable Manager to establish a
} STEP 2 connection, then click on the TRANSMIT button 77| to display the
TRANSMIT dialogue on the screen.

@ Transfer Yariable Table

ArErS >

1 <5Single Precision Beal Mum
| | <Dauble Frecision Real Mur
|1 <vectar Type W)»

|1 <Position Type (F)> Cancel
1 <Jaint Twpe (11>
| <Homogeneous Transtorme select Al
|1 <Character String Type (31>

< BECEE

EELLN

Select the variable object type and run.
} STEP 3 The number of variables in the Robot Controller and that in Variable
Manager should match.
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B Setting with PAC Program Manager

You can set the number of variables by selecting [Tools], [Set], and [Variable]
in this order.
Refer to “6.5.1.2 Variables”.
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6.1.3.2 Editing Variables
[1] Editing Controller Variable Table

} STEP 1 Click on él button to establish a connection to the Robot Controller.
] button is displayed in the pressed state.

STEP 1 STEP 2

[ C:\Progrzm Files\wWINCAPS2AIRA-0000MPRA-D000 var - Variable Mana.._ [E[m]

iy ﬁl EI r_;l;&l |<Glabalvariable> j

Typel |TypeF| TjrpeDl Type‘v’l TypePI Type.]l T}rpeTl TypeSI
{No “Yalue V|Usage |Macr|:|

[ Y O N e e
[ R s N B I R

[T.1 100 | R =

taneously indicated from the Robot Controller.
The values of the Robot Controller variables are indicated in the grid.

Click on button and acquire the variable information, instan-
» STEP 2 | g

} STEP 3 Select the variable grid you wish to change and input the new values.
[ﬁ C:\Program Files\WINCAPS2\IRA-0000MRBA-0000_var - Yanable Mana... =] B3
“File Edit Actions Tools Help
IE Elﬁl ﬁl ’Ilw&l |<Glabalvariable> j

Type ! | Type F| Trpe I | Type V| Type | Type J| Type T| Type s |

{Ma “alue |Usage |Ma|:r|:|
0 \ 20
1 Z
2 3
3
4
5 i

1.1 [ T\ e e
STEP 3
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[2] Editing Personal Computer Variable Table

} STEP 1 Click on # button to disconnect from the Robot Controller.
The button is shown expanded. At this time, the values of the variable
table currently being edited, by the personal computer, is displayed in the

grid.
STEP 1
[ﬁ C:\rogram Files\YWwWINCAPS2AIRA-0000MRBA-0000_var - Yanable Mana... [l{=] B3
“Fils/ Edit  Actions Tools Help
ﬁfﬁlmlﬁl _'E_?I ’Ilw&l |<Glabalvariable> =]
Type ! | Type F| Trpe I | Type V| Type | Type J| Type T| Type 5 |
Mo “alue |Usage |Ma|:r|:|
0 4
1 5
2 ]
3 a
4 1]
5 0
1,1 [ 100 | e e
} STEP 2 Select the variable grids to change and input the new values.
[ii C:\Program FilesYWINCAPS 2\ RA-0000MRBA-0000_var - Variable Mana.. [lj[=]
File Edt Action: Tools Help
& m| 2| _'E_?I s |<Global varisble> 7|
Typel |TypeF| TjrpeDl Type‘v’l TypePI Type.]l T}rpeTl TypeSI
Mo “Yalue |Usage |Macr|:|
0 L3
1 ]
2 ]
3 1
4 1]
5 a
1,1 | e C e
STEP 2
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Chapter 6 Operating Variable Manager

[3] Transmitting Controller Variable Table

Change the values of the variable table on the personal computer, as

} STEP 1 I instructed to in Chapter 6, subsection 6.1.3.2 [2] “Editing the Personal
Computer Variable Table” on page 6-8 of this instruction manual.
Transmit the variable table from the personal computer to the Robot

} STEP 2 Controller according to the procedure described in 6.2.5 “Transfer
File” on page 6-14. The values of the robot controller variable table
change to the new values that have been transmitted from the
personal computer.
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[4] Backing Up Controller Variable Table

» STEP 1 I

» STEP 2 |

instruction manual.

this instruction manual.

Receive the Robot Controller variable table, following the instructions
in Chapter 6, subsection 6.2.5 “Transfer File” on page 6-14 of this
The values of personal computer variable table
change to the new values, received from the Robot Controller.

Save the personal computer variable table as a VAR file, following the
instructions in Chapter 6, subsection 6.2.3 “Save File” on page 6-13 of

-

- Variable Table Handling -

By using | button, select which grid

to edit. The personal computer or the

controller? When the value of a grid changes, the content of the object variable
table changes. Pressing the monitor button displays the contents of the variable

table on the opposite end. (No change is
Data transmission between the personal

enabled during monitoring.)
computer and the controller is affected

by respective variable tables. Variable data, received by the personal computer,

can be saved as a “*.VAR” file with “Save”.

“‘OPEN”.

Monitor button

Tyme

Existing data may be referenced with

Grid

1| Typa ¥ | Typa D | Type | Typa®| Tyma 1| “ypa T] Type ¢

No

Waue J Usage |Macrn

30

| . Acquires data in

5

succession
@|:

Acquires data for one

e |wfra=|o

6
0
0
0

time

_| - Selects connection ]

*.VAR file

” Transmission

Variable table

Variable table
J %/

Personal computer

Robot Controller

~
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Chapter 6 Operating Variable Manager

6.1.4 Files to Be Managed

Figure 6-2 shows the file types managed by the Variable Manager. The
following subsections explain each variable.

X

Variable
Manager

var_tab

Macro

Variable file definition file

Fig. 6-2 Files Managed by Variable Manager

6.1.4.1 Variable File (*.VAR)

The Variable file saves the variable information used for the program project.
Since a separate file is created for each project, respective variables can be
managed without any confusion, even if multiple program projects exist.

The file extension is “.VAR”.

6.1.4.2 Macro Definition File (var_tab.h)

This file contains variable macro names, by type and the variable numbers
corresponding definition.

The macro definition file is placed when the variable file, with extension
(*.VAR). The file name is “var_tab.h”.

To use a variable related macro from a PAC program, it is necessary to input
this macro definition file by using the #INCLUDE statement at the head of the
program.
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6.1.5 Menu List

The Variable Manager command menu has the following tree structure:

File
New (Programmer Level) *1
Open (Programmer Level) *1
Save
Save As (Programmer Level) *1
Transfer
Print
Make Macro Define File
Import Macro Define File
Close

Edit
Copy
Paste
Search on Grid

Actions
Connect
Snapshot
Monitor
Get Pose
Move

Tools
Options
RS232C Dummy Input
Calculator

Help
About Variable Manager

Fig. 6-3 Variable Manager Menu Tree

*1:  Displayed only when the file extension display option menu is checked.
To set the display option, log-in again, at the programmer level. Select
Tools, Options, and View and check the optional file extension menu.
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6.2 File Menu (Variable Manager)

Variable Manager uses the VAR file (variable file) to save variable information
(variable table). The Variable Manager file menu is used for managing this

VAR file.
Eile Edit Actions Tools Help

Hew

Open... Chrl+0
Save Ctrl+S
Save Az

rarsten.. (BTl
Prrint. . Chrl+F

take Macro Definition File
Impart bMacro Definition File

Cloze

Fig. 6-4 File Menu

6.2.1 New (Programmer Level)

Creates variable information (variable table).

6.2.2 Open (Programmer Level)
Opens the existing VAR file.
Since the standard Windows dialogue box appears, select a VAR file to open,
click on [OPEN] to open the desired file.
Opening file E2

Loak jn: | =3 Ira-0000 RN E

IRA-0000. var

File name:

Open I
Files of wpe: [ VAR file(* var] =] Cancel |
o

Fig. 6-5 Open Project Dialogue Box

6.2.3 Save

Saves the current state to the currently selected VAR file.
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6.2.4 Save As (Programmer Level)

Saves the variable information (variable table) to a new VAR file.
The standard Windows dialogue box appears. Select the path, input the file
name and click on SAVE to save data.

Save As
Save in: | 3 Ir=-0000

IRy 0000, var

File name:

Save I
Save a3 bupe: |um=; file war] = Cancel |
v

Fig. 6-6 Newly Saving File Dialogue Box

6.2.5 Transfer

When the communication with the Robot Controller is ON, the variable table
data may be transmitted or received.

The variable table refers to an array of variable data.

When the Transfer Variable Table dialogue appears on the screen, select the
respective variable types tables and click on either Transmit or Receive to
transmit data.

@ Transfer Yariable Table Ed

— Transfer Table

<Long Integer Type (1)> Transmit >
<3ingle Frecision Real Mum ¢ Beceive
<Double Precision Feal Mur

<vector Type (W)

<Position Type (F)> Cancel
<Jaint Type (0)>

<Homogeneous Transforme Select All

<Character String Type (5>

Fig. 6-7 Transfer Variable Table Dialogue Box
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Chapter 6 Operating Variable Manager

6.2.6 Print

6.2.6.1

Prints variable tables for respective variable types.

Print Object

When the Print Manager dialogue box appears on the screen, select the Print
Object tab, select the table and click on Print to print the data.

B Print Manager

Print Object | Option |

Frinter Canon LEP-430

~ Frint Ohject
ey —
1 - Single Precision Feal Number Type (F)
2 - Double Frecision Feal Mumber Type ()
3 -“Vectar Type (V)
4 - Position Type (F)
5 - Jaint Type ()
v B - Homogeneous Transformation Type (T) [:\\i
7 - Character String Type (3)

SelectAll |

Frint Cancel | ErEn e, | Set |

Fig. 6-8 Print Object Tab (Print Manager Dialog Box)

e Select All: Selects all objects for printing simultaneously.

o Set: Displays the printer setting dialogue and makes various
settings for the printer.

e Preview: Allows the user to see the print format before actual printing.

e Cancel: Closes the dialogue box without printing.

o Print: Prints variable tables.

¢ Option: Displays printing options.

TIP: To print specified pages only, click the printer button |& after
previewing. You may specify the print range in the printing
preview.

Note: If you select more than one object to be printed, Preview is not
usable.
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E D - Long integer type [1] H=] E3

Wariable Managor avael oez?

0 - kgl : Mooo il o - o _uh b

5

o

Yl e Taag= rlazm

iFoud
iCououh
| ouoArC

e e e R

=

1af3 3 I 7 I Eancell. I I I Elnsel 100 af 100 Totz

TN
LI
_I

@IEI_I_

Fig. 6-9 Preview Window

Moves to the head/tail end of the page.

Moves to the immediately preceding/following page.

Selects display (Reduction/Standard/Expansion)

Sets print execution

The printing range (specific pages) of an object file can be
specified.

Frinter: Swztern Printer [Canon LBP-730]
Pritt Hange Cancel |

™ Pages Copies: I 13:

Erom: I 1 To I 3 ¥ Collate Copiss

Fig. 6-10 Print Window

Exports the object file.
The selected object file will be converted into the file format
specified in Format and outputted (saved) to the Destination.

]|

Destination;

| Disk file =

(] I Cancel |
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6.2.6.2 Option
Selecting the Option tag will display the print options.

Note: Print option is not available from the Variable Manager.

6.2.7 Make Macro Define File

Create a “var_tab.h” file in the folder where the variable file (*.VAR) resides.

The “var_tab.h” file contains the variable macro name, listed by type and
information corresponding to variable numbers.

6.2.8 Import Macro Define File

Reads the macro definition file (var_tab.h) and expands in the "Use" and
"Macro Name" columns for each variable.

6.2.9 Close

Ends Variable Manager and closes the Variable Manager window.
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6.3 Edit Menu (Variable Manager)

[ Actionz Tool: Help

Copy Chrl+C
Pazte Crl+

Search on Gnd  Chrl+G

Fig. 6-13 Edit Menu

6.3.1 Copy

Temporarily stores the same data as that in the selected range. Data
temporarily stored by copying can be used with the Paste command.

6.3.2 Paste

Pastes temporarily stored data by cutout or copying to a specified location.
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6.3.3 Search on Grid

Searches for a specified character string from an application field or macro

name field.

When the Search on Grid dialogue box appears on the screen, specify the
necessary items and click on Find Next. The line containing the found
character string is displayed in reverse.

ia Search on Grid

Eind what ||

E
=] | Find Next |

Field Namall_lsage Field j Cancel |

Object
& Al

" Selected Bange

Search Im

™ tatch Case

Fig. 6-14 Grid Search Dialogue Box

e Find What:
¢ Field Name:

e Search:

¢ Object:

e Match Case:

Enter a character string to be searched.

Select an object field to search from the application
field or macro name field.

Specify the direction of search. If All is selected,
searching is carried out downward until the end,
then it is continued from the beginning of the data.
Select the range to search, either All or selected
range.

If checked, upper case and lower case are
searched separately.
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6.4 Actions Menu (Variable Manager)

The commands in this actions menu can be specified also with the buttons.

Actions Tools

v Connect
Snapshot

tonitar | ’:.I-:l l§|

et Foze
Move

Fig. 6-15 Actions Menu and Buttons

6.4.1 Connect

Establishes communication with the Robot Controller.

During connection with the Robot Controller, a checkmark appears in the
menu.

& button has the same function as the connect button. When connected, the
button is displayed in the pressed state.

6.4.2 Snapshot

Acquires variable data of the moment from the Robot Controller.
button has the same function as the snapshot command.
Set the communication conditions before executing the snapshot command.

6.4.3 Monitor

Acquires variable data in succession from the Robot Controller.

button has the same function as the monitor command.

Set the communication conditions before running the monitor command.

The personal computer acquires the data only of the variables displayed on the
screen from the Robot Controller during continuous monitoring, and does not
acquire the variable data not displayed on the screen. You can, therefore,
specify the data acquisition range by displaying the variables to be monitored.
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6.4.4 Get Pose

6.4.5 Move

With this command, the personal computer captures the current robot position
data from the Arm Manager to the currently selected variables of type P, J, or
T. (In the Variable Manager window, variable types and numbers are
displayed in reverse video.) If the Arm Manager is connected, you can obtain
the actual robot position.

Z| button has the same function as the Get Pos. command.

The values of the currently selected variable types P, J, and T are written to the
Arm Manager as the current robot position. (In the Variable Manager window,
variable types and numbers are displayed in reverse.) At this time, the robot
does not move to the specified position even if the Arm Manager is connected.
However, only the virtual arm of the Arm Manager moves to the specified

position.
%] button has the same function as the MOVE command.

Note: Arm Manager moves its imaginary arm in the continuous
monitoring state or when the Snapshot button is pressed.

6-21




6.5 Tools Menu (Variable Manager)

6.5.1 Options

Used to set the operating conditions of Variable Manager.
When you select Options from the Tools menu, the Options dialogue box
appears on the screen.

Note: Items that can be edited differ by user level. For restrictions, by
user level, refer to Chapter “1.3 Security” in this manual.
For how to change the access level in the middle, refer to Chapter
4 “4.3.3 Re-Log In” in this manual.

6.5.1.1 Monitor

#F Dptions
VI Varlab\el Dizplay |
—Option
Timer Inter/als: '_,J'_ g0 ms

Ok | Cancal |

Fig. 6-16 Monitor Tab (Options Dialog Box)

e Timer intervals: Sets intervals of getting data from the monitor.
Default is 500 milliseconds.
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__________________________________________________________________________________________________________|

6.5.1.2  Variables (Programmer Level)

$E Options

—Option

Mo, of type | 100 Mao. of type T : I 50
Mo of type F 100 Mo, of type S I B0

ALl

Mo. of type D
Mo, of bype '
Ma. of type P 100
Mo. of type J 100

Ik, Cancel

Fig. 6-17 Variable Tab (Options Dialog Box)

e Click the variable tab to sets the number of variables for each type.

If you modify the number of variables, take the following procedure to bring the
modified result into the internal data of the robot.

Recompile the source file into the executable file.
} STEP 1 Refer to Subsection 5.2.8, "Make Exec. Program."

Transmit the Program Table, Execution Program Table, and Cross-
} STEP 2 reference Table to the robot controller.

Refer to Subsection 5.2.6, "Transmit a Project."

Loads the project from the teach pendant.
} STEP 3 Refer to the OWNER'S MANUAL, "Setting-up," Section 6.6, "Loading a
project, [F6 Set]-[F1 Load!].
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6.5.1.3 Display (Programmer Level)

Click the display tab to set the display option for Show/Hide.
A display tab is indicated when the user level is higher than the programmer.

— Dptian
|| Filz Expansion Menu
Altarnatic refreshiAutarnatic shapshot]

Ik | Cancel

Fig. 6-18 Display Tab (Options Dialog Box)

e File Expansion Menu: Used to extend FILE (F) menu of the PAC Program
Manager. For details, refer to Subsection 6.1.5, "Menu
List” in this chapter.

o Automatic refresh (Automatic snapshot): If selected, this option automatically
monitors the current status as a snapshop when the
communication gets linked or when you change the
window size during connection or scroll the screen.
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__________________________________________________________________________________________________________|

6.5.2 RS232C Dummy Input

Note: To execute RS232C Dummy Input command, ensure the following
conditions are met:

e RoboTalk is set in RS232C.

e Each WINCAPSII manager is not connected. Since RS232C
Dummy Input command uses the RS232C port of the personal
computer. Therefore, if a Manager is connected to the Robot
Controller, an error will occur due to conflict.

The message entered in the dialogue box is transmitted to the Robot Controller
via RS232C.

Use this function when debugging the program.

If you execute RS232C Dummy Input command without connecting the robot,
the personal computer teaching system behaves as if it has transmitted the
data to the RS232C of Robot Controller.

You can choose a delimiter from between [CR+LF] and [CR] as an end code
attached to the output character string.

6.5.3 Calculator

Displays the standard Windows calculator. If the calculator is not installed, a
message reading “Could not find the file” appears on the screen.
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6.6 Help Menu

Descriptions on how to use WINCAPSII can be read by using the help menu.

Help

Lizenze Fey

About Syztem kM anager

Fig. 6-19 Help Menu

6.6.1 About Variable Manager

Displays the version information on Variable Manager.
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Operating DIO
Manager

This chapter describes the WINCAPSII software
DIO Manager functions that are used with the
personal computer teaching system.






Chapter 7 Operating DIO Manager

7.1 Outline of DIO Manager

7.1.1 OQOutline of Functions

The DIO Manager can monitor I/O status and/or manage the I/O layout table.
In addition, the program can be debugged prior to the completion of the facility
to test the program by adjusting Dummy SW ON or OFF to vary the I/O state
falsely.

When the MONITOR SW is turned ON or OFF and the DIO Manager
connected, the status of an I/O can be changed.

There are three methods for displaying 1/Os: table, oscilloscope and panel.
The DIO Manager window appears on the screen when DIO Manager is
started.

The DIO Manager can select a standard mode or conventional interchange
mode for I/O layout. For details, refer to 7.5.1.4 “Hardware”. For information
regarding the standard mode and conventional compatible mode for 1/O layout,
refer to chapter 5 “Robot Controller Interface” in Owner’'s Manual (Installation &
Maintenance).

® C:\Program Files\wWINCAPS 2\IRA-D000MRA-0000_dio - DIO Manager

Fle Edt Achons Tonl Help
£ o2 & 9 S +| 9
Mo.| State |Type |U5age |Mac:r0 ‘MDHitDlDﬂ
OfOFF | Systeminput | Step stop (alltasks) | SINT OFF |0
1|OFF | Systeminput | <Reserved> SN2 OFF Ok
2|OFF | Systeminput |Hal(all tasks) SiM3 OFF Ok
3|OFF | Systeminput | Strobe signal SIM4 OFF | Ok
4| OFF  System input  Interruption skip = I OFF Ok
5| OFF | Systeminput  Command data area o| SINE OFF |0k
B|OFF System input  Dataareal b0 (Ghi:  SIN7 OFF  DF
J|OFF Systeminput |Data aresal bit1 (Bhit:  SINS JFF  OF
8[|OFF | Systeminput |Dataareal bil 2 (Bhit:  SIMY JFF  OF
9[OFF | Systeminput Dataareal bit3(8hit: SIM10 OFF OF
10[{OFF  Swsterninput Data area 1 bitd (8hit: | SIM11 OFF k=
4] | ;

Fig. 7-1 DIO Manager Window

The following are the functions of the DIO Manager.
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7.1.2 Tool Bar

7-2

£| CONNECT button to make connection with the Robot Controller.

SNAPSHOT button to input the I/O status of the Robot Controller a single
time only.

MONITOR button to input the I/O status of the Robot Controller in
succession.

57| TRANSMIT button to either transmit or receive environmental table data.

21 DUMMY INPUT/OUTPUT button to select whether to use the dummy 1/O in
the Robot Controller. It selects the I/O number for which the DUMMY SW
grid is set to ON.

[ =] DISPLAY SELECT list for specifying the format of the 1/0 status
display.

1| RETURN button to select the preceding page when the number of I/Os to
monitor stretches over multiple pages.

i] NEXT button to select the following page when the number of 1/Os to
monitor stretches over multiple pages.
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7.1.3 Table Item

# C:\Program Files'\wINCAPS 2\ RA-0000% BA-DO0D. dio - DIO Manager

File Edt Actionz Tool Help

L322 7| 9

#¥|

Mo | State |T5.fpe |U5age |Ma:ru:u |MDnitD|Dﬁ
0|OFF  Swsteminput  Step stop (all tasks) SN OFF 0O
1|0FF Swsleminput | <FReserved> SIMZ OFF | Ok
2|0OFF | Swysteminput  Halt (all tasks) SING OFF Ok
J|OFF | Sysleminput | Strobe signal SIM4 OFF | Ok
4| OFF | Swstem input | Inferruption skip SING OFF Ok
5|OFF | Swsteminput | Command data area o SING OFF | Ok
B|COFF  Swstem input  Data area 1 bit 0 (Bhit: | SINT OFF 0OF
¢|OFF  Systeminput  Dataarea bit1 (Bhit: | SINE OFF OF
8|0FF  Swysteminput  Dataareal bit 2 (Bhit: | SINY OFF | OF
9/0FF  Swsteminput  Dataarea 1 kit 3 (Bhit: | SIN10 OFF OF

10| 2FF Swstern input  Data area 1 bit 4 (Bhit; | SIN11 OFF k>
4] | 3
Fig. 7-2 Table Items

e Number: I/0O layout number.

o State: Status of 1/0. In the MONITOR state, it indicates the status of
the Robot Controller I/O or the emulated 1/0 (memory) in the
personal computer. It is able to operate (ON-OFF) the Robot
Controller 1/0 or the emulated I/0O in the personal computer
except when in the continuous monitor state.
In the connected state the Robot Controller 1/0O is the object of
action while in the disconnected state the emulated 1/O in the
personal computer is the object of action.

e Type: I/0 layout type. Display only and not for editing.

¢ Application: I/O layout application. Can make entry as a comment. Double

e Macro name:

e Monitor SW:

e Dummy SW:

clicking enables entry.

I/O layout macro name. Corresponds to the I/O macro name
and the I/O number described in the macro definition file
dio_tab.h. Double clicking enables entry.

Specifies whether to monitor or not. Turns ON-OFF by double
clicking.

Specifies whether to use the actual I/0 of the Robot Controller
or the dummy SW (emulate memory). Turns ON-OFF by
double clicking. When turned ON the DUMMY SW (emulate
memory) is used. Unless the dummy /O 8 button is set to
ON, the Dummy SW setting is not enabled.
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7.1.4 Basic Usage

When designing

DIO layout mode
setting

l

Setting of respective . )
I/0 number application Refer to “7.1.1 Outline of Functions”.
and macro name

Creating Macro Refer to “7.2.7 Make Macro Define File”.
definition file

Refer to “7.5.1.4 Hardware”.

7-4



When monitoring

Connect to Robot
Controller

l

Select variable type
and range to monitor

l

Select display format

l

Start monitoring

l

Change values as may
be needed

Chapter 7 Operating DIO Manager

Refer to “7.4.1 Connect”.

Refer to “7.4.3 Monitor”.

Refer to “7.4.5 Display Format”.

Refer to “7.4.3 Monitor”.

Refer to 7.1.1 “Outline of Functions”.
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7.1.5 Files to Be Managed

7.1.5.1

7.1.5.2

7.1.5.3

7-6

Fig. 7-3 shows the types of files managed by the DIO Manager:

X
DIO
Manager
dio_tab dio_cnf
.h .h
DIO I/O Distribution Configuration Macro
File Macro Definition Definition File

File

Fig. 7-3 Files Managed by DIO Manager

DIO File (*.DIO)

The DIO file saves I/O information used for the project.

Since a separate file is created for each project, respective I/O information can
be managed without confusion even if multiple projects are involved.

The file name extension is “.DIO”.

I/0 Layout Macro Definition File (dio_tab.h)

This file contains definitions corresponding to I/O macro names and /O
numbers.

The I/O layout macro definition file is located where the DIO file (*.DIO) is
found.

The file name reads “dio_tab.h”.

To render the I/O macro applicable from the PAC program, it is necessary to
input this macro definition file at the head of the program using #INCLUDE
statement.

Configuration Macro Definition File (dio_cnf.h)

Contains the macro definitions for the content of hardware settings.

The Configuration macro definition file is located where the system project file
is found.

The file name reads “dio_cnf.h”.
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7.1.6 Menu List (DIO Manager)

The DIO Manager command menu has the following tree structure:

File
New (Programmer Level) *1
Open (Programmer Level) *1
Save
Save As (Programmer Level) *1
Transfer
Print
Make Macro Define File
Import Macro Define File
Close

Edit
Copy
Paste
Find on Grid
Selected Range All ON
Selected Range All OFF

Actions
Connect
Snapshot
Monitor
Pseudo input/output
Display Style

Tools
Options
DIO Command Viewer

Help
About DIO Manager

Fig. 7-4 DIO Manager Menu Tree

*1: Displayed only when the file extension menu of the display option is
checked. To set the display option, (re) login on the Programmer level
and then select Tools, Options and View, and check the option file
extension menu.
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7.2 File Menu (DIO Manager)

The DIO Manager has the DIO files for saving I/O data. The File menu of DIO
Manager is used for managing the DIO files.

File Edit Actions Tool Help

Mew

Open... Ctrl+0
Save Chrl+5
Save bz,

Airamsten.. [EEr{#1]
Frint_. Chrl+P

Make Macro Definition File
Import Macro Definition File

Cloze

Fig. 7-5 File Menu

7.2.1 New (Programmer Level)

Creates new |/O information.

7.2.2 Open (Programmer Level)

Opens an existing DIO file.
When the standard Windows dialog box appears on the screen, select the DIO
file to open, and click on OPEN to open the file.

Opening file

Loak ir; |G [r=-0000 j @l il E

IR4-0000. dio

File name:

Open I
Files of twpe: [ DI file(* dio) =] Cancel |
=

Fig. 7-6 Open Project Dialog Box

7.2.3 Save

Saves the current status in the presently selected DIO file.
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7.2.4 Save As (Programmer Level)

Saves /O information to a new DIO file.
When standard Windows dialog box appears on the screen, select the path,
input file name, and click on SAVING to save the data.

Save Asg BE

Save_in:la Ir2-0000 j @l il I:_ =

|Ras-0000. din

File narne: &-0000 Save I
Save az type: |DIEI file[* dio] j Cancel |
A

Fig. 7-7 New File Save Dialog Box

7.2.5 Transfer

When the Robot Controller is connected for communication, it is capable of
transmitting or receiving the environmental table data.

The environmental table refers to an array of data the robot needs to operate.
When the Transfer Environment Table dialog appears on the screen, select the
table and click on either Transfer or Receive to transmit data.

@ Transfer Environment Table E

— I'ransfer Tahle
<Harchware Setings>

¢ Beceive

Cancel

Select All

M
i

Fig. 7-8 Transfer Environment Table Dialog Box

Hardware setting: Setting various parameters needed for DIO operation.

If this content is changed, press either Transfer or Receive so as to share the
same data between WINCAPSII and the controller. After data transmission
from WINCAPSII to the controller, restart the controller.
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7.2.6 Print

Prints the DIO Manager environment table and 1/O layout table.

7.2.6.1 Print Object

When the Print Manager dialog box appears on the screen, select the Print
Object tab, the table, and then click on Print to print the data.

B Print Manager

Print Object |  Option |

Frinter Canon LEBF-430
~ Print Object
e 'y
[ 1 <Harchware Settings>

Select All |

Frimt | Cancel | Frewvisw | oet I

Fig. 7-9 Print Object Tab Print Manager Dialog Box

e Select All: Selects all objects for printing.

e Set: Displays the printer set dialogue and makes various printer
settings.

¢ Preview: Enables the user to see the print before starting the print job.

e Cancel: Closes the dialog box without printing.

e Print; Starts printing.

¢ Option tab The printing option setting sheet appears.

TIP: If you wish to print only the specified page, see preview and click
on the print button |& .

Note: If you select more than one object to be printed, Preview is not
usable.
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@ <Hardware Settings> [_ O] x|
ﬂ
0K Manager el an?
~<badware Smuagr : Moo file oo - “din_erh’
Frz=rir Talax irlacm Acomalerd
Allocwon mods 0,2 Compoubls 1,5 Sumdad) 1|2 AR 1
Fouy b @ ardid, | did) I | ¥ FARTTY 1
Hoad ¥ wmumuy pugn smug ¢ [Mardid, | ¥od) | |y o _gvaacD |
Dioricia o ol mpusalon 2 |¥o Dw_w_sLeT ]
Devicciva, Mo af ougue aloa 7 [ o _our_ster 1
Deyioifa prgpoouon mioi [idhrdid, | :Vaid] 1| ¥ O EERECHE 1

Fig. 7-10 Preview Window

Moves to the head/tail end of the page.

Moves to the immediately preceding/following page.
Selects display (Reduction/Standard/Expansion)
Sets print execution

The printing range (specific pages) of an object file can be
specified.

EE 1of1 | 2 I HI Cancell %Iﬂlﬂ,ﬁll Elnsel Eof9 Toks
LIRS
J

@LLL

Print |
Frinter: Swstern Printer (Canon LER-730)
Print B ange Cancel |

" Pages Copies: I 13:

¥ Collate Copies

Fig. 7-11 Print Window

B3| &l .  Exports the object file.
The selected object file will be converted into the file format
specified in Format and outputted (saved) to the Destination.

Export E3

Farmat: D estinatian:

| Disk file =l

Character-separated values

QK I Cancel |

Fig. 7-12 Export Window
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7.2.6.2 Option
Selecting the Option tag will display the print options.

Note: Print option is not available from the Variable Manager.

7.2.77 Make Macro Define File

Create a "dio_tab.h" file in the folder where the DIO file (*.DIO) resides.
The "dio_tab.h" file contains the I1/O numbers and macro name information.

7.2.8 Import Macro Define File

Reads the macro definition file (dio_tab.h) and expands in the "Use" and
"Macro Name" columns on the screen.

7.2.9 Close

Ends DIO Manager and closes the DIO Manager window.
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7.3

7.3.1

7.3.2

Edit Menu (DIO Manager)

Copy

Paste

= Action: Teool Help

Copy Chrl+C
Past Chrl+f
Find on Grid Chrl+5

Selected Range All O
Selected Range All OFE

Fig. 7-14 Edit Menu

Temporarily stores a specified range of data. Data temporarily stored by
copying can be used by the Paste command.

Pastes the temporarily stored data by cutting or copying to a specified location.
This operation is enabled in the “Application” and “Macro name” fields only.
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7.3.3 Search on Grid

7-14

Searches for a specified character string from either the application or macro
name field.

When the SEARCH ON GRID dialog box appears on the screen, specify the
necessary items and click on FIND NEXT. The line containing a found
character string is displayed in reverse video.

i Search on Grid

E

Eind “hat: I j Find Mext I

Field NamelUsage Field j Cancel |
COhject Search Im

= All
¢ Zelected Bange [ tatch Case

Fig. 7-15 Search on Grid Dialog Box

¢ Find What: Enter a desired character string to be
searched.

¢ Field Name: Choose the searching object field from
between Usage Field and Macro Field.

e Search: Specify the searching direction. If Whole
is selected, the search is made downward
to the end, and then the search restarts
from the beginning of the data downward.

¢ Object: Choose the searching range from
between all and just a selected range.

e Match Case: If this box is checked, search is made
with distinction between upper and lower
cases.
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7.3.4 Selected Range All ON

Multiple monitor and dummy switches may be selected and turned ON

simultaneously.

As Fig. 7-12 shows, first select the I/O number of the desired item (monitor or
dummy switch), then select Selected Range All ON. The menu content can be
more easily displayed by clicking the right button of the mouse to select the
command as shown below.

|Mnnit|:|r = |Dummy =iy

Qi
OFF _ ON

p Copy Ctrl+C
Past Chrl+f

bl

OFF
OFF Search on Grid Crrl+5
OFF Selected Bange Al OM

OFF Selected Bange Al OFE

OFF OFF e

Fig. 7-16 Selected Range All ON

7.3.5 Selected Range All OFF

Multiple monitor switches and dummy switches may be selected and turned
OFF simultaneously.
As Fig. 7-13 shows, first select the 1/O number of a desired item (monitor
switch or dummy switch). Then select Selected Range All OFF. The menu
content can be more easily displayed by clocking the right button of the mouse
to select the command as shown below.

OM

m Copy Ctrl+C
0N Past Chrl+
O Search on Gnd Ctrl+G
OM Selected Range All 0N
OM Selected Range & OFF
OFF

Fig. 7-17 Selected Range All OFF
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7.4 Actions Menu (DIO Manager)

The Actions menu commands are also issued by depression of the tool

buttons.

ey Tool Help

LConnect
Shapzhat
Monitor

Fzeudo input/outpt

v Tabls
Dzcillogcope

Panel

oo @l 7 = e«

Fig. 7-18 Action Menu and Buttons

7.4.1 Connect

Connects the communication line with the Robot Controller.
When connected, check mark is attached to the menu.

£ button works the same as the Connect command. When connected it is

displayed as if depressed.

7.4.2 Snapshot

Acquires the data of the moment from the Robot Controller.

button has the same function as the Snapshot command.

Before executing the Snapshot command, ensure that the Manager is
connected with the Robot Controller.
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7.4.3 Monitor

Acquires data in succession from the Robot Controller.

button has the same function as the Monitor command.

Before executing the Monitor command, ensure that the Manager is connected
with the Robot Controller.

During monitoring, the DIO Manager acquires the data only of I/O numbers
displayed on the screen from the Robot Controller, and does not acquire the
I/O number data not displayed on the screen. You can, therefore, specify the
data acquisition range by displaying the 1/O numbers to be monitored.

Monitor intervals can be set with the timer intervals. Refer to “7.5.1.1 Monitor”.

7.4.4 Pseudo input/output

To emulate (dummy input/output) the state in the Robot Controller, false 1/Os
are provided in the Robot Controller in addition to the actual I/Os. Selection of
the actual versus false I/Os can be specified for each port by turning the
Dummy SW grid of the table display ON-OFF.

When the Dummy input/output button 8! is turned ON, every port with the
Dummy SW grid set to ON will function as a dummy I/O.

If the button @Y is turned OFF, all the 1/O signals are activated as the actual I/O

signals irrespective of the setting of the Dummy SW grid in the table.
Valid setting range of dummy I/Os is as follows:
Standard mode
34-55, 552-575+(DeviceNet input slot number-8)x8
Interchange mode
21-55, 536-559+(DeviceNet input slot number-8)x8

Note: DeviceNet input slot number may be referred to with the hardware.
If DeviceNet is not installed, the range will be only 34-55 (Standard
mode) or 21-55 (Interchange mode).

7.4.5 Display Format
m Tool Help

LConnect
Shapzhot
b anitar

Pzeuda inputdoutput

Dizplay Style 3 v Table
Ozcillozcope
Fanel

Fig. 7-19 Display Format Menu

The DIO Manager has three methods for displaying 1/O statuses.
Select Display Style from Actions menu, and the three display styles appear
on the right: Table, Oscilloscope, and Panel. Select a required one.

You can also select the display style by clicking on Display selection list
[ =l and displaying the pull-down menu.
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7.4.5.1 Table

When you select the table type display, the I/O states are displayed in the table
type as shown in the list.

® C:\Program Files\\WINCAPS 2\IRA-00DDMRBA-0000_dio - DID Manager
File Edit Action: Tool Help
D8] =] Y [o-Table ] ] ¥]

MNo.| State |Type |Usage |Macm ‘MDmiDr‘Dumﬂ
OIOFF i Swstem input | Step stop (all tasks) SN OFF  ON
1|OFF  Systemninput | <Fesered> SiME OFF 0N
Z2|OFF  Systermninput | Halt(all tasks) SIM3 OFF 0N
3|OFF  Systermninput | Strobe signal SiM4 OFF 0N
4(OFF  Swstemninput | Interruption skip SiMG OFF 0N
5[OFF  Swsteminput | Command data area o SIMG OFF 0N
Bl|OFF  Systemninput  Dataareal bit 0 (Bhit: SINT OJFF  OFF
?|OFF  Systemninput  Dataareal bit1 (Bhit: SIME OJFF  OFF
8[|0OFF  Systeminput  Dataareal bit 2 (Bhit: SIMY OJFF  OFF
9(OFF  Systeminput  Dataareal bit 3 (Bhit: SINT0 OJFF  OFF

10{OFF  Swsteminput  Data areal kit 4 (8hit: | SN OFF  OM o
T o

Fig. 7-20 Table Display (DIO Manager) Window

In the table type display, I/Os are displayed in different colors depending on the
classification group. Tables 7-1 and 7-2 outline the colors and classifications in
the standard mode and compatible mode for the conventional type.
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Table 7-1 1/0 Colors and Classifications (Standard Mode)

Classification | Color | Delimit | Layout Name Macro Remarks
Standard input | White 0 0 [ System SINxx (Robot stop and Enable Auto
(64 points) input are excluded.)
33 (34 points)
34 | Userinput| UINxx
47 45 (12 points) | (No. 46 and 47 are missing.)
48 48 | Hand HINxx
input
55 55 (8 points) No. 55 for interruptive
detection of disconnection
56 56 | (Missing Missing
number) number
63 63
Standard output | Pink 64 64 | Hand HOUTxx
) output -
(64 points) 7 7 (8 points)
72 72 | System SOUTxx
tput
103 | O (32 points)
104 | User UOUTxx
output
127 127 (24 points)
Internal 1/0O Yellow 128 128 | Internal ITIOxx
I/0
(384 points) 511 511 (384 points)
DeviceNet input | Green 512 512 | System DSINxx SINxx (517 and 518 are
(256 points) input missing.)
551 547 (34 points) | (548 to 551 are missing.)
552 552 | User DUINxx Extensible in unit of 8 points
input
767 767 (216 points) | Default: 24 points
DeviceNet Blue 768 769 | System DSOUTxx SOUTxx
output output
(256 points) 799 1246 (31 points) | (No. 768 CPU is normally
missing.)
800 800 | User DUOUTxx Extensible in unit of 8 ports
output
1023 1023 (224 points) | Default: 24 points

7-19



Table 7-2 1/0 Colors and Classifications (Previous Model — compatible Mode)

Classification | Color | Delimit | Layout Name Macro Remarks
Standard input | White 0 0 | System SINxx (Robot stop and Enable Auto
(64 points) input are excluded.)
33 (21 points)
34 | Userinput [ UNIxx
47 45 (25 points) | (No. 46 and 47 are missing.)
48 48 | Hand HINxx
input
55 55 (8 points) No. 55 for interruptive
detection of disconnection
56 56 | (Missing Missing
number) number
63 63
Standard output | Pink 64 64 | Hand HOUTxx
output
(64 points) 7 7 (8 points)
72 72 | System SOUTxx
tput
103 | °U*P! (32 points)
104 | User UOUTxx
output
127 127 (24 points)
Internal /10 Yellow 128 128 | Internal ITIOxx
I/0
(384 points) 511 511 (384 points)
DeviceNet input | Green 512 512 | System DSINxx SINxx (517 and 519 are
. input missing.)
(256 points)
535 534 (21 points) | (535 is missing.)
536 536 | User DUINxx Extensible in unit of 8 points
input
767 767 (232 points) | Default: 24 points
DeviceNet Blue 768 769 | System DSOUTxx SOUTxx
output output
(256 points) 799 1246 (31 points) | (No. 768 CPU is normally
missing.)
800 800 | User DUOUTxx Extensible in unit of 8 ports
output
1023 1023 (224 points) | Default: 24 points
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7.4.5.2  Oscilloscope

Upon selecting the oscilloscope display type, the I/O statuses are displayed in
graphical form as on an oscilloscope.

When displayed in the table type, turn the Monitor SW grid of the desired 1/0
display to ON.

The maximum number of I/Os that can be displayed simultaneously is 8.
Clicking the Return button #] or Next button #] scrolls the list by one page.

& C:\Program Files\wincaps2\IRA-0000% RA-0000.dio - DID Manager

Eil= Edit Actions Tool Help

IE EI EI 1 - Dscillosce

Fig. 7-21 Oscilloscope Display (DIO Manager)
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7.4.5.3

7-22

Panel

Upon selecting the panel display type, the I/O states are displayed in panel.
When displayed in the table type, turn the Monitor SW grid of the desired 1/0
display to ON.

The maximum number of I/Os that can be displayed simultaneously is 32.
Clicking on the Return button ﬂ or Next button i] scrolls the list by one page.

€ C:\Program Files\wincaps2\IRA-DDO0AIRA-0000 dio - __ =] B3

File Edit Action: JTool Help

e = | e

RN [ Uirg [ HIM3 [ HouT:
[] uinez [] Uirto [] Hing [] HouT4
[ iz [ Uiri11 [] HirE [l HouTs
[ w4 [] w2 [] Hirg [] HoUTE
[] LM [] o048 [] Hin7 [] HouT?
[] UG [] 0047 [] Hirg [] HouTs
[ uinz [] Hir [] HouT  [] SOoUTH
[ Uina [ Hinz [ HouTz [ soUTZ
[ J [0

Fig. 7-22 Panel Display (DIO Manager) Window
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7.5 Tools Menu (DIO Manager)

7.5.1 Options

Makes various types of settings needed for the DIO Manager.

Upon selecting Options from the Tools menu, the Options dialog box appears
on the screen. Clicking the tab enables each item to be set.

Checking Create Header File creates the configuration macro definition file
(dio_cnf.h). The dio_cnf.h file contains the macro definition information for
hardware settings.

Note: The items that can be edited differ depending on the user level.
For restrictions by user level refer to 1.3 “Security”. For
information on how to change the access level, refer to 4.3.3 “Re-
Log In”.

7.5.1.1 Monitor

-ﬁi Ophons

0] Cancel

Fig. 7-23 Monitor Tab (Options) Dialog Box

e Timer intervals: Sets the intervals for acquiring data through continuous
monitoring. Default is 500 msec.
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7.5.1.2  Oscilloscope

$E Options E1
Montor Dsmllnscupe' Fanell Hardwarel M—DNetl Displayl
~Drawing Color
Background Color: IEiIEu:k j
Scale Color: IDark gray j
teasured Yalue Color: IWhite j
DE. Cancel

Fig. 7-24 Oscilloscope Tab (Options) Dialog Box

e Background: Specify the background color of the oscilloscope.
e Scale color: Specify the scale color of the oscilloscope.
e Measured: Specify the color of measured values in the
oscilloscope.
7.5.1.3 Panel
ﬂ- Options | x|
Ml:lniturl Cscilloscope F'anell Hardware | I-.-I—DNetl Displayl
~ Drawing Color
Color at ON: ILightgreen j
Color at OFF: IDark gray j
CF. Cancel

Fig. 7-25 Panel Tab (Options) dialog Box

e Color at ON: Specify the color at ON in the panel display.
¢ Color at OFF: Specify the color at OFF in the panel display.
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7.5.1.4 Hardware

Click the Hardware tab to set various parameters needed for DIO operation.
For the meanings and element numbers of parameters, refer to “Appendix” in
PROGRAMMER’S MANUAL.

The left side of the 1/O layout frame displays I/O device, the right side displays
I/0 layout.

1/0 device I/0 layout

-ﬁI- Ophions h; x|

i e —————
PROFIBUS-DP Slave {Compatible |
RS

Fig. 7-26 Hardware Tab (Options) Dialog Box

7.5.1.5 M-DNet

Click the M-DNet tab to set the parameters needed for establishing the Device
Net master mode. For the meanings and element numbers of parameters, refer
to the instruction manual for Device Net master.

.............................

Froperty SetWalue
seral Mumber 171100

Expected Packet_FRate 0
Inter_Scan_Delay

s

0
1
a

£

] 4 Cancel

Fig. 7-27 M-DNet Tab in Option Dialog Box
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7.5.1.6 Display

Click the Display tab to set SHOW/HIDE option for display.
This display tab appears when the user level is higher than the programmer.

—Optian
| | File Expansion Menu
Autarnatic refreshlAutomatic shapshot]

0] | Cancel

Fig. 7-23 Set/Display Menu

Fig. 7-27 Display Tab (Options) Dialog Box

o File extension menu: Extends the Files menu of the DIO Manager. For
details, refer to 7.1.6 “Menu List”.

¢ Auto Update (automatic acquisition of snapshot):
If you change the window size or scroll the screen
when the DIO Manager is connected or in the process
of connection to the Robot Controller, the Manager
automatically monitors the snapshot.
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7.5.2 DIO Command Viewer

The DIO command viewer shows the bit pattern of DIO command.
For information on the DIO commands, refer to chapter 5 “Robot Controller
Interface” of the Instruction Manual (Installation and Maintenance).

DI0 Command Yiewer for Standard Allocation

—Command Area: I0[30 TO 33])iDnet(544 TO 5477

1 - Program Qperation hd
TIE47] 30[544) I d P J

~Data Arzal: I0[6 TO 13](Dnet[520 TO 527])

I I I I I I I D 2|:|]|1 - Program Reset Star j

13[527] B[S

- Data AreaZ: I0[14 TO 28)(Dnet[528 TO 543])

OODOCOOOCOCODODOEA o

29[543] 14[528]

[ 10[5)(Dnet518]) - Ocd Parity

Fig. 7-28 DIO Command Viewer
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7.6 Help Menu

The Help menu provides explanations on how to use WINCAPSII.

Help

Lizenze Fey

About Syztem kM anager

Fig. 7-29 Help Men

7.6.1 About DIO Manager

Displays the version information on DIO Manager.
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Operating Arm

M anager

This chapter describes the WINCAPSII software
Arm Manager functions that are used with the
personal computer teaching system.






Chapter 8 Operating Arm Manager

8.1 Outline of Arm Manager

8.1.1 Outlineof Functions

The Arm Manager is a tool provided for monitoring the current robot arm position,
effective tool number, and effective work number.

Since robot actions can be simulated without actually operating the robot, robot
programs can be developed efficiently and safely from the initial stage of
development.

Main tool bar Operation bar (1)

¥ C:AWINCAPSINBINAYS-6577E \IRA-DD00MRA-0000.arm - Arm Ma... =] B3

File Edit Action “iew Tool Help

EEEE R R EIETE
[ x| v| Z| PRX| FEY| PRZ| FG||#
[<lros 61728 10884 57015 18000 1400 -170.00 ; %'
#

|

I

= olole

.:_I _'_l
Y-axis rotation 1
\\ -
/ Bl 8 T
Operation bar (2) /
a: X-axis rotation b: Zoom bar
Operation bar (4) Robot display Operation bar (3)

Fig. 8-1 Arm Manager Window
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8.1.2 Tool Bar (Arm Manager)

8-2

Main Tool Bar

e EE Qe E R

CONNECT button. Refer to “8.4.1 Connect”.

SNAPSHOT button. Refer to “8.4.2 Snapshot”.

MONITOR button. Refer to “8.4.3 Monitor”.

TRANSMIT button. Refer to “8.2.5 Transfer Project”.

WORK COORDINATE SYSTEM SET button. Refer to “8.6.1.6 Work”.
TOOL COORDINATE SYSTEM SET button. Refer to “8.6.1.5 Tool".
AREA COORDINATE SYSTEM SET button. Referto “8.6.1.7 Area”.
REMOTE OPERATION button. Refer to “8.6.2 “Remote Operation”.
OBJECT TREE button. Refer to “8.6.4 Object Trees”.

Operating Bar (1)

Type-P T TYPE button: Displays the current position of the robot in T type.
HE:‘# P TYPE button: Displays the current position of the robot in P type.
Type-J+Ex J TYPE button: Displays the current position of the robot in J type.
Copy COPY button: Copies the current position of the robot to the clipboard.
%! vl z| mx| Ryl Rrz| FG
Pos 61726 10884 57015 18000 14.00 -170.00 5

CURRENT POSITION DISPLAY box: Displays the current position of
the robot.
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Operating Bar (2)
ﬁl WIRE FRAME button. Changes the robot arm drawing to a wire frame.
@l FLAT SHADING button. Changes the robot arm drawing to flat shading.
IE] SMOOTH SHADING button. Changes the robot arm drawing to smooth
shading.
& PROJECT button. Specifies whether to display the robot in perspective.
21 VIEWPOINT SHIFT Y-AXIS ROTATION bar. Rotates the robot display
around the Y-axis.
—
=
Operating Bar (3)

About SystemMarager | | OCK Z button which sets the viewpoint in the

=]

direction of Z-axis.
LOCK X button which sets the viewpoint in the direction of X-axis.
LOCK'Y button which sets the viewpoint in the direction of Y-axis.

VIEWPOINT SHIFT VERTICAL bar. Scrolls the robot display vertically.

Operating Bar (4)
a] | » VIEWPOINT SHIFT X-AXIS ROTATION bar. Rotates the robot display

around the X-axis.

b:«] | 1| ZOOM bar.Zooms the robot display in or out.

8-3



8.1.3 Basic Application

This subsection describes the flow of off-line point teaching.

Note: Since the current Arm Manager has no such accuracy in
calibration to provide teaching with precision, rough point
teaching is conducted to check program operation.

During designing

Monitor started without Refer to “8.4.3 Monitor”.
connection

—p| Robot operation with Refer to “8.6.2 Remote Operation”.
simulation images

l

| Refer to “6.4.4 Get Pose”.
nput the current

pose to variable Note:
Operation with Variable Manager

All points
completed

. Refer to “6.2.5 Transfer File”.
Variable data Note:

transmit

Operation with Variable Manager
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During Monitoring

Connected to Robot Refer to “8.4.1 Connect”.
Controller

l

Select item desired Refer to “8.6.1.1 Monitor”.

for monitoring

l

Start monitor Refer to “8.4.3 Monitor”.
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8.1.4 Filesto Manage

Fig. 8-2 shows the files that the Arm Manager manages. The following are the
description of each file.

X

Arm Manager

arm_cnf
* ARM .

Arm configuration
definition file

>

Arm file

Fig. 8-2 Files Managed by Arm Manager

8.14.1 ArmFiles(*.ARM)

The Robot Controller servo information used for a project and other information
used for setting and reading using the SET command in the Arm Manager TOOL
menu are saved in an Arm file.

Since a separate file is created for every project, robot characteristics that differ
from one project to another can be managed without confusion even when
multiple projects are being managed.

The extension for the file reads “ARM”.

8.1.4.2 Arm Configuration Macro Definition File (arm_cnf.h)

Stores the macro definition information of arm set data.

The Configuration macro definition file is located where arm files (*.ARM) are
found.

The file name is “arm_cnf.h".

To use a macro concerning arm configuration from the PAC program, it is
necessary to input this macro definition file at the head of the program using an
#INCLUDE statement.
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8.1.5 Menu List (Arm Manager)

The Arm Manager command menu has the following tree structure:

File
New (Programmer level) *1
Open (Programmer level) *1
Save
Save As (Programmer level) *1
Transfer
Print
Close

Edit
Cut
Copy
Paste
Rename
Rebuild

Actions
Connect
Snapshot
Monitor

View
Arm
Tool
Work
Area
Obstacle

Tools
Options
Remote Operation
Object Trees
Pose Conversion

Help
About Arm Manager

Fig. 8-3 Menu Tree of Arm Manager

*1: Displayed only when the file extension menu of the display option is
checked. To set the display option first re-login on the programmer level.
Then select Tools, Options, and View and check the option file extension
menu.
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8.2 FileMenu (Arm Manager)

The Arm Manager has an ARM file to save information on trajectory generation.
The Arm Manager File menu is used for managing the ARM files.

File Edit Action Wiew

Hew

Open ... Chrl+0
Save Chil+5
Save Az .
inareter... Bl
Print ... Ctrl+F
Cloze

Fig. 8-4 File Menu

8.2.1 New (Programmer level)

Creates new robot arm information.

8.2.2 Open (Programmer level)

Opens an existing ARM file.
When the standard Windows dialog box appears on the screen, select an ARM
file to open, and click on OPEN to open the file.

Opening file HE
Look i |3 Ira-0000 ] ok [ =
R4,-0000. arm
File name: Open I

Files of type: I.-'l'-.rm filef=. armm] =] Cancel |

Fig. 8-5 Open Project Dialog Box

v

823 Save

Saves the current status in the currently selected ARM file.
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8.2.4 SaveAs (Programmer level)

Saves the current robot arm information to a new ARM file.
When the standard Windows dialog box appears on the screen, select the path
and input the file name. Click on Save to save the data.

Hize ik saving 2=
Swvare | ' el =l & @A el = mj
ﬂlF-‘-\.I'l'..'l'l.-ln

Fix pana ||:-'.4, T3 Lave |
EES AT |I:|.|1|| o] iy :l Cariasl |

Fig. 8-6 New Saving of File Dialog Box

8.2.5 Transfer

When communication with the Robot Controller is ON, this enables it to transmit
or receive the environmental table data.

The environmental table refers to the arrangement of data necessary for the
robot to operate.

When the Transfer Environment Table dialog box appears on the screen, select
the table, and click on either Transmit or Receive to transmit data.

& Transfer Environment Table |

— Transfer Tahle :
vl <Canfig> Transmit >
<Trajectory>
<Servoz
<Tool»
Ciiarky Cancel
<Arear

< Beceive

Fig. 8-7 Transfer Environment Table Dialog Box

The items in the transfer table are the contents set in 8.6 “Tools Menu”.

Note 1: After sending the configuration setting, trajectory, and servo
data, you need to restart the Robot Controller.

Note 2: For the tool and work data, the Controller receives the values
which has been changed with the TOOL and WORK commands.
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8.2.6 Print

Prints the Arm Manager environmental table.

8.2.6.1 Print Object

The Print Manager dialog box appears on the screen. Select the Print Object tab
and select the object to be printed. Click on Print to print data.

B Print Manager |

Print DhjEmT Dption ]

Printer Canon LBP-430
b .
} .......................................................................................... Selel::t A” |
[ 1 <Trajectorys
1 <Serno>»

[ 1<Tool>
1 <wv'orks
[ ] <Arear

Frirt Cancel Fresiew Set

Fig. 8-8 Print Object Tab (Print Manager Dialog Box)

 Select All: Selects all of the environmental tables as the object for
simultaneous printing.

* Set: Displays the printer SET dialog box and makes various printer
settings.

* Preview: Enables viewing of the print status prior to actual printing.

« Cancel: Closes the dialog box without printing.

* Print: Prints the table.

¢ Option: Print options appear.

TIP: To print only specified page(s), click on the printer button |& after
previewing.

NOTE: If you select more than one object to be printed, Preview is not
usable.
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&l <Config> H=] E3
i’
Amn Manager a0z}
“Apphouoe modag™ : Maaa filk oo - *apd_aai'b’
pruP:rl; Valae mar Armmalerd
Coouel 3m el mounn opumzune 1] CN'D_ASP‘&CC 1
Flooi-mouoL o Crabod-mouo 1] D _SFACE 1
[ —"— 2,000 | CHD LoD 1
[ p——— - o | CHD Loeesa [
[T e pp——" - 20 | cHD_LDeegr 1
[ p——— - lo0 | £ _LOFeEeT 1
Enemda pulazemuat i paawssiog dlowme: 1) W | CHD_PLEWDTHI 1
Enmad= puli= coums far pasweciog diowmes 1) w0 | CHT PLEWDTIR: i
Eamada pulic coums for pasweoiog diowmes [15) w0 | CHT PLEWDTHS ]
Enemda pulazmuat i paawcsiog olowme: [4) 20 | CHD PLEWDTH 1
Enemds pulic couat far paswosing diowmes (3] W | EWD_PLETOTS i
Enemda pulazemuat i paawssiog o owme: 6] 4 | €HD_PLSWDTHG 1
Enemda puliz couat for paswosing diowmes 17 0 | EHDy_PLEWDT 1
Eamada puliz cums far pasweciog diowmes B2) W0 | EWD PLEWDTHE i
o;.umu [T ——— 5,000 | CHD_preTRoUT 1
uel o g made CN'D LerhAoOE 1 LI
1oz 0] M] Eancell. | J6] [Close]  sg0iEE  Tote

]
ol
J

@LLL

5

Fig. 8-9 Preview Window

Moves to the head/tail end of the page.
Moves to the immediately preceding/following page.
Selects display (Reduction/Standard/Expansion)

Sets print execution
The printing range (specific pages) of an object file can be specified.

Print |
Frinter: Spstem Printer [Canon LBP-730)
Print Range Cancel |
& 4l 3 pages
" Pages Copies: IG
Erom; I 1 Ie I 3 ¥ Caollate Copies

Fig. 8-10 Print Window

Exports the object file.
The selected object file will be converted into the file format
specified in Format and outputted (saved) to the Destination.

Export |
D estination:
| Disk file =l
| F, I Cancel |

Fig. 8-11 Export Window
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8.2.6.2 Option

Selecting the Option tag will display the print options.

Note: Print option is not available from the Arm Manager.

8.2.7 Close

Ends Arm Manager and closes the Arm Manager window.
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8.3

8.3.1

8.3.2

8.3.3

8.3.4

8.3.5

Edit Menu (Arm Manager)

This menu is for editing the object tree.

Edit  Action  “iew Tool

Cuk Chrl+
Copy Chrl+C
Paste Clrl+f
R ename
Beconfigure

Fig. 8-13 Edit Menu

Cut

Cuts data out of the selected range. The cutout data can be used with the Paste
command.

Note: Only the selected data is cut out. Note that the data that exists on
the lower level than the selected data will be also deleted.

Copy

Temporarily stores the same data as in the selected range. Data temporarily
stored by copying can be used in the PASTE command.

Paste

Pastes temporarily stored data by cutout or copying to a specified location.

Rename

Open the object tree, specify an object and use RENAME to change the name of
the object.

Reconfigure

Re-draws the display of the object tree and displays only the root object.
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8.4 ActionsMenu (Arm Manager)

The Actions menu commands can be also issued by depression of the buttons

on the tool bar.
| Action NICTIE

v LConnect
Snapzhot
Fonitor

S8 &l El

Fig. 8-14 Actions Menu and Button

8.4.1 Connect

Connects communication between the Robot Controller.

When connected the menu is attached with a check mark.

The connect button | works the same as the Connect command. When
connected it is displayed as if depressed.

8.4.2 Snapshot

Acquires the data of the moment from the Robot Controller.

The snapshot button |ﬂ| has the same function as the Snapshot command.
Before executing the snapshot command, ensure that the Arm Manager is
connected with the Robot Controller.

8.4.3 Monitor

Acquires data in succession from the Robot Controller.

The monitor button | has the same function as the Monitor command.

Before executing the monitor command in succession, ensure that the Arm
Manager is connected with the Robot Controller.
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8.5 View Menu (Arm Manager)

Specifies the elements to be displayed in the robot display.

A

Tanl
Wfiork
Area
Dbztacle

¥ C:\Program Files\wzicaps 20 AA-D000AAA-DODDD. anm - Ao Mansges =] E Arm

Fle Edé Acion Wiew [od Hel

[ ma| o %z «El

|—:1.|._,E.-J ..| 4 122 99971 109.9995, 9.99955E, 0, 59 99966, D) /|/

[ Work
[ |
= "
]
(&
=]
E=al Obstacle

/ \

Tool Area

Fig. 8-15 View Menu and Screen Display
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8.5.1

8.5.2

8.5.3

8.5.4

8.5.5

8-16

Arm
Specifies display of the robot arm. When Arm on the menu is check-marked, the
robot arm is displayed.

Tool
Specifies display of the tool coordinates. When Tool on the menu is
check-marked, the tool is displayed.

Work
Specifies display of the work coordinates. When Work on the menu is
check-marked, the work coordinates are displayed.

Area
Specifies display of the area. When AREA on the menu is check-marked, the
area is displayed.
Define the area with Object Tree in the Tools menu. Refer to “8.6.3 Object
Trees”.

Obstacle

Specifies display of an object. When Obstacle in the menu is check-marked the
obstacle object is displayed.

Define the obstacle with Object Tree in the Tools menu. Refer to “8.6.3 Object
Trees”.
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8.6 ToolsMenu (Arm Manager)

Il:u:l| ﬂE:||:I
Options...

Bemote Operation

Object Tree

Boze Converzion

Fig. 8-16 Tools Menu

8.6.1 Options

Makes various settings that are necessary for Arm Manager.

Select Options from the Tools menu to display the Options dialog box. Click on
the tab and set the required data at the respective items.

When you put a checkmark at Create Header File, the macro definition file
(arm_cnf.h) for arm configuration is created.

Note: The items that can be edited vary with the user level. For
restrictions by user level, refer to “1.3 Security”.
For information on how to change the access level, refer to “4.3.3
Re-Log In”.
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8.6.1.1 Monitor
£F Options |

| Cunfig.l Trajectory | Zervo | Tool | W ork | &rea | Display |

i
\ 00l ms
1
Action History:  —— T 10 Points

™ Monitor Work Coordinate System Simultaneously

™ Wonitor Tool Coordinate Systern Simultaneoushy

ANAN

A\

Check this box when
displaying the monitored
values.

T \Psmuam 1 il e spn S0 LA-DER TLA DED sem - Aums M snage =] ED

[ Il jotee e (e [l
T ol o #lsl «lEl
\\ =] ﬂ:us-'l 14 BESE 9 FEGEE, [1 54 5585 1

o 3]s W)

3l

I
L

|

B

541 N g 1 4

Fig. 8-17 Monitor Tab (Options Dialog Box)

« Timer intervals: Sets the intervals for acquiring data on the monitor. Default is
500 msec.

« Action history:  When drawing the trajectory of a robot, this specifies how
many points of position data to draw. Default is 10 points.
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8.6.1.2 Configuration

Click the Config. tab to set various parameters that affect acceleration,
deceleration, and positioning. For the meaning of each parameter, refer to “4.6
Control Sets of Motion Optimization”, “4.7 Setting the Master Control
Parameters in User Preferences” and “Appendices” in the Programmer’s

Manual.

HF Oipticns El
Monitor E-E':T!m. || Trajectory | Ealr'uu] Tnl:ll] '#urh| Hrﬂl I:llr-pli,rl
Fropeity Setwalus
B ]

B 1
- ]
& 1
N ]
Cardnal s# ol mokon oglimizEhon 0
Floor-rmournt or Cverhead-raount 0
Mass of pasicad (g) 10000 -
ok | concal |

Fig. 8-18 Config. Tab (Options Dialog Box)

8.6.1.3 Trajectory Generation

Click the Trajectory tab to set various parameters needed for robot arm
operation.

Change parameters by rewriting the set value grid in the list.

For the meanings of parameters, refer to “Appendix” in Owner's Manual
(Programming).

Monitor| Cortig. [ Trajectory || Servo | Toot | work | Area | Dispiay |

Froperty

Setwvalue

F]

1

11

Positive saftware motion imit (J1.deg10°3) | 176000

Fusittve saftwars mation hmit (2 deg 03 | 135000

Pusilive saftware motion mit (/3deg 108 | 155000

Posithwe software motion lirmit (J4.deg*10°3) | 135000

Fositive software motion it (J5 deg10°3) | 120000 .
ok | cancal |

Fig. 8-19 Trajectory Tab (Options Dialog Box)
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8.6.1.4 Servo

Click the Servo tab to set various parameters necessary for the robot arm servo
system.

Change parameters by rewriting the set value grid in the list.

For the meaning of parameters, refer to “Appendix” in Owner’s Manual
(Programming).

'j;:— Optsons

Fropary Selvalug

LT T I — I — L — A — 2 — ]

Fig. 8-20 Trajectory Generation Tab (Options Dialog Box)

86.1.5 Tool

Click the Tool tab to define the tool coordinates to be displayed on the robot
display.

Clicking on the tool coordinate system set button J will open the same Options
dialog box.

Monitor| config | Trajectary | Sarva [ Tool || work | area | Desplay |

m:-dw*lzlm-:lﬁleil
m o oy o g 0
o o 0 @ 0
33 o o 0 0o 0
4 o0 Do 0 o 0
N ol o o o o
E o o 9 gy 0
.'|".ILI.ILII.'1|r
R

ok | cancel |

Fig. 8-21 Tool Tab (Options Dialog Box)
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8.6.1.6 Work
Click the work tab to define the work coordinates to display on the robot display.
Clicking on the work coordinate system set button ﬁwill open the same
Options dialog box.
'g;:- Oplsons
Mo, | | Z| R =] rI|
1 0 i [ 0 0 i
Z 0 0 0 0 0 i
El ] 0 ] ] 0 1]
4 ] 0 ] ] 0 1]
g 0 0 0 I 0 0
B 0 0 0 0 0 i
7 I 0 I 0 0 1]
Fig. 8-22 Work Tab (Options Dialog Box)
8.6.1.7 Area

Click the Area tab to define the area to display on the robot display.
Clicking on the area set button ﬂ will open the same SET dialog box.

Monttor| config. | Trajectary | Sarva | Tool | work [Ares | pesplay |
MNa. | M| 2 Re Ry Fil

0 0 i 0 0 0

1 i i 0 i 0

2 i 0 ] 0 0

3 i i 0 i 0

4 a 0 ] I} 0

5 1 0 0 0 0

3 i i 0 i 0 =
-ll i 5 - & . 0 Il

ok | cancel |

Fig. 8-23 Area Tab (Options Dialog Box)
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8.6.1.8 Display

Click the Display tab to set the display option between Show and Hide.
This display tab appears when the user level is higher than the programmer.

Monitar | canag | Trajectory | Seren | Toot | work | Area 'Elpli_'r_'l

Cedion

Fils Espstvdian Man

Fomshc e s Soresa C S e ik

Frrmission of CALSET transmission
L5 hariw e acoeierabor

o | conca |

Fig. 8-24 Display Tab (Options Dialog Box)

« File extension menu: Extends the Files menu of the Arm Manager. For detalils,
refer to 8.1.5 “Menu List”.

 Auto Update (automatic acquisition of snapshot):
If you change the window size or scroll the screen when
the Arm Manager is connected or in the process of
connection to the Robot Controller, the Manager
automatically monitors the snapshot.

« Only when the "Permission of CALSET transmission” is selected, CALSET
data (RANG, CALSET values) may be transmitted. This is to avoid unexpected
transmission of CALSET data.

This option is not selected by default.

Note:The RANG and CALSET values differ in each robot. When
transmitting them, make sure that correct data is set up for
transmission. If the robot controller receives incorrect data, the
robot will not run normally.

For details about "CALSET," refer to the INSTALLATION &
MAINTENANCE GUIDE.

« You may choose the use of hardware accelerator.

If enabled, the hardware accelerator will make Arm Manager draw faster on
screens according to the "Graphic hardware accelerator” settings of your PC.

If you modify this setting, restart WINCAPSII to make it go into effect.

Note: Depending upon graphics drivers installed in PCs, the hardware
accelerator may cause Arm Manager to fail to display correctly in
some cases. If such occurs, disable the hardware accelerator.
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]
« Displaying details of arm objects [Ver. 1.8 or later]

When “Detailed display of arm objects” is selected, the screen shows all the
robot objects in the object tree from base to flange. The screen is changed
when the WINCAPSII is activated.

T Obgect Tron

L Basg Total Objects: (104 /256
[ PowecSupply « Db

([ PometSupplyi ; 2

#— BaseBody [ Dlplay Fimchaw

I Areal

{1 Areal
*
i
z

i Areal
[ Argad
[ Aread
I Aread Lim = -
] Arsak
[ Area?
A WorkDd
A Workld

4 Work? oo [ |

A Works
A Workd ;J'.'-'l't | r |
B Workb .

A Workh | j

A Work? | E:‘} IE) & E__j Ij

Fig. 8-24b Object Tree Dialog Box

GEES

8.6.2 Remote Operation

Selecting the remote operation command displays the Remote Operation dialog
box.

To remote-operate the robot, click the remote operation button on the Remote
Operation Dialog Box using the mouse.

%+ Remote Dperation [ x|

WORKD-BASE 7]
TOOLD-Flange 7

|
g
i
p
|
J
i
p
i
p

Remote operation button

Fig. 8-25 Remote Operation Dialog Box

Note: Use the Arm Manager in the disconnected state. For reasons of
safety, the robot is designed not to move even if the Robot
Controller is connected.
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8.6.3 Object Trees

Defines the object to draw on the robot display.
Select Object Tree from the Tools menu to display the Object Tree dialog box.

A
Toksd Ciyects- [ 115 r2

i i Y Corresponding axis
Moving direction and scale

[ |I !J‘"-. ;~-‘!|1!4—Additiona| buttons

Fig. 8-26 Object Tree Dialog Box

e [+] mark: Indicates that the hierarchical structure of the lower order of the
object tree is hidden. Clicking will show the hierarchical structure of
the lower order.

e [F] mark: Indicates that the hierarchical structure of the lower order is
displayed. Clicking will hide the hierarchical structure of the lower
order.

« Additional buttons: Use these buttons to add an object with the specified shape

as a subdirectory of the currently selected object.

* Close: Closes the Object Tree dialog box.

 Relative Position: Inputs the position of relative object in the event

coordinate system

o XIYIZ: Refers to x/y/z components of the relative position of the object.
Units in millimeters.

* RX/RY/RZ: Angle of rotation of the object around x/y/z axes.

Specified in degrees.

« Size(L): Inputs the size of the object.
o XIYIZ. Refers to the length (size) in the direction of x/y/z. Units in
millimeters.

* Color(C): Selects and inputs the color of the object.

« REDRAW: Refreshes the robot display.

« Display: When check-marked it is displayed on the robot display.

» Corresponding axis: It is possible to move the object in combined motion with
the selected robot axis. Select the corresponding axis and
its moving direction and scale.

Cautions: (1) Even if the property of the object is changed, it will not be
reflected unless the REDRAW button is depressed.
(2) Positions of the arm, tool, work, area and size cannot be
changed.
(3) To change tool, work and area use the SET menu.
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8.6.3.1 Adding New Objectsto Object Trees

Select an object to be added.
» STEP 1

} STEP 2 Right-click to display the contents menu, and copy the object.
Cut Chrl+
Lopy
Faste Chrl+
Rename
Reconfigure
} STEP 3 Right-click to display the contents menu, and paste the object.
@ RDEDé Fiase:1 Cut Chrl+
.......... ase: EDDP Etr|+|:
E‘ Paste Chl-+f
_— Rename
Beconfigure
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8.6.3.2 Deleting Objects

Select an object to be deleted.
» STEP 1

} STEP 2 Right-click to display the contents menu and cut the object.
Copy Chrl+C
Pazte Chrl+b
Fename
Beconfiqure
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8.6.3.3 Rendering Object Images by Arm Manager

This section describes how to create object images including palette bases, palettes,
works, conveyer and its tool as shown below.

¥ C¥Proeram Files¥Wincaps2?¥VS-6577E¥v5—6... M=l E

Fil=  Edit Action Yiew Tool Help

Zm|g| 5| ol =&l
I~ | 2] 13 34 us] [
15 ( uE

The object image rendering procedure consists of the following steps:

(1) Creating a palette base

- Resizing the object
- Moving the object position
- Copying the object

(2) Creating a palette

(3) Creating a work

(4) Copying a combined object (palette + work)

(5) Copying a combined object (palette base + palette + work)

(6) Creating a conveyer and its tool object, then setting the work object onto the
conveyer tool object.
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[1] Creating a palette base object

(1) On the Tool menu, click Object Tree to open the Object Tree dialog box.
(2) First let's create one foot of a palette base object.

Click the button to create a square base image object. The object will be
added to the object tree at the same time.

. Object Tree =] £

4 G:¥Program Files¥Wincaps2¥\S-6577E¥VS-6577E¥VS—6577E_. [M[=] B3

I@ Foot File Edit Action Miew Tool Help
=Base ‘ Total Objeds: /256 ‘ St = = ol
ety == [ T
¥ Display Fedraw | = lnt 000 000 000 000 000 000 &
Relative Position: i
S 0 R a
Y 0 Ry 0
Z 0 Rz ]
&
Size: £ Half o Eull
" 0| R
N 0 R
Z 0f Rz
coor [ _|
Joint __L,
| |
NNAE
3
2 4

(3) On the Object Tree, right-click the <ObjectName> and click Rename in the

dropdown menu to give it the desired object name.
Enter the object name you want to use and click OK.
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& Foot : —
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Haste (Gl
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; | 0
Bebuild Ry
Mave Robot Dat RZ U . .
i (4) Change the object color, if you want, by
e [ Halt  Eull clicking the color buttons.
Shanee St 4 =
Tl k] 2 = Color 2 | x|
zZ ] o0 Rz Basic colors:
coor [ | IR
__ A e
Joint — T .
| EE 1 ...
- AN EEEEEN
LIB[AB|0T (O T
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Colon j 00
e | FEEEEENEN
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(5) To change the object size, click the object you want to change in size and enter
the desired size (numeric values) into the Size boxes as shown below at left.

: Object Tree
|® Root

[P Base ‘ Total Objects: / 256 ‘

r~ Property - Object(108]————
Relative Position:

5 200 Rt 1]
N 400 Ry 0
2 0/ Rz i

ize: ull

NN EE

% C:¥Program Files¥Wincaps2¥\S-6577E¥VS-6577E¥WS—6577E. [M[=]E3

File Edit Action Wiew Tool Help

AD8l 5] *s| &g
i~ o1 32 93] 4] 15| 38|
~Jnt 000 000 000 000 000 000

%% |

(6) To move the object position, click the object you want to move and enter the target
position (numeric values) into the Relative Position boxes as shown below at left.

" Object Tree

‘ Total Ohjects: [ 109 /256 ‘

r— Property - Object(108)————

0

B
® 300 B

Y 00 By 0
-
ze: & Half ¢ Eull

LN
400 By

50 RZ

Lolor: rmj

Joint ...._............:;]
- —

NN EE

M€ x o

4 G¥Proeram Files¥Wincaps2¥VS—-6577E¥VS-6577E¥VS-6577E.. [H[=] E3
File Edit Action Wiew Tool Help

A@al 7 s &gl
[N [ nl  nl  nB] ol s
3 (| (=Dt 000 000 000 000 000 0.0

% % 5]

8-29



(7) To create another foot of a pallet base, copy and paste the object in Arm Manager
according to these steps:

Right-click the object (the foot created in the steps above) you want to copy and
click Copy as shown below at left.

Click the target place where the object should be pasted, then click Paste.

, ¥ C:¥Proeram Files¥Wincaps2¥VS-6577E¥VS—6577E¥vS-6577E.. [Mi[=1E3
e Fie Edit fcton Wew ool Hebp
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i E -
et (RN o | i
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= — = obyEHlieR W= 0.00 0.00 0.00 0.00 0.00 0.00
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| |2 ]

cul it

l, ty - Object(108] —
T Topy Cir+G
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& Position:
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E00 Ry [1]
50 RZ [1]

=| olal®
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e
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Vovz OB "ol

z | 50| Rz

(8) To move the pasted object in Arm Manager, click the object and enter the target

position (numeric values) into the Relative Position boxes as shown below at left.
" Object Tree

4 C:¥Proeram Files¥Wincaps2¥VS-6577E¥VS-6577E¥VS-6577E.... [M[=] B3
‘ File Edit Action Miew Tool Help
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2 50 Rz
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| "
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i
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(9) Let's create a palette base object.

Copy and paste the object and enter the desired size and target position into the
Size and Relative Position boxes, respectively, as shown below at left.

" Object Tree O] x| ¢ C¥Proeram Files¥Wincaps2?¥VS-6577E¥VS—6...
Eile  Edit Action \iew Tool Help

@|!|!|§| *- | #E
I O 1 I T I =2
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r~ Property - Object(110)——————
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=3 500 A 4 8
< Y 0 Ry 0 ’El
2 60 Rz =]
IE

NN EE

[2] Creating a palette object

(1) First let's create a palette bottom plate.

Click the (s button in the object tree window to create a square bottom plate
object. The object will be added to the object tree at the same time.

(2) Enter the desired size and the target position into the Size and Relative Position
boxes, respectively, to set the pallet bottom plate.

" Object Tree O] x| ¢ C¥Proeram Files¥Wincaps2?¥VYS—6577E¥VS—6...
‘ Eile  Edit Action \iew Tool Help
Total Ohjects: -1 12| /256 ‘
P e =] R S e v =
~ Property - Object111)———————— I—_I_I_|| _J!| _JIJI_l |_II|I | HEs
¥ Display Redraw | .
P T p
’El
3
(&

¥ 30 Rx 0
Y 650 Ry 0
7 130 gz 0

ull
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(3) Let's create a partition.

Click Pallet in the object tree and enter the desired size and target position into the
Size and Relative Position boxes, respectively, based on the bottom plate created.

" Object Tree ¢ C¥Proeram Files¥Wincaps2?¥VYS—6577E¥VS—6...

Eile  Edit Action \iew Tool Help

| Total Objects: [ 113] /256 ‘ Am2| 5 *8 gl
=

r Property - Object(112)————

. S O 7 T [ | -
Relative Position:
0 Rmx i 8 ﬂ
g 300 Ay 0 ]
— 5
Size: = Half  Full IE
3000 Fe
iy 100 By
2~ 10 a7
LColor: r_m—’_l_’
Jdoint ___v_‘l
I —
NN ElE .
I~ -

(4) Let's copy the original partition object created in step (3) to arrange it in parallel
with the original partition object.

Copy the original partition object and click the target position to paste it.

Enter the desired position (numeric values) into the Relative Position boxes to set
the partition. Repeat this operation to create the required number of partitions.

" Object Tree (O] x] ¥ C¥Proeram Files¥Wincaps2¥V5-6577E¥VS-6.. [M[=]E3
|® Foot ‘ File Edit Action Miew Tool Help
Total Objects: [ 117 /256 ‘
ﬁl!l!l 2 sl el
- Property - Object(116]—————— | Jll le J3| jq| J5| =
Fielative Pasition:
3 0 R
Y 300 Ry 1]
NZ 90 Rz
Size: & Half ¢ Full
b 300 Fi
ke 10 Ay
z 100 /2
Lolar: I _I_I
Jairit — vl
| == 1
MNP
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Chapter 8 Operating Arm Manager

(5) Let's create a partition perpendicular to the partitions created in steps above.

Click Pallet in the object tree and copy the original partition object and click the
target position to paste it. Enter the desired position (numeric values) into the
Relative Position boxes to set the partition.

" Object Tree ¢ C¥Proeram Files¥Wincaps2?¥VYS—6577E¥VS—6...
Eile  Edit Action \iew Tool Help
Total Objeds:-ﬂﬁ /256 ‘
A0 0 F k-0 '
- Property - Object{117) I—_I_I_|| _J!| _JIJI_l |_II|I | HEs
¥ Display ; - ﬁ[
Felative Position H ﬂ
300 g TN
y | py 0 fil
[ =g E
Size: & Half  Eull IE
=3 100 A
Y 300 By
LColaor: I _I_l
Jaint TMH
| "
NN E]E
=
3
2 A

(6) Let's copy the original partition object created in step (5) to arrange it in parallel
with the original partition object.

Copy the original partition object and click the target position to paste it. Enter the
desired position (numeric values) into the Relative Position boxes to set the
partition. Repeat this operation to create the required number of partitions.

: Object Tree O] =] 4 C¥Proeram Files¥Wincaps2¥VS-6577E¥VS—6... M=l B3
File Edit Action Miew Tool Help
‘ TDta|ObjEC‘tSZ /256 ‘ ﬁg’glll EI *ll}-‘l@ %tl T“‘:Z_I
~ Propetty - Objest{121]—————
ropey - Glectli=l) I~ T 11 2] 13 1] 35| 1|8
¥ Display 7
Wﬁ%n:
x® -300 R 0
N 0 Ry 1]
S R 7
Size: & Half ¢ Full
® 100 B
i 300 Ay
z 100 /=
LColor: I _I_I
Joint — :_I
| 1
NNRE
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[3] Creating a work object

Create a work object by using the v button in the Object Tree window and put it in

the partitioned space, in the same way as described in the previous sections.

" Object Tree O] x| ¢ C:¥Proeram Files¥Wincaps?¥VYS-6577E¥vS—6... [l [=] B3
I@ Root Eile  Edit Action \iew Tool Help
& -[F) Base ‘ Tatal Chjects: -128 /256 ‘ ar
: i Pallethase ~ Propery - Objsct{127) ﬁl!l!l EI ﬁlﬁl@l _m
=@ Palet . [ a1 gzl 33 1 5| [E#
Rielative Posiion: & 2 ﬂ
< 80 R N 2
-80 0
............ il Pallet > T E;
............ il Pallet U =
Size: & Half « Eull IE
® 30 F
N 300 /Yy
z 80 B2
oo |
Jaint _—L,
| == ‘
=
3
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[4] Copying a combination object (pallet + works)
(1) In the Object Tree, right-click a higher class

object containing objects to be copied, and
o @B Total Objects: [ 128] /256 click Copy

- .. hase |- Propenty - Object(111)

T v - (2) Click the object to which you want to paste the
¥ Position . . A
. e ke ;§|:g copied object, then click Paste.
) apa Bebu t Tree -y - -
7 e — (3) Enter the target position (numeric values) into
R e the Relative Position boxes to set a
e 6] . . .
B em| i Dy combination object (pallet + works) as shown
g S T — below.
B 2 v - . —
B Work —"— o i 4 G:¥Proeram Files¥Wincaps2¥V5-6577E¥VS—6... [M[=] E3
ooy Obj il f et Filz  Edit Action Miew Tool Help
@ ﬁl!l!l 2 sl el
41 [ n| n] 5 1 [#
gt ¥ -
3 Q S
3 - — #
;_' .: = |
T =
y H [
- | 8 Y L )
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Chapter 8 Operating Arm Manager

[5] Copying a combination object (pallet base + pallets + works)

In the same way as described above, copy a combination object of a pallet base,
pallets and works onto the desired position.

¥ G:¥Proeram Files¥Wincaps2¥V5-6577E¥VS—6... M= E3

File Edit Action View Toal Help
#0807 %lire] &El
[ ] m ] a3 i[#E
-] #
| JiLois
[ _>| "

[6] Creating a conveyer object and itstool objects

In the same way as described in the previous sections, create a conveyer object and its
tool objects and then put works on the conveyer tools.

: Object Tree =13 ¥ C:¥Program Files¥Wincaps2¥VS-6577E¥YS—6.. M=l E3
& Root - File  Edit Action Yiew Tool Help
.......... B Base ‘ Tatal Objects: [_197] /256 ‘ = ; =
: i | T
= @ Pallet hase  Praperty - Object(196] I_ﬁl!l!l EI ilﬁl@l &l_l I_
[ Palletbase s | o o o M s |#E
£ Pallet hase I Display -Bedraw =
o « (il
Relative Position: ﬁ%
bs 0 R 1]
£ Pallet hase ¥ <5 | A 5
= z 0 Az i
Size: & Half ¢ Eull
" 30 R
Y 30 Ry
Z 80 Rz
- @ Coweyerool | Cor I |
---------- B Conveyer ool
Joint — vl
-] —
) I N E]E]
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]
8.6.4 Pose Data Conversion

This is the tool for converting the data type between the three types of pose data
(P type, J type and T type). Conversion is made on the basis of the specified
work coordinate system (WORK) and tool coordinate system (TOOL). Clicking
on the work coordinate system, tool coordinate system or the data type will run

the calculations for conversion.

Pose Conversion 0

~Local Coordinate System
¥ [worko-Base x| &7 [TOOLO-Flange 7]

C Type d C Type T

FIG |3

Fig. 8-27 Pose Conversion Dialog Box
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Chapter 8 Operating Arm Manager

8.7 Help Menu

Descriptions on how to use WINCAPSII can be viewed using the Help menu.

| Help

Licenze Key

dbout Systern Manager

Fig. 8-28 Help Menu

8.7.1 About Arm Manager

Displays the version information on Arm Manager.
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Operating Vision
Manager

The Vision Manager handles the functions of the
vision control device. This chapter describes the
WINCAPSII Vision Manager used by the
personal computer teaching system.






Chapter 9 Operating Vision Manager

9.1 Outline of Vision Manager

9.1.1 Outline of Functions

The Vision Manager supports the creation of vision programs in PAC.

The Vision Manager enables you to interactively proceed with the defining
vision processing windows, create search model, and lookup tables.

Image data can be backed up in BMP format, while search model data can be
backed up by user defined specific formats.

You can start the Vision Manager by clicking on the @l System Manager
button or from the Window menu.

When the Vision Manager is started, the Vision Manager window appears on
the screen. The following are the functions of the DIO Manager.

Note: A uVision board (optional) is needed to use the Vision Manager.

9.1.1.1 Vision Manager Window

Shape edit tool bar Main tool bar Menu bar

€ C:-\Program Files\WINCAPS 2\ IRA-00000MRA-DO. .

File Acktn: Tools Hél

TZ ol o w818 @]l ]alm>

Object screen status \ Teaching panel

Image data status Display screen status

Fig. 9-1 Vision Manager Window
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Teaching Panel:

When editing the window shape and/or search model shape, adjust the
shape with the teaching panel, using the mouse.

Display Screen Status:

Displays the current screen displayed state on the Vision Monitor. The
camera or processing screen state is also displayed here.

Object Screen Status:

Displays the screen analysis processing object (Process Screen 0 to 3).

Image Data Status:

Displays the attributes of image data displayed on the teaching panel.

9.1.1.2 Options Window

#F Options

Look Lip | General Setiing | Display |

Brigh Takls0 |Taklel |Takle? |Takle3 |T:i|

o I 0 0 255

1 1 0 1 254

2 2 1 T 253

3 5 z % 257

4 4 Z 74 251

R R & ar 7RN hl
=Standard Table: 100%

j Set to Standard |

[T Create Header File

Cancel |

Fig. 9-2 Options Window

Look Up tab:
Sets the lookup table.

General Setting tab:

Sets general information concerning vision function.

Display tab:
Sets the extended display.
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_________________________________________________________________________________________________________|

9.1.1.3 Edit Macro Name Window

#f Edit Macro Name |
Window | Search Model |
Mao.|Usage |Macr|:|

a

1

Z

3

9

&

k

7 -
ak. Cancel

Fig. 9-3 Edit Macro Name Window

Edits the macro names of the windows and search models. The macro name
definition file can be created from the input macro name. The macro name can
then be used in programs.
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9.1.1.4 Various Tool Windows

Area. Gravity Center. Principal Az
—heasuring Condition
Object “indaws: IWindDwD: j Back
Measuring Mode: |o-Principal Axis =] Editwindow
Object: & ‘white " Black o moan |
Binary Processinc |l
’V Lawer. IE Dhject Windaw: Back
Wylind ol j o
HESU” Erupew
lterms ek
. . Farameter “alue
FProcessing Time (m — Del
& > angin 24 elete
res —
Girawity Center = 1 B - 3 Register
Grawity Centar v Square—w@th 73
Angle sguare - height 417 IFput
Integrate Brightness | =d44are -angle 0
— — = Square - mode 2 Cam Image

Fig. 9-4 Various Tool Windows

The Tool window is called from the main window. The work objective is carried
out through a combination of these tool windows.

Table 9-1 Functions of Various Tools

Camera input Inputs camera images
Select display screen Controls screen to display on vision monitor
Edit window Makes window
Edit search model Makes search model
Binary-coded Sets binary code level for image analysis

registration

Area, center of gravity, Analyzes area, center of gravity and spindle

principal axis
Measure labeling Analyzes labeling
Measure edge Analyzes edge
Model search Makes pattern matching using search model
Read code Reads QR code
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9.1.2 Tool Bar

Shape edit tool bar

£ C:\Program Files\WINCAPS2\RA-0000MRA-00_.. [M[S] E3

File Action: Toolz Help

Main tool bar

] W= O T

E BT

Fig. 9-5 Main Window and Tool Bar

Main Tool Bar

b

SEek=

Connects with the Controller.

Displays the environmental table
transmit dialog.

Displays the camera input tool.

Displays the window edit tool.

Displays the binary processing
registration tool.

Displays the labeling tool.

Displays the model search tool.

Shape Edit Tool Bar

'\ Makes changes, moves and edit.

y;
0
|

Specifies the shape of lines
(between two points).

Specifies the shape as oblong.

Specifies the shape as an
ellipse.

| Acquires controller information.

£

£ 1

GODE

@

L.
O
D

Displays the area, center of
gravity and spindle tools.

Displays the edge tool.

Displays the code read tool.

Makes rotary editing.

Specifies the shape of the line
(length).

Specifies the shape as a circle.

Specifies the shape as a sector.
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9.1.3 Basic Application

During image analysis

@

A

Connect the Robot
Controller

A 4

Display camera images by
selecting display screen

Input camera images

Register a window
to use for analysis

A

Register the binary-coded
level to use for analysis

Measures the area, center
of gravity and spindle

End

9-6

Chapter 9, subsection 9.3.1 “Connect.”

Chapter 9, subsection 9.4.6.3 “Select Display
Screen."

Chapter 9, subsection 9.4.6.2 “Camera Input."

Chapter 9, subsection 9.4.3 “Edit Window."

Chapter 9, subsection 9.4.6.4 “Binary-coded
Registration."

Chapter 9, subsection 9.4.6.5 “Area, Center of
Gravity, and Principal Axis."
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9.1.4 Files to Be Managed

Fig. 9-6 shows the five files that the Vision Manager manages.

I
vis_cnf - vis_tab
h / Vision \ h
’ manager .
Configuration macro Macro definition file
definition file
3
*.bmp *mdl
*vis
Bit map file Model data file Vision file

Fig. 9-6 Management Files of The Vision Manager

9.1.4.1 Vision File (*.vis)

Contains set information about the vision board including window, search
model, calibration, lookup table and system settings. Since they are in different
files by project, the respective vision information can be managed without
confusion, even if multiple projects are involved. The file extension is “.VIS”.

9.1.4.2 Model Data File (*.mdl)

Contains the search model image data. It is managed with relational
information registered to the vision file. The model data file is located wherever
the vision file (*.vis) is. The extension is “.MDL”.

9.1.4.3 Bit Map File (*.bmp)

The Vision Manager can handle files in BMP format. Image data received from
the Robot Controller can be stored in BMP format. Also, BMP formatted files
stored, in advance, in the Vision Manager can be opened. Bit Map File is
located wherever the vision file (*.vis) is. The extension is “*.BMP”.
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9.1.4.4 Macro Definition File (vis_tab.h)

Contains the correspondence definition, between the window macro name and
number, and the macro name and number of search model. The macro
definition file is located wherever the vision file (*.vis) is. The file name is
“vis_tab.h”.

9.1.4.5 Configuration Macro Definition File (vis_cnf.h)

Contains the vision set data macro definition information. The configuration
macro definition file is located wherever the vision file (*.vis) is. The file name
is “vis_cnf.h”.

To use the macros related with window, search model, and configuration in

PAC project, it is necessary to read this macro definition file by specifying
#INCLUDE statement at the top of program.
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_________________________________________________________________________________________________________|

9.1.5 Menu List

The Vision Manager command menu has the following tree structure:

File
New *1
Open *1
Save
Save As *1
Transfer
Open Image Data
Save Image Data As
Print
Make Macro Define File
Import Macro Define File
Close

Actions
Connect
Get Info

Tools
Options
Edit Macro Name
Edit Window
Edit Search Model
Calibration
Image Analysis
Camera Input
Display image
Binary-coded Registration
Area, center of gravity, principal axis
Labeling
Edge
Model search
Read code

Help
About Vision Manager

Fig. 9-7 The Vision Manager Menu Tree

*1: Displayed only when the display option file extension menu is checked. To
set the display option, re-log in at programmer level, then select Tools,
Options and View, and check the option file extension menu.



9.2 File Menu

The file stores necessary information for operating the vision device and it also
reflects the contents of editing with the Vision Manager. The following shows
the list of data stored:

System set data (camera setting, etc.)

Lookup table data

Window data

Search model data

Calibration data (teaching point data and conversion factor)

File Actions Toolz Help
Hew
Open...
Save Chl+5
Save hs...
irarEten,.

Open Image Data
Save [mage ats fs

Frint... Chrl+FP

Make Macro Definition File
Impart Macra Definition File

Cloze

9.2.1 New (Programmer level)

Creates a new set file for an editing object. Default is stored when making a
new file.

9.2.2 Open (Programmer level)

Opens the saved set file to edited an object.

9.2.3 Save

Saves set data currently being edited.

9.2.4 Save As (Programmer level)

Saves the set data under editing by newly creating a file.
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9.25 Trandfer

9.25.1 Transmitting Set Data

Transmits set data between the Robot Controller and the personal computer.
This function is used for transmitting set data edited by the Vision Manager or
for receiving Robot Controller (backup) set data.

To transmit set data, it is hecessary to be connected to the Robot Controller.
For instructions how to establish a connection, refer to Chapter 9 “9.3.1
Connect” in this manual.

9.25.2 Transmitting Image Data

Image data is transmitted between the teaching panel and the Robot Controller
(Ver.1.5 or before: Process screen 0 to 3, Ver.1.6 or later: + Camera screen 0
to 1). The teaching panel displays the images of the currently held image data.
If nothing appears on the teaching panel, no image data is being held.

- O x

ile ﬁctl-on.s Tools ﬂelp. Robot Controlle@
| M%) @& B[E[0]e0] @] | g

(ul B

|

Process Screen 0 Camera Screen 0

EleisElsN sl

(Ver.1.5 or before) Addition (Ver1.6 or later)

N J

| |Hec7{ved Image Data

Teaching panel

Notel: If no image datais held, only
receiv-ing is enabled.
2: Camera screen is only for receiving.
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9-12

C —

@ Transfer Environment Table

| mage Data Transmit Procedure

 Transfer Tahle

[ 1<System Settings>
[ 1<Look Up>

[ 1<Calibration>

1 <wvinclows

N <Search Model»

%@ Transfer Image Data

<Imapge Data>(Receive Only

1441

Transmit »

< Receive

Cancel

SelectAll

Process Sor

rocess Screen vI

Screen Si

[ ox |

File  Actions  Toolz Help

(& 2| o| M| 8l&] @e]t]ssalw

~ Received
image

File | Actions Toolz  Help

l? « Connect

&l & | es|os]o0 Q]

Get Info

Disp Een irayitie
Process Screen

Feceived Image Data

(1) Check image data (A) in the Transfer

Environment Table dialog.

(2) Click on either Transmit or Receive.
The data update check dialog appears

on the screen, click on Yes.
The Transfer Image Data dialog appears.

(3) Set the processing screen (B) and the

drawing screen (C) as the object screen
for transmission. Image data is
transmitted between the processing
screen, specified here, and the
teaching panel.

(Drawing Screen is for Ver.1.6 or later.)

(4) When receiving image data only, set

the Screen Size to either 1/4 screen or
1/1 screen. When transmitting, the
screen size is determined according to
the image data held in the teaching
panel.

(5) Click on OK in the Transfer Image

Data dialog box.

The image data is transmitted.

When receiving, images of new image
data are displayed on the teaching
panel. Also, during transmission, image
data is transmitted onto the processing
screen specified.

(When transmitting, the image data on
the drawing screen is not transmitted.)

(6) After receiving image data, you can

display the drawing screen or the
process screen by selecting the action
menu, and can save image data.
(Ver.1.6 or later)

— Displayed screen
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9.254 Image Data Screen Size

Determine the size of image data to be received using the Screen Size setting
in the Transfer Image Data dialog. The 1/1 screen receives all the image data
on the processing screen. The 1/4 screen receives the image data on the
processing screen by thinning the data to 1/4. When 1/4 screen is selected,
time required for data transmission is reduced to 1/4 of the 1/1 screen thus
saving time.

The display size of the teaching panel differs by the screen size. Since the 1/1
screen is about 4 times larger in size than the 1/4 screen, it is not possible to
display everything on a low-resolution personal computer screen. In cases like
this, receive the image data by setting the screen size to 1/4 screen.

When the image data that has been saved is transmitted to the Controller, it is
possible to analyze the same image data. In this case, if image data to be
transmitted is on the 1/4 screen, the analytical result will be different from
before, since the image data is thinned to 1/4.

Note: If the number of possible colors displayed on the personal
computer screen is less than 256, some color errors may be
generated to the image data displayed on the teaching panel.
Although no particular operational problem will result, use a
personal computer screen having 65,535 (16-bit color) or more
colors that can be displayed to ensure correct color display.

9.2.6 Savelmage Data As

The Vision Manager can save image data displayed on the teaching panel in a
bit map formatted file. When image data is received from the Controller, the
data image is displayed on the teaching panel. Select Save Image Data As to
save the image data sample.

<Ver.1.6 or later>

The Vision Manager can save image data set on the teaching panel by
selecting “Export”. If the process screen or the drawing screen is selected,
composite image data is saved.

Screen sizes are as follows.

Kind of screen Selection Size

Process screen 1/1 screen 512 x 480
1/4 screen 256 x 240

Drawing screen 1/1 screen 640 x 480
1/4 screen 320 x 240

9.2.7 Open Image Data

With Save Image Data As, the Vision Manager can read the image data saved
in the bit map format and display it on the teaching panel. By transmitting
image data displayed on the teaching panel to the Robot Controller, you can
analyze the sample image that has been saved.
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9.2.8 Print

Prints the set data currently being edited with the Vision Manager.

9.2.8.1 Print Object

e Select All: Selects all of the environmental tables as the object for
simultaneous printing.

e Set: Displays the printer SET dialog box and makes various
printer settings.

¢ Preview: Enables viewing of the print status prior to actual printing.

e Cancel: Closes the dialog box without printing.

e Print: Prints the table.

e Option: Print options appear.

TIP: To print only specified page(s), click on the printer button | S after
previewing.

Note: If you select more than one object to be printed, Preview is not
usable.
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ﬂ

s Managar 99l 0eed
“<Epavmm Smungar : Moo il oo - wa_emll

Prozorip Val iz acm Armmalered
Coman | - 3buwa mechminm o | €A _SHUTI [
Comman | - lowa iagut l=ed o | ca_LEveE LI |
Cozan | -upps mpu l=rd 100 | cA_LEVEL I |
Coman | - cxomo uachlsuauachls 0| €A _COECT] |
oo ? - abuwa mchminm 0 | €A_SHUT? |
Coman t - lowa 1gut l=ed o | ca_LEVE Lt |
Coman t -upps mpu l=ed 100 | cA_LEVEL 2 |
oo - oo wachlsuauachls 0| CA_CoMECTY |
oo atochinoizuno aravm 0| A _SYHC |
ShCoin - diawmes 4 | SH_CoRM_DETI |
ShCoin - 1ovard | | SH_CoR_DET2 |
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ShCuc - iwmrd | | SH_CRC_DET |
ShCue - widih 3| SH_CRC_WDTH |
Semch ueeouL ues fom) 2000 | SH_TREOUT | j

m 1af1 }|}|||:an.:e|| §|ﬂ|@| Close| 17051 Totz

Preview Window

ﬂl :  Moves to the head/tail end of the page.
LI :  Moves to the immediately preceding/following page.
. Selects display (Reduction/Standard/Expansion)
Sets print execution
The printing range (specific pages) of an object file can be
specified.

L[5~ =

Print

Frinter: Swstem Printer [Canon LBP-730)
Print Bange Lancel |

@l 3 pages

£ Pages Copies: I 13:

From: | 1 Te| 3 I Collate Copies

Print Window
B3| &l :  Exports the object file.

The selected object file will be converted into the file format
specified in Format and outputted (saved) to the Destination.

E xport

Farmat: Deztination:

| Disk file =l

Character-zeparated values

ak. I Cancel |
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9.2.8.2 Option
Selecting the Option tag will display the print options.

Note: Print option is not available from the Vision Manager.

9.2.9 Make Macro Definition File

Prepare the data created using the macro-name-edit function. This function is
used to create the macro definition file (vis_tab.h) in the folder having the vision
(*.VIS) file. By reading the macro definition file into the program, you can use
the macro names entered using the macro edit function.

9.2.10 Import Macro Definition File

Reads the macro definition file (vis_tab.h) and expands in the Macro Edit
Window.

9.2.11 Close

Erases the Vision Manager from the personal computer screen. The vision
manager is not displayed on the screen but exists on the memory. When
restarted from the System Manager, the Vision Manager appears with the edit
data displayed just before the Vision Manager is closed.
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9.3 Actions Menu

9.3.1 Connect

Sets the connection object (edit object) of the Vision Manager. By establishing
a connection, communication with the Controller becomes possible. As a
result, editing of the controller setting (window and search model) and image
analysis can be performed. If set for non-connection, the Vision Manager sets
the file on the personal computer as the object to be edited.

m Tools Connection selection method 1:
— O Click on Actions in the menu bar. The Actions menu
Lonnect appears.
=0l @ Click on Connect.

The Vision Manager is connected and disconnected
alternately each time this command is issued.
Connection selection method 2:

The connection ON/OFF state alternates also when
you click on g in the tool bar.

- Display of Connection State -

The connection state is indicated by the pressed state of CONNECT button
& in the tool bar or a checkmark in front of Connect in the Actions menu.

Disconnected Connected

File Actio [y Iook File actic [0y ool
é{l | Connect ‘ ;:‘25 v LConnect

E{ =l o) Giet [nfo
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9.3.1.1 Edit Object of Vision Manager

9-18

The objects to be edited using Vision Manager can be mainly classified into the
following three types:

Type A, editing only the files in the personal computer. After editing, the set
value is transmitted to the Controller.
(Objects: general setting, lookup table, and calibration data).

Type B, editing both the settings of the Controller and the personal computer
files. After editing, the set values are shared between the personal computer
and the Controller by data transmission.

(Objects: Window)

Type C, editing only the settings of the Controller. After editing, the set values
are backed up in the personal computer file
(Objects: Search model).

In the case of Type A, the file on the personal computer is always the object of
editing, irrespective of the connection state with the Controller.

Types B and C have different edit objects, depending on the state of
connection.

When connected, Type B selects the Controller information as the object of
editing. When disconnected, it selects the file on the personal computer as the
edit object.

Type C selects the Controller information only for the edit object.
Consequently, editing cannot take place unless connected to the Controller.

~

- Relationship Between the e
Connection and Edit Object - |- ]

File on the personal computer L Controller setting
Type A: Type A:
. (LSenkeraI sz:ting ‘/ § cgj e General setting
e Lookup table 3 > e Lookup table
e Calibration % Q o Calibration
7 a @ =
Type B: X M Type B:
o Window Object of editing o Window
pun differs by the state of pun
connection/non-
Type C: connection. W Type C:
. Search model « Search model
V- L=

* Type A edits the file on the personal computer and transmits set value to the Controller.
e Type C edits the Controller information and backs it up on the personal computer.
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9.3.2 Get Info

To edit Controller Types B and C settings, as described in Chapter 9 “9.3.1.1.
Edit Object of the Vision Manager” in this manual, you must read the Robot
Controller information into the personal computer in advance. Without getting
information on the Controller, the Vision Manager cannot correctly edit the
Robot Controller settings.

To get information, connect the Vision Manager with the Controller in advance.
For details on connection the Robot Controller, refer to Chapter 9 “9.3.1
Connect” in this manual.

m Tools Information acquisition method 1:
= ® Click on Actions in the menu bar. The Actions
v Lonnect menu appears on the screen.

@ Click on Get Info.

Controller information (window/search model) is
acquired.
Information acquisition method 2:

Click on in the tool bar to acquire same
information.
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9.4 Tools Menu

9.4.1 Options

9-20

Creates the various settings needed by the Vision Manager.
Checking the Create Header File creates configuration macro definition file
(vis_cnf.h).
@ Click on Tools in the menu bar. The Tools menu appears.
@ Click on Options.
The Options window appears.

Note: Items that can be edited differ by the user level. As to restrictions
by user level, refer to Chapter 1 “1.3 Security” in this manual.
To change the access level in the middle of operation, refer to
Chapter 4 “4.3.3 Re-Log In” in this manual.

® Change the set contents.

@ Click OK to register the changed contents.
Click Cancel to invalidate the changed contents.

Edit M acra M ame
Edit " ird o

Edit Search Model |::>

Calibration

Image Analyszis

3 Dptions
Look Up| Gereral Setting  Display |
- Option
File Expansion Menu
Eutomatic ieheshléutomatic snapshot]

ak | Cancel |
/

/

oK, | Cancel |
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Click the Look Up tab to set the lookup table characteristics. By changing the
lookup table the user can change the camera image input characteristics,
camera images and processing screen display characteristics. 0 to 4, in the
lookup table, are reserved by the system. 5 to 15, in the lookup table, can be

9.4.1.1 Look-up Table
changed by general users.

Look Up | General Setting | Display |

Brigl Taklel |Taktel |Tahls? [Tabled [T~
0 0 0 0 255
1] i 0 k1l 254
7| 2 1 50 253

3 3 2 B3 252
B 4 2 74 251

5 5 3 a7 ?:n_l;l
4 13

Standard Table 100% j

et ta Standard

Create Header File Cancel

> —r 1|
o ——t+—

Table5 [Tableb | Tahles |Tableb |
241 241 ] 241 247
242 242 © | 242 242
243 (g |::> | 243[100
244 | 24— m
245 24 245 245
4R 24k dh 74k
E
{:I-Uptions [ x|
Look Up | General Sertingl Disp\ayl
Brigl Tablad [Tablsl [Tahls? [Tahlsd [T~
0 0 0 S
I 1 0 g =
E 2 1 En| 73
e 3 z b3 252
I 4 ? 74 251
Ll_ql g 3 a7 ?qnﬂJ
Standafd Table 100%;

’ j Set ta Standard |
r CIE{STE! Header File I o / Cancel |
/

| /

G H

Graphic display of characteristics

® Drag scroll bar (A) to display the table of
characteristics in the list (B).

@ Click the column (C) in the table to display
characteristics.
In this example, the graph (D) shows the
characteristics of Table 7.

Input and edit of set value numerals

® Double-click the cell (E) to change the set
value.

The cell character is displayed in reversal.

@ The input character will then be input
(inserted) in the position in the reversed
character.

Copy a standard table

@ Click the column (F) in the table to copy the
standard table.

@ Select the standard table (G).

® Click on Set to Standard (H).
The standard table is copied into the selected
table. In this example, 100% is copied to
Table 5.

Save editing results

Click OK to save the set value.
To invalidate the editing results, click Cancel.
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9.4.1.2

General Setting

Click the General Setting tab to make various settings for Vision Board.

For parameter definitions and element numbers, refer to “Appendix” in Owner’s
Manual (Programming).

Note: If you put a checkmark at Create Header File and select OK, the
parameter macro definition file “vis_cnf.h” is automatically
created. To use macro name with GETENV and LETENV in PAC
language, you must include this file.

Look Up  General Setting | Display |

Setvalue

Froperty

Camera 1

- shutter mechani

-

Camera 1

-lowerinput leve

Carnera 1

-upper ingut leve

*

Camera |

-camera usable;

*

I}

I}
1000
i}
100
i}

i}

0

=

Back to Standard |

[~ Create Header File

ok

| Cancel |
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1000

94

(1) Shutter method
Set the camera shutter system for each camera.
0: Field shutter 1: Frame shutter

(2) Input upper/lower limit level

@ Double-click the cell (A) to change the set
value.
The cell character is displayed in reverse
video.

@ Enter a value. The entered value appears
(is inserted) in the reversed value position.

® Click OK to register the changed value.
Click Cancel to invalidate the changed
value.

@ Click Back to Standard to restore the
default value settings.

Set the camera input level and the camera output signal relationships for

each camera.

By changing the upper/lower limit, the pertinent camera output signal can
be input, in more detail.
Always set the lower limit value to value lower than the upper limit value.
(Upper limit value > Lower limit value)
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(3) Synchronous method
Set the synchronous method in the camera. Since all the cameras are
simultaneously set, it is not possible to discretely change the camera
settings. For internal synchronization, set camera input with the Vision
Board internal synchronous signal. For external synchronization, set
camera input with the camera synchronous signal.
0: Camera internal synchronization 1: Camera external synchronization

(4) SHCORNER setting
Set the SHCORNER command measuring conditions. For details of each
parameter (distance, intervals, width and height), refer to SHDEFCORNER
command.

(5) SHCIRCLE setting
Set the SHCIRCLE command measuring conditions. For details of each
parameter (intervals and width), refer to SHDEFCIRCLE command.

(6) Search time-out time
Set the timeout time for search measurements (SHMODEL command,
SHCORNER command and SHCIRCLE command).
Search measurement error is detected by timeout.

(7) Vision monitor display position
Set the display position with the processing screens (0 to 2) displayed on
the Vision Monitor.
0: Center 1:Left 2:Right

(8) Search compatible mode
Set the kind of search models to be registered.
The search models are classified into two kinds: search mode that does not
require angle measurement and the model that requires angle
measurement. This setting allows you to choose the model kind for
registration. If you select “1” or "2”, the models that can be registered with
one model number to limited to one kind; thereby, you can increase the
number of models that you can register.
1: Model that does not require angle measurement
2: Model that requires angle measurement
3: Both
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9.4.1.3 Display

Click the Display tab to set the display option between Show and Hide.
This display tab appears when the user level is higher than the programmer.

-ﬁI- Options E
Look Up | Generd Setting  Display I
—Option
File: Expansion Mernu
Autornatic refrezhldutomatic snapshot]

ar Cancel

¢ File extension menu: Extends the File menu of Vision Manager. For details,
refer to Chapter 9 “9.1.5 Menu List” in this manual.

¢ Auto Update: When you connect the Vision Manager to the Robot Controller
(by selecting Connect from the Actions menu), the Vision Manager obtains
information in the same way as you select Get Info from the Actions menu.
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9.4.2 Edit Macro Name

Edit window and search model macro names and usage. A Macro definition file
is created from the input macro name, which can be used in the program.

Only single-byte characters can be used for macro names, as shown below.
Using any other characters than these, the macro definition file will be created
but it cannot be used in the program.

Characters that can be used for macro name

Single-byte alphabetic
character

AtoZ, atoz

(The upper and lower cases are treated with the
same.)

Single byte numerical
character

0to9

Single-byte katakana

Single-byte underline

Options

Edit Macro M ame
Edit \indow

Edit Search kModel
Calibration

Image Analyzis

b

@ Click on TOOL in the menu bar.
The TOOL menu appears.

@ Click on Edit Macro Name.
The Edit Macro Name window appears.

® Double-click on cell (A) to be edited.
Characters already entered in the cell are
displayed in reverse video. If the cell has no
characters, the cursor appears.

@ Input character.
Input characters will then be input (inserted)
in the position in the reversed character.

e Y | © Click on OK to register the changed

Window Search Madel |

contents. Click on Cancel to invalidate the
changed contents.

Mo |Usage |Macm
0
1
Z
inclow | Search Model |
Mo [Usage |Mﬁ|:rn
I
1
2
= 3
4
5
B
? -
Cancel |
Window edit
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9.4.3 Edit Window

To edit the Robot Controller window settings, it is necessary to get the Robot
Controller information on the personal computer, in advance. For the method of
getting information, refer to Chapter 9 “9.3.1 Connect” and “9.3.2 Get Info” in
this manual.

9.4.3.1 Window Editing Tool

Edit the window (register, delete, etc.).

Window edit tool Displays an edit object window.

Edit Wwindow =]
Object Window: . . .
[windcw1 = M_Dlsplays previously displayed tool.
Eroperty o i Creates a new window.
Parameter | Walus . i .
W origin M_Deletes an edit object window.
Torigh__ | Regsl—|——Registers the edit object window.
Square - wicht

Square - heig 27

&l_lnputs camera images.
Square -angl .
Square - mod M—Dlsplays the camera screen.

Displays edit object window information.

- Window -

The uVision board sets the image processing range
window area. The window size is stored on the
uVision board by window number. There are two
’ methods of editing the window; Vision Manager

method and user program method. Window
information edited by a user program is temporarily
registered. It will be deleted upon turning off the
power. Use care when using this method.

r

Object of Window
measurement

\- J
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9.4.3.2

New

When newly registering a window, click on New. The Create Window appears
in the window edit tool. To validate this window, you must register the window.

Window edit tool

Edit \Window o
Ohject Window: —
[\windowl [ _ Beck |
— =
Paramestar | Walus c
e _ Dol |
Y arigin 4|
Sequare - wicht Register
Sguare - heig 271 Input
Square -angl | |
Square - mod Camn Imange |

- Create Window

Silindowe Mo: |1 ill

Shape: |Rectangle j\\ A

@ Click & in the tool bar.
The Window edit tool appears.

@ Click New.
The Create Window dialog box appears.

® Set a window number.
(By default, an unused window number is
automatically set.)

@ Set the window shape (B).
The example screen shows “Rectangle”.

® Click OK.
The default shape (rectangle) is displayed as the
set value (C).
The window shape is displayed on the teaching
panel.
If the Vision Manager is connected to the
Controller, the window shape is displayed on the
Vision Monitor.
To change the shape, refer to Chapter 9 “9.4.3.3
“Modify Windows” in this manual.

® Click Register.
The set value (C) of the window edit tool is
registered in the window.
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9.4.3.3 Modify Windows

Edit the edit object window with the teaching panel. To validate the window
after editing, you must register the window.

(1) Edit with the teaching panel

Window edit tool A

E dit “Window

Dhject Window:
[winciowt = _ P |

o CRew
Farametsr  |Valus
= arigin Delste
Y ongin .
Sguare - width ﬂl
Sguare - heigy Input
Souare -
Square - Carnlmage

Teaching panel

€. C-\Program Files\wincaps?\IRA-00007\RA-0000. . [ HE E

File Actons Took Help

&= = 8| & ]| %]e0] @
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@ Click on ﬁ in the tool bar.
The window edit tool appears.

@ Select window (A) as the object to be changed.
The window shape in the edit object appears on the
teaching panel.
If connected, the window shape appears on the Vision
Monitor.

® If the window shape requires changing to some other
shape, click on the shape change button (C).
Shape after change appears on the set value (B).
The specified shape window appears on the teaching
panel. If connected, the window shape appears on the
Vision Monitor.

@ Drag the window displayed on the teaching panel with the
mouse to adjust the window shape.
When the shape is changed, the new value appears as
the window edit tool set value (B).

® Click on Register in the window edit tool.
The set value (B) in the window edit tool is then registered
to the window.
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(2) Edit by numerical value input

Window edit tool @ Click on & in the tool bar.
The window edit tool appears.

Edi. Window @ Select a window (A) to be edited.

Qbjad! Vindow: ® Double-click on the cell (B) to change the set value.
:f'“dz‘;ﬂ- Cell characters are displayed in reverse video.

Erope

A ® When you enter a value, it replaces (or is inserted into) the
reversed value.
® Click on Register in the window edit tool.
B The set value (B) in the window edit tool is registered to the

nput | window.
Cam Image |

Parameter |WValue
Xorgin

Delete |

eister

Y ongin
Sgjuare - wicht 291
Sguare - heig 271
Sguare - ang|
Souare - mod

(3) Teaching window by key operation
Using the teaching panel, the window shape can be fine-adjusted by
carrying out the following key operations while editing the window shape.

Window type lllustration Teaching method
Name
End point X Start Point Shift Left/Right [—][«]
@ | wNoDPT | & : P Y Start Point Shift Up/Down [1][]]
S art point X End Point Shift Left/Right [W][S]
g Y End Point Shift Up/Down [H][L]
':;_;_ X Start Point Shift Left/Right [—][«]
3 | WNDALN O\L Y Start Point Up/Down [T][!]
Start point P Length Extend/Reduce [W][S]
Angle Increase/Decrease [B][C]
z Startpoint  \igth X Start Point Shift Left/Right [—][<]
Q ) Y Start Point Shift Up/Down [T][{]
§ WNDRCT ] eight | width Increase/Decrease [W][S]
> Height Increase/Decrease [H][L]
- r: Radius
o X Center Shift Left/Right [—>][«]
CBD WNDCIR Y Center Shift Up/Down [T][l]
& Radius Increase/Decrease [W][S]
Tm YR rnegw | X Center Shift LeftRight [][«]
§’§ WNDELP | Y Center Shift Up/Down [T][l]
DO Width Increase/Decrease [W][S]
5 Height Increase/Decrease [H][L]
A:  Outside Diameter
r:  Inside Diameter
01: Starting Angle
62: Ending Angle
o X Center Shift Left/Right [—>][«]
5 Y Center Shift Up/Down [T][l]
g_) WNDSCT Inside Diameter Increase/Decrease [W][S]
3 R Outside Diameter Increase/Decrease [H][L]
2 Circutar Arc 14 Starting Angle Increase/Decrease [B][C]
Ending Angle Increase/Decrease [M][N]
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9.4.3.4 Delete Window

Delete a window selected for editing.

Window edit tool ® Click on ﬁ in the tool bar.
The window edit tool appears.
@ Select the window to be deleted in the cell (A).

E dit !iE:an::h hodel ® CI|Ck on Delete

Cibject odel: . .

Modier —___ aeek | The selected window is deleted.
Property: A

Farametel|Walue

sp.
Width Mew |
_ e |

Height 108
Fieference il Delete

Refarence 1] .
- Eenjster |
hodel size 18708
Remaining 8924672 Input |
Cam Image |

9.4.3.5 Register Window

Register a window selected for editing.

Window edit tool O Click on ﬁ in the tool bar.
et 5 The window edit tool appears.
Object Model @ Select the window to be registered in the cell (A).
[E * Back

® Edit the window set values (B).

A @ Click on Register.
ey | The windows set value (B) is registered to the window.

Froperty:
Pararmete|Yalue
Whficlth

todel T

Height
Fiaference Delete |
Reference

Model size 18708

Remaining| 924672 Infaut |
Cam Image |
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9.4.3.6 Editing Windows with Teaching Panel

(1) Window size change and shift
To change the window size or shift the window, click on Change-shaft %
in the shape edit tool bar.

Size change

Handle

To change the size,
drag the handle

Shift

To shift, drag the
outer shape

D

(2) Window rotation
To rotate, click on (& (Rotate) in the shape edit tool bar.

Rotate

Handle

-

To rotate, drag the
handle
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9.4.3.7 Projection Window

For window shape parts (rectangle and sector), it is necessary to set the mode.
The mode is a parameter for specifying the window projection shape. It is quite
important when measuring the edge. For measuring shapes, other than the
edge, it is necessary to set the mode = 2 (all projection). When a window is
newly created or a window shape is changed, it is set to mode = 2.

Set the mode parameter according to the purpose.

(1) Rectangle window

Mode = 0 (X-axis Mode = 1 (Y-axis Mode = 2 (total)
projection) projection)
Origin Q
Height
Width (No projection)

(2) Sector window
Mode = 0 (projection in Mode = 1 (projection in Mode = 2 (total)
meridian direction) perimeter direction)

(No projection)
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9.4.4 Edit Search Model

To edit a search model in the Robot Controller, it is necessary to get the Robot
Controller information on the personal computer, in advance. For the method of
getting information, refer to Chapter 9 “9.3.2 Get Info” in this manual.

9.4.4.1 Search Model Edit Tool

Edit (register, delete, etc.) the search model. Editing of a search model is
possible only when the Vision Manager is connected to the Robot Controller
with a built-in vision board.

Search model edit tool
Displays an edit object search model.

Edit Search Model
Object Model:
IM;‘ZEITD = j Back j__ Displays the previously displayed tool.
Eroperty: b adel Dis :I__ Displays the search model images to vision monitor.
Faramete)|Valua
Whfidlth [ :l__ Newly creates a search model.
Height o
Sy —— Delete :I__ Deletes an edit object search model.
Fieferance Eegieter :I__ Registers the edit object search model.
hModel size 1
Fermainine Input :l——lnputs the camera images.
Cam Imags__l__ Displays the camera images.

Displays the edit object search model information.

Note: If the Robot Controller is not capable of angle measurement, you
cannot set any data at Offset Angle.
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9.4.4.2

9-34

Search Model Reference
Display the search model image registered to the vision board on the Vision

Monitor.
Search model edit tool A ® Click on & in the tool bar.
T —— The Edit Search Model window
dit Search Model
Ohbject Model: appears.
Modell: @ Select a search model to be
Property: referenced in the cell (A).
Sy— Model Disp ® Click on Model Disp.
Width New The search model image appears
Height on the Vision Monitor.

Fieferance % Delzis

Feference
Offset angle
Model size

Eeqister

Input

Cam Image

Bl

Display to the vision monitor

Search model image

\ Reference position

Monitor display frame



9.4.4.3

New
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Use the New command to register a search model. When the search model is
newly created, the search model edit tool shows the range of images to be
registered to the vision board. To register the search model image to the vision
board, a registration process is required.

Search model edit tool
Edit Search Model

Object Model:

[Modelo:
Property:

Pararmeter |“alue

tadel Dizp

‘Width Hi

Height 100

Reference X 50 Dl

Feference ' 50 A
Eisie

Offset angle 0

Model size 28144 Input

Cam Image

L

- Create Model

el M |z :Il

oK \i\ Cancel |

Teaching panel

# C:\Program Files\wincaps2\IRA-0000MBA-0000... 9IS B3

Fille Actionz Tool: Help

[ 2| o] A=

B2 %)%

Display/Frocess | Object/Process

@ Click on & in the tool bar.
The search model edit tool appears.

@ Click on New.
The Create model dialog box
appears.

® Set the search model number (A).
(By default, an unused search model
number is automatically set.)

@ Click on OK.
Default search model data appears
as the set values (B).
The search model shape appears on
the teaching panel.
The shape also appears on the
vision monitor if the Vision Manager
is connected with the Robot
Controller.

® Drag the search model shape
displayed on the teaching model
with the mouse to adjust it.
When the shape is changed, the
value appears as the search model
edit tool set value (B).
When changing the shape, refer to
Chapter 9 “9.4.4.5 Editing Search
Model with Teaching Panel” in this
manual.

® Click on Register.
Register the image, in the range
specified with set value (B), in the
search model edit tool, to the vision
board.
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9.4.4.4 Delete Search Model

Delete the edit object search model.

Search model edit tool @ Click on & in the tool bar.
The Edit Search Model window
appears.

@ Select the search model to be
deleted in the cell (A).

_ ModelDisp | ® Click on Delete.
New The selected search model is
| deleted.
Delete
Reference v :
B
Offset angle Lﬂml
Model size 28144 Input |
Cam Image |

i\

Edit Search Maodel
Ohject Model:

hModel:

Property: \
Parameter  [“alue
Witth 100
Height 100

Reference X
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9.4.4.5 Editing Search Model with Teaching Panel

(1) Changing size and moving the search model

Change size Move

To move the search
model, drag the
frame.

To change the size,
drag the handle.

Handle (/\\%

(2) Changing the offset position

Change the offset position

To change the offset
position, drag the
cross.

(3) Changing the offset angle

Change the offset angle
O

To change the offset
angle, drag the long
bar of the cross.

(4) Search Model Teaching by Key Operation
When editing the search Model shape with the teaching panel, the search
Model shape can be fine adjusted with the following key operation:

Width

Start point X Start Point Left/Right [«]1[-=]
Y Start Point Up/Down M

© Width Increase/Decrease [WIIS]
) Height Increase/Decrease [HI[L]
Reference point X Offset Left/Right BI[C]

| Height v Offset Up/Down [MIIN]

| Offset Angle Increase/ Decrease [ |][D]
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9.4.5 Calibration

9.4.5.1 Camera Calibration Tool

Camera calibration tool Specifies the object (white/black) to be measured.

A

Displays the binary coded level used for
measuring the center of gravity.

Specifies where the point is registered.

Camera Calibration

~Calibration Data

Registration |PW
~Wision Paint

EditNa. |1 - || Eﬁek—'— Returns to the previously screen.
Bmﬂ%tie%ﬁ Sl | ggiigma{— Displays Binary Processing Registration Tool
Coordinate: : { Lower[128 | Curgar | Calibrat Executes calibration.
“\iﬁ;?onx _— u;“: Higher %5 ] SE‘W*"M In Obtains camera image.
Ej:f;: g ceost | Measu{e\l\ Can Displays camera screen
Fghoty 0 . Pugfaot Paint
0

arighle P Mo II] j

\ Displays the cross cursor.
€« Ge!>|
—] Sets Window.

il Measures the center of gravity in the Window.

2] Specifies the P variable number to be obtained.

k.

\ Obtains the Robot Variables.
Obtains the vision coordinates.

Lists the coordinates (for editing and display of teaching point).

Displays the calibration conversion coefficient.

9.4.5.2 Camera Calibration Procedure

The camera calibration tool calculates the coordinate conversion coefficients
from the robot coordinate values, corresponding to the coordinate values of the
three points of vision.

The camera calibration tool manages 32 different sets of camera calibration
data (edit No. 0 to 31) and calculates the coordinate conversion coefficients,
according to the procedure described later. The vision coordinates, robot
coordinates, and coordinate conversion coefficients are registered with the
calibration number specified in the edit number (A).

Camera calibration is as follows:

Positioning at 3 places

.

Specifying calibration No. In the Edit No. grid (A)

.

Refer to “9.4.5.3 Entering Vision

Entering vision coordinates Coordinates”

.

Refer to “9.4.5.4 Entering Robot

Entering robot coordinates Coordinates”.

.

, ; , Refer to “9.4.5.5 Executing Camera
Calculating coordinate conversion Calibration”
coefficients afibration.
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9.4.5.3 Entering Vision Coordinates

There are the following three methods for entering vision coordinates:

(1) Numerical Input Method

(2) Cursor Input Method. This method is a method of marking while
checking the images on the vision monitor screen (cursor)

(3) Measurement Input Method. This method uses the center of gravity
data, in the image, as the input value by using the image analysis
function

The following are the procedures of the above methods.

The points refer to the three points for calibration. Coordinates in the three
points, of the vision and the robot coordinates, can be correlated with each
other by point number.

(1) Input of numerals

|F/ A ® Double-click on cell (A) to input the vision

Itern Foint 1 X coordinates.

Yislions f ’ﬂ B The cursor appears in the cell.

Vision Y /g/ @ After entering the numeral, it is input
(inserted) to the cursor position.

Robote 0 ® Pressing the Enter key registers the

Fobat 0 numeral.

Fobot 2 L @ Input the vision coordinates in cell (B) for

the vision Y coordinates, using the same
> steps as above.

I e F ® Click on (C) in the scroll bar.

t?m ol The 2 point cells appear.

Wision < 0 ® Hereafter, input the vision coordinates (X,
Wision ™ 0 Y) for points 2 and 3, using the same
Rohot 0 steps as above.

Fobot™ 0

Fobot £ 0

=

9-39



(2) Cursor input

You can enter the vision coordinates while observing the camera images
using the cross cursor.

I

Eegistration  |Foint 1 -|
—%ision Faoint \
Ohject: © White @ Black
Binary Level
LDwer: Cursar :I.\
Higher:[255 || setwindow |
<< Get | heasure |

Cc

Cross cursor

/

List of coordinates

O Enter the camera images to the
processing screen.
@ Display the processing screen with the
camera image on the vision monitor.
® Select Point 1 at Registration (A) where
the coordinates are to be entered.
@ Click on Cursor.
The cross cursor appears on the teaching
panel and on the vision monitor.
® Move the cross cursor by dragging or key
operation. Set the cursor to the target
coordinates.
® Click on Get (C).
The cross cursor coordinates are entered
in the vision coordinates of Point 1 set at
Registration (A) (and displayed in the
coordinate list).
@ Enter the coordinates of Points 2 and 3 in
the same procedure.

Key operation of

Cross cursor

( ¢ \ [term Faint 1 |F
YWision = I}
Vision 7 0 h[fT] [—] Cross cursor
shi
EDEDti g left/right
. . ol [T] [l] Cross cursor shift
Fobot 2 1] un/down
p

Vision monitor H.
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(3) Measurement input
Center of gravity can be obtained from the camera image, through image
analysis, and entered as the vision coordinates.

Beqgistration |Pnin11

"I

O Enter the camera images to the

- vision Fain processing screen.
B — Bmaomfefe‘ Cowhite = Blask SN A @ Display the processing screen with the
r}inwer‘l'lgﬁ—| cusor | camera image on the vision monitor.
o ‘ . ® Select Point 1 at Registration (A) where
i Setwindoy | the coordinates are to be entered.
<4 Get | Measure | ™~ Cc @ Set object (B)
b ® Click on Set Window.
A window appears on the teaching panel.
A window appears on the vision monitor.
® Shift or adjust the window position by
dragging or key operation.
@ Click on Measure.
The Vision Manager measures the center
of gravity in the window and displays its
position on the vision monitor.
Click on Get (E).
Measured center of gravity coordinates
are entered in the vision coordinates of
Point 1 set at Registration (A) (and
displayed in the coordinate list).
® Enter the coordinates of Points 2 and 3 in
the same procedure.
/W'ndow List of coordinates Window teaching
y ftermn Paint 1 |F by key operation
almn e 0. |[€][>] Window shift left-right
;’SLD::; E [N [¥]  Window shift up-down
Ee S Window width increase-
© o Rabot™ u WITS] decrease
Robot 2 u [H] L] Window height increase-
decrease
Vision monito\ H

Center of gravity
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9.4.5.4 Entering Robot Coordinates

Input the robot coordinates with either of the following two methods:

(1) Input numerals directly

(2) Use the coordinates stored in the P variables of the robot, as the input
values.
The following are the procedures of the above methods.

Note: Always input the robot coordinates at a position corresponding
with the input point number of the vision coordinates.

(1) Numeral input

[tern Foint 1 F
Visianx | 0
“Wigion Y n
Fohot % ——A
Fabat ™ ——B
Robot 2 —f—C

- p—

[term

Fuaint 2

I5

Yision =

Yision

Fobhot X

Fobot™

Fohot £
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® Double-click on the cell (A) of the robot X
coordinates.
The cursor appears in the cell.

@ When entered, a value is inserted at the
cursor position.

® Press the Enter key to register the entered
value.

@ Enter the robot Y coordinates (B) and robot Z
coordinates in the same procedure.

® Click on the scroll bar (D).
The Point 2 cell appears.

® Enter the robot coordinates (X, Y, and Z) of
Points 2 and 3 in the same procedure.




(2) Variable input
Coordinates stored by the P variables of a robot can be used as the input
values.

Begistration |PDinH

vl

—%ision Point
Dhject  © White & Black
Binary Lewel
Luwer: Cursar |
Higher P55 ]| Setwindow |
<< Get |
—Robot Foint

“Yariahla P Mo, |u

<< Get \l

kMeasure |
=i
=

C
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O Select Point 1 at Registration (A) where the
coordinates are entered.

@ Specify the P variable number where the
point coordinates are stored at Variable P No.
(B).

® Click on Get (C).

The robot variable coordinates are entered in
the robot coordinates of Point 1 set at
Registration (A) (and displayed in the
coordinate list).

@ Enter the robot coordinates (X, Y, and Z) of
Points 2 and 3 in the same procedure.

Coordinate List

[term Foint 1 F
Yisionxd 0
YWision v 0
Rokbiot = 0
Fohot v 0
Rohot £ 0

o —

Note: When entering variables, connect the Variable Manager to the
Robot Controller. The personal computer can get the robot
variables via the Variable Manager. If the Manager is not
connected, the computer cannot get the current robot position.
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9.4.5.5 Executing Camera Calibration

When you execute camera calibration, the Vision Manager calculates the
coordinate conversion coefficients from the entered vision coordinates and the
robot coordinates. Then, the Manager stores the calculation results in the file
specified on the personal computer. To register the calibration data to the
Controller, you need to transmit the data to the Controller from the personal
computer.

When the calibration data is transmitted to the Controller, only the coordinate
conversion coefficients are registered to the Controller. You can convert the
vision coordinates of user program into robot coordinates using the coordinate
conversion library.

The coordinate conversion library converts the coordinates using the
coordinate conversion coefficients registered in the Controller.

) I_IIIII_A.I_y LEws|
Coordinate: | Lower[128 | G |
ltern Faint1 F
i <1255 p
ision 730 ﬂlgher. SetWindaw |
Sision 2e4.0714 A
<< Get heasure
Fobat % EE5 5565 | | 4|Cﬂm Image
Fobot* -2.04934 —Robot Point
Robot 2 105 Vatisiole PNo. [0 =

|!| ‘ >| << Get |

Fi= 3519625 R =-213.3665 R =105

O = 9226306 0% = 1.368364E-02.02=10
\

A,

@ Click on Calibration (A).
Coordinate conversion coefficients are calculated and displayed in B.
The coordinate conversion coefficients are saved in a set file on the
personal computer.

@ Transmit the calibration data to the Robot Controller from the personal
computer.
For the transmit method, refer to Chapter 9 “9.2.5 Transfer” in this manual.
When calibration data is transmitted, all the data is transmitted in a batch.
When executing calibration at several points, execute calibration of all the
points, and then transmit the data to the Robot Controller.

[« [+

Notes @: If the error message “Improper coordinate data” appear
during calibration, check the coordinates of all the points and
enter them again.

@: If you change the coordinates, always press the calibration
button to recalculate the coordinate conversion coefficients.
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9.4.6 Image Analysis
9.4.6.1 Image Analysis Tool in General

[1] Common Button Functions

Buttons shared by each tool are arranged in the image analysis tool. The
shared buttons include Input and Cam Image.

Click on Input, and the Vision Manager enters the camera images to the
processing screen under the condition set using the camera input tool. The
Manager displays the obtained image data of the processing screen on the
vision monitor. The same result can be achieved by clicking on Input in the
camera input tool.

Click on Cam Image to display the image of the camera number set in the
camera input tool on the vision monitor.

G g R | =T Camera input tool
‘\t/?;mx — 232‘F Higher 5% _] SElw‘”d“"‘/l Input InF'Ut Input Camera
Yision " 2240714 << Get | T — | EmhEE
EEESEC fgsﬂilggz‘\s ~RobotPoint———————————————— Cam Image Camara ND,iICﬁmBrﬁ1 j : BaCk'
Fiabiat 2 105 VaablePNo. [0 = LnDkUp"Wﬁ Inout I
H = npw
> << Get
P{= 3519625 R =-218.36085 RZ =105 = * \
Ox=.9225305 0% =1.368364E-02.02 = 0 H
Input Screen:|Process 0
; Ly
\
\
[2] Object of Image Analysis Camera number
Main window The image analysis tool analyzes the image data stored
DT R TR T T on the processing screen. At this time, the analysis tool
= N I R Y measures the processing screen indicated at the status of
. the main window. By entering camera images with the
El camera input tool (Input), the processing screen to which
a image data is entered is selected as an object to be
= processed. When the processing screen appears with the
= Stat image display tool, the displayed processing screen
& - otatus becomes the object for processing.
[Disp | Camt (_[ObilPd [ )

[3] Process Time

The image analysis tool displays the processing time required for
measurement in terms of milliseconds. However, since the minimum intervals
of measurement for processing time is 10 (milliseconds), time under 10
(milliseconds) cannot be correctly displayed. For example, if actual processing
time is 35 milliseconds, the image analysis tool displays the time as 30
(milliseconds). Moreover, if the processing time displayed on the image
analysis tool reads 0 (millisecond), the actual processing time would be 0 to 10
(milliseconds) or less.

[4] Measuring Result

To display the measurement data, bring focus to an object in the list of
measurement result of each window.

Note: When you execute image analysis, the screen mode (such as character size)
of the uVision board changes. Therefore, when you run a user program after
image analysis, you may obtain unexpected results. In this case, make
corrections by setting the necessary points in the user program.
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9.4.6.2 Camera Input

[1] Camera Input Tool

This tool inputs images from the camera to the processing screen.
Camera input tool

%]  Selects the camera of which image is taken.

Camera ND.:ICamera1 =] L Beck— Displays the previously displayed tool.
Loak Up:l'll]ﬂ%([l) ] \nput—l— Inputs camera images to the processing screen.

!ﬂpmscmen:W Specifies the lookup table used for input.

Specifies the processing screen where camera images are stored.

[2] Input Video Image

Input Camera

7 @ Click on M in the tool bar.
CRRSIEINGH) oo | [ | The camera input tool appears.
Loak Up:| 100%(0) \ b nput | @ Select the camera number (A) from which image data
is taken.
/'-" \ ® Select the look up table used for display in the cell (B).
/ ﬁ @ Select the input screen (C) to store the camera images
Input Scrgen: |Frocess 0 on.
/ \\ \ 5 ® Click on INPUT.
The camera images are input to the processing
/ NN
A C B
4 - Pixel - N\ ( h

- Brightness -
Each pixel of image data processed by
the uVision board has a value (0 to 255)
that represents brightness (in 256
steps). This value is called brightness.
As the number gets close to “0”, the
pixel becomes darker. As it gets closer
to 255, the pixel becomes brighter.

The pVision board internally handles image data as a
group of individual points, one of which is called pixel.

The pVision board handles 512 x 480 pixels (lengthwise x
widthwise) in the storage memory (processing screen),
and 624 x 480 pixels (lengthwise x widthwise) in the
dedicated drawing memory (drawing screen).

512 624
N 4 N
Process result 255
480 EX 480 e © <: ﬁ
0
‘Processing screen Drawing screen ‘Processing screen
N\ J L Y,
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9.4.6.3 Selecting Display Screen

[1] Display Screen Tool

Select a screen (camera, processing screen and drawing screen) to be display
on the vision monitor.

Display screen tool

Displap Screen Selects the drawing screen to display.
 Ciranwing ) . .
Qisplalerang ] j Displays the previously displayed tool.

~Camera and Frocessing

%I— Selects the vision monitor display for a specified screen.
Digplaleamera1 : "l
Look Us70% 1) = Selects the camera screen or processing screen to display.

Selects the lookup table used for display.

[2] Selecting Vision Monitor Display

Display screen tool ® Click on Eﬁ| in the tool bar.

The display screen tool appears.

D ng @ Select the drawing screen as the screen to be displayed
Displayy] Cramings 1 = on the display screen (A).

. ® Select the camera screen or processing screen to displa
[ Camera enc Progrssing __ Breoito | with the display screen (B) P k P
Displas] Cafreral \ - )

@ Select the lookup (C) table used for display.

/ N\

® Click on Execute.
Look Upr?ﬂ% (1 \ -\ Select the vision monitor display for a specific screen.

/ AN

/ NN

A C B

Note: After image analysis, the Vision Manager automatically changes
the display screen setting (A) on the display screen tool so that
drawing screen 1 will appear, where measurement result is drawn.
If the current setting is Drawing 0, the setting will be changed to
Drawing 0+1 after image analysis.
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9.4.6.4 Binary-coded Registration

[1] Binary-coded Registration Tool

Register the binary-coded level with the image analysis tool.

The detection method for the binary-coded level includes manual and
automatic methods (mode method, discriminant analysis method and P tile
method). Optimal condition can be verified by using the binary-coded register
tool.

Binary-coded register tool Selects a window that specifies the range of processing.

Binary Pre stration
- Detect Binary Processing Level

Selects the select mode for binary-coded level.

Histo Process Range: Back Displays the previously displayed tool.
rind owl: - - . . .

el [ M Changes the vision monitor display to the normal display.

Detection Method w'_ Changes the vision monitor display to binary-coded display.

Detection kode . . .

[Ftle hethod [ ﬂ'— Binary-codes the currently displayed processing screen.
inany Procassing Lavel B A " M_ Detects the binary-coded level if detection mode is set to auto.
Higher ————— £5 I‘IUUD = . .

{'g = ] \ = | | tisg=mt— Displays a histogram.
L ower I&. e .

Ol e ®ERe: ___mpu_—}— Inputs camera images.

/ \\ ml_ Displays the camera screen.
NN

Specifies the reference area to be used by P tile method.
Specifies the measuring object of an area to be used by P tile method.

Specifies binary-coded Specifies binary-coded level.
level manually.

Displays the histogram.

Image data input from the camera to the
uVision board has 256 gradations of
brightness per pixel.
Binary-coding refers to rewriting the
brightness of each pixel into white or
black, based on a threshold borderline
_ value. Such threshold value is called the
Eiif;rﬁf:ég% binary-coded level. The pVision board
specifies the binary-coded level with two
@ binary limits, the lower and upper limits.
Values greater than the lower binary limit
and to the upper binary limit are binary-
coded as white (1) and other values as
black (0).

- Binary-coding -

After being
binary-coded

- J

Note: Only the oblong window can be selected for processing (angle = 0).
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4 )

- Histogram -

Here, histogram refers to the counting of the frequency of appearance of
brightness values, for a range specified by the window of the image data
input from the camera. When graphically displayed, the histogram provides
ease of understanding the distribution state of brightness, which makes it
easier to determine the binary-coded level, when image data is being
binary-coded. Moreover, the uVision board provides a function for
automatically determining the binary-coded level. This function determines
the binary-coded level by using the histogram.

Figure 1 shows the histogram of image data before it is binary-coded,
showing that the object and background are separated into two portions.
Figure 2 shows the result of binary-coding, on the different binary-coded
level, the lower limit (lower limit of binary) and the upper limit (upper limit of
binary) are adjusted to produce different binary-coding results.

Fig. 1 Fig. 2
0 Brightness 2>55 Lower Upper Lower Upper
o,
)
Obfct __ JBack- L L
ground
efore binary er binary After binary coding
coding coding
\_ J
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[2] Binary-coded Level Registration

(1) Manual

Binary process registration tool

Binany Process Registration
~Detect Binary Processing Level
Histograrm

[=]
Frocess Range: Back
i clonr 'i
Mormal
Einary Data,

Execute

Detection tethod
Detection Mode:

[Detectlavs]

Feference Arga:

Ll

Higher. —J
Lawer J Object &W/iite. € 5/R)

’—Enary Frocessing Level

—Binary Processing Lewvel

Hiciher —J
Laonwer / J \\
/ \
C D
(2) Automatic

Binary process registration tool

gistrabion
Frocessing Level

in:
~D
Histograrm

[=]
Frocess Range: Back
‘hinclonrll 'I
Mormal
Binary Data
Execute

Detect Level

Histogram

Detection Method

Detection Mode:
P-ile Method

Reference Area:

J I =
f— ou,m.f?ﬂhk\f“ B

\\ \\

NN\ N

D C B A

Binary Processing Level

Higher.

Lower.
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o Click on M in the tool bar.
The binary process registration tool appears.

@ Select a window for measuring the histogram with
process range (A).

® Set the detection mode (B) to Manual.

@ Click on Histogram.
The histogram appears.

® Drag the slider (C) and set the lower limit of binary-
coding level.

® Drag the slider (D) and set the upper limit of binary-
coding level.
Sliders (C and D) can be dragged (changed) only
when the detection mode (B) is set to Manual.

@ Click on €] in the tool bar.
The binary -coded register tool appears.

@ Select a window for measuring the histogram with
the process range (A).

® Set the detection mode (B) to automatic mode
(mode method, discriminant analysis method, and P
tile method). If you are using a method other than
the P tile method of detection, this is the end of the
procedure.

@ Specify the reference area (C) used for the P tile
method.

® Specify the object (D) of the area to measure with
the P tile method.
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[3] Selecting Display

The binary-coded register tool can display the camera screen and the process
screen currently displayed on the vision monitor in a binary-coded format.
In binary-coded display, it is possible to check the binary-coded results without
having the actual data binary-coded.

Binary process registration tool

inarp Process Fegistration
-~ Detect Binary Processing Lewvel

Histogram Process Bange:

[<]
|

Back

‘Windomwi: j

Detection Methad

Detection Mode
Manual

Naorral
Binary Data
Execute

Hziiziei L)

ReierenceXea
M =
é 126 Object: F19UHRER ETHIEES

Higher:

’—Bnary Frocessing Lewel

Lower:

VA

Histogram
Input
Cam Image

‘s \¢ \A

@ Click on @ in the tool bar.
The binary process registration tool appears.

@ Click on Binary Data.
The Vision Monitor display changes to binary code.
Set detection mode (A) to Manual and change the
binary-coded level by dragging sliders (B and C).
Then the display of vision monitor is updated with
the binary-coded level after the change.

® Click on
normal display.

Normal. The vision monitor returns to

e N
- Result of display selection -
Normal display Binary-coded display
\. J
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[4] Binary Process Registration Screen

Converts the specified range of the currently displayed processing screen to
the binary codes.

Binary process registration tool

Binary
~Detect Binary Processing Level
Histograrm

Frocess Range:

‘hinclonrll 'I
Detection Metho

Detection Mode:

Binary Processing Level

Higher.

| =
— [

Lower: Object @1ite CIEIEXE

[=]
Back

Mormal
Binary Data
Execute
Bjziizle AR |
Histogram
Input
Carn Image

[S] Detecting Binary-coded Level

O Display the processing screen to be binary-coded
on the vision monitor by using the monitor display.
@ Click on @ in the tool bar.
The Binary Process Registration window appears.
® Select a window for specifying the binary-coding
range at Process Range (A).
@ Click on Execute.
The specified range of the processing screen is
binary-coded.

e N
- Result of binary-coding -
Before binary After binary
coding coding
N\ J

Automatically detect the binary-coded level of the processing screen currently

on display.

Binary process registration tool

Register Binay Froc

sz
~Detect Binary Processing Level
Histograrm

Frocess Range:
i clonr 'i

Detection method
Detaction

[=]
Back

Mormal
Binary

IManua\

Feference Arga:

!

Binary Frocessing Level
Higher —— ati
Lower —— 2

Lo becute

[Detectlavs]

Histogram
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O Display a processing screen where you want to
detect the binary-coded level using the monitor
display tool.

@ Click on @ in the tool bar.

The Binary Process Registration window appears.
® Select a window for detecting binary-coded level
with processing range (A).

@ Set detection mode (B) to auto (mode method,
discriminant analysis method and P tile method).
For detection mode other than P tile method,
proceed with step after @.

® Specify the reference area (C) to use for the P tile
method.

® Specify the object area (D) to measure with the P
tile method.

@ Click on Detect Level.

The histogram appears.
Displays the detected binary-coded level at (E).
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9.4.6.5 Area, Center of Gravity, and Principal Axis

[1] Area, Center of Gravity and Principal Axis Measuring Tool

Measure the area, center of gravity, and principal axis in a specified window.
Set the binary processing level to use with the image analysis tool using the

binary-coded register tool.

Area, center of gravity and principal axis measuring tool

Auea. Gravity Center. Principal duis Specifies a window for specifying the range of measurement.

~Measuring Conditian

|rBinary Pm}gssing Lewvel

A\ \ \ M Inputs camera images.
Result \ \

T AN Carm Image |_ Displays camera screen.
Processing Time (ms) |\ \
Area

Giranvity Center =
Gravity Centery’
Angle

Integrate Brightness

AN
\ Specifies the object being measured.
Displays binary processing level.

Objeci indawe: [Winciowt, || M Displays the previously displayed tool.
Ieasuring IE-Pr\ncipa\ At =l MI— Displays the window edit tool.
Object & MWhite . ﬁaﬂx

Ediit Binary |— Displays binary-coded register tool.

Lowar 128N\ | Highar [255 \ | . |_ Measures the area, center of gravity and principal axis.
N\ \ \

Displays the result Specifies the object being measured (white/black).

of measurement.

4 N\
- Brightness integration value - Brightness integration value
Window refers to the sum of the
brightness values of every
100l100h00h0o oo pixel, within a range
specified by the window, of
100{100|100{100(100| image data input from the
20 (20 20 (20 [100| Ca@mMera.
20120 (20 |20 [100
20120 (20 |20 [100
Brightness integration = 100x13+20x12=1540
- J
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- Area -

Window

N B

1 (white) area = 13
L 0 (black) area = 12

Area refers to the counting of white (1) or
black (0) pixels in the range specified, by
the window, after binary-coding the
image data is input from the camera.
The result is the number of pixels. With
the uVision board, the area is measured
by binary-coding the brightness of every
pixel in the window in real time without
changing it, so it is not necessary to
binary-code image data in advance.

- Center of gravity -

X
Window

/
Object \ |
Center of gravity

The object from the image data input from
the camera forms a plane. The center of
gravity refers to the point at which the
weight of an object on the plane would
remain in equilibrium.

The pVision board obtains the center of
gravity from white(1) or black (0) pixels
within the range specified by the window
after image data is binary-coded. The
center of gravity is expressed with X
coordinates and Y coordinates.

.

- Principal axis angle -

Major

axis
Minor
axis

X

0

e \
Window Object

The object from the image data input from the
camera forms a plane. When this planar
object is rotated, the longitudinal axis around
which the object rotates best is called the
major axis of the principal axis and the axis
that intersects it orthogonally is called the
minor axis. The uVision board defines the
angle (theta) from the horizontal axis (X-axis)
to the major axis of the principal axis as the
angle (0) of principal axis. The angle of
principal axis is obtained in from white (1) or
black (0), object in a range specified by the
window after the image data is binary-coded.
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[2] Measuring Area, Center of Gravity and Principal Axis

Area, center of gravity, and ® Click on &/ in the tool bar.

principal axis measuring tool The Area, Gravity Center, Principal Axis
measuring window appears.
The window shape appears on the teaching

e —— panel and the vision monitor.
Object Windas: [vmcewn ] Bk | A @ Select object window_ (A). .
o g The_range of the specified window shall be the
— Editwindn| B object of measurement.
Bmaggiﬂ;ﬁ; ate ¢ Hesk Ecit Binary | ® Select measurement mode (B).
( Lower 13 \| Higher [255 | Execute | Select the object of measurement from Area,
-- | Center of gravity and Principal axis.
Pugsul \ %ﬁ @ Select object (C).
‘;;nsessm s N\esults - Caim(gjeee Select object for binary-coded measurement
7 . from White and Black.
Grawity Center % 24m0162 ® Click on Execute.
iy oo 2380152 The processing screen, of the current object
e R being processed is measured, and the results
- ==X are displayed in the measuring results (D) list.
The vision monitor displays the result of
\ \ processing.
D cC

- Result of measurement -
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9.4.6.6

Labeling

[1] Labeling Measuring Tool

Measure the labeling in a specified window.
Set the binary-coded level to be used with the image analysis tool using the
binary-coded register tool.

Labeling measurement tool Specifies the window used to specify the range of measurement

With.

~Measuring Condition . . .
J Displays the previously displayed tool
ijedWmdDWindowﬂ‘ j Ba__l':k
Sort Mudeiw-Area Descend‘,m@kofdej E it Wind Displays the window edit tool.
Area Lower|i = M_ Displays binary-coded register tool.
Object & White " Blad o Measures the labeling.
Binary Pmcéﬁsmg Lensal N
{ Lower. [128 \ | Higher. 55  \] Input Inputs the camera images.
AN \
N\ m lma Displays the camera screen.
Result
[tem General \LLﬂhelﬂ\ ‘Lab =
Processing T 260
Label Mumhe 48
Area Rye278
Gravity Cente
Grawity Cents = Specifies the display sequence of measurement results (labeling
Mg i LI . .
1 order, descending order of area, ascending order of area)

Grants the labeling order if greater than this area.

4 )\
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\ Displays binary-coded level.
Dlsplays the result Specify the measuring object (white/black)

of measurement

- Labeling -

Labeling refers to the numbering process of the concatenated areas of white (1) or black
(0) pixels after binary-coding image data input from the camera. (Refer to Fig. 1)
Labeling enables you to separately handle multiple objects that are present in the area
specified by the window.

With the uVision board, area, center of gravity, angle of principal axis, fillet shape and
circumferential length are obtained as the characteristics of respective objects upon
running the labeling. The fillet shape refers to an oblong that circumscribes the object.
(See Fig. 2) The circumferential length refers to the counting of pixels that constitute the
external shape of the object. (See Fig. 3)

Fig. 1 Fig. 2 Origin of fillet Fig. 3

| External

‘ = shape
¥m |
| Circumferential
“ Length = 12 pixels

Window Object Width of fillet Height of fillet

Note: Only the oblong window can be selected for processing (angle =
0).
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[2] Measuring Labeling

Labeling measuring tool

~Measuring Condition

ObjemWindUWiWindgwn \

j Back |

SGHMDchAreaDes n ng OrdeJ

Ed\tWiﬂdUWl

Area Lowerin

Qbject rwmé\ A\B&k

Edit Binary |

Lower: [1 ?3 | Hi her |$5

Input |

(Eimary Froc sslng Le .:

\

Fesult /

\
Cam Image |

||_at:\e|u

ltem / General

\La o

¥

~—

F’mcessmé T 260
Fesult

Label Nuhbe \ 4
lterm

General |Labe|D l

Area /
Frocess time (ms)

Grawvity ¢ente
Lakel number

Gravity/Cente
:3 e ‘1.| i

[

D
Area
G-oenter =
G-center ™y’

JT

130 120
7

11201

ZEq.R717

231.0651

09 A4

|
|

® Click on EI in the tool bar.
The labeling measuring tool appears. The window
shape appears on both the teaching panel and the
vision monitor.

@ Select an object window (A).
The object of measurement shall be the range of
the specified window.

® Select the sort mode (B) from Labeling Order, Area
Descending Order, and Area Ascending Order.
Measuring results are displayed in the specified
order.

@ Specify Area Lower Limit (C).
Labels greater than the specified area are
measured. This setting allows you to disregard
minor objects.

® Select Object (D).

Choose an object for binary-coded measurement

between White and Black.

® Click on Execute.
Measures the processing screen currently being the
object of processing. The number of measured
labels is displayed in the Measuring Result List (E).

@ Click on the respective label grids (F) under Result.
Detailed results of the clicked table are displayed in
the table under Result and the vision monitor.

- Measurement result -
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9.4.6.7

Edge

[1] Edge Measuring Tool

Measure the edge in a specified window.
Use projection window (mode =0 or 1).
Read 9.4.3.7 “Projection Window."

Edge measuring tool

~Measuring Conditian E

Ohject Wmdnwiwmdgwa-

[

Qetec‘tioniﬂ—ﬁrightness Absu\\te

[

Edge Objectiz-Whule

Specifies a window to specify the range of measurement with.

MDisplayS the previously displayed tool.
- Displays the window edit tool.
Edlthdle

EdlthlaI,;,_I_Displays binary-coded register tool.

Leve\imﬂl

EiransEiacessng Lewve]

Lower:

(

Seanning Dir & Positive \{ Negat\e

N

Hicher

M_Displays the measuring condition and set screen.

Graph Displays the distribution graph screen.
Executs—|— Measures the edge.

\\

Result

ftems

Gemer}q\ \ | Fasull

\
|Fos

Frocessing T
MNumber of De

*
Y

B

put Inputs the camera image.

Displays the camera screen.

Specifies the edge detection system.
Specifies the object edge to detect (black—white, white—black, all).

\Specifies the level for detecting edge (brightness, area).

Specmes the scanning direction of the edge.

Displays the binary-coded level during area measurement.

Displays the result of measurement.

ssauybug

- Edge -

Absolute
value

E—

1 F

—p Position

In wVision board, edge refers to a point at which an
object in the specified window changes from
darkness to brightness (black to white) or from
brightness to darkness (white to black).

The position of the edge detected by the pVision
board refers to a point at which the brightness in
the window or the area value meets the specified
level value. To specify the level value, an absolute
value or differential value is used depending on the
circumstances of the object. The absolute value
detects the position at which brightness or area
value passes a specified location. The differential
value detects the position at which variation of
brightness or area is greater than the specified
value.

Window

~

dge

Differential
A value

ssaujybug

O Edge detect position

J
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where the edge can be measured (straight line, oblong {mode = 1,
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[2] Measuring Edge

Edge measuring tool

Edge
i Measuring Condition

gbje:twmdowiwmdowa; \

EngOhiBEﬁiEfWhD\E\ \ \

Back

el

EditWWincow

Edit Binary

[ |
Qeied\onlD—Bnghmess Abiulute\ j
[ |
=]
=

Levelhzﬁ
Scannina Dir. & Poditve \ © Negative
|—E\nary Bracessi L

Lowwer

SetScreen

i

Graph

Execute

Result \\ \ ‘\ \\ \ Input
:j;n:aessmgT e 4u“%im\i\q§j Cam Image
Mumber of De m
b \ 1
v 1 =
AV W WA
VLl
F EDC B A

 Click on #2l in the tool bar.
The Edge measuring tool window appears.
The window shape appears on both the teaching
panel and the vision monitor.

@ Select Object Window (A).
The specified window range is to be measured.

® Select Detection System (B) from among
Brightness absolute value, Brightness differential
value, Area absolute value, and Area differential
value.

@ Select Edge Object (C) from Black—White,
White—Black, and Whole.

® Specify Level (D).

® Choose the projection window scanning direction
between Positive and Negative at Scanning Dir (E).

@ Click on Execute.
The Vision Manager measures the currently
selected processing screen and displays the result
in the Result table (F).
The processing results appear on the vision
monitor.

- Measurement result -
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[3] Distribution Graph

The edge measuring tool can display the distribution graph of a measured

window. According to this distribution graph, variation of brightness in the

window and the area can be checked. By linking the distribution graph and the

distribution data display, brightness and area of the graph-specified point can
A be checked with ease.

; Displays distribution graph
O Click on Graph.

- | A distribution brightness graph appears. At this
time, Brightness Distribution Graph appears as

Edit Wmdﬂwl the title (A).
[SmEres |

Brightness Distribution Graph

— The brightness integration and area appear as
SditBinary the distribution data (B).

Set3creen |

= Selection of graphic display

O Click on Integrate Brightness grid (C) of

Listikution Qata : Exccute | Distribution Data (B) or Area grid (D).

E’DJEU'U” bz e Bl e ot | When the Brightness Integration grid is clicked

on, the brightness distribution graph appears.

St e | Conversely, when the Area grid is clicked on, the

area distribution graph appears. The currently

displayed data name (Brightness Distribution

Graph or Area Distribution Graph) appears at the

title (A). At this time, the marker (E) appears at

I

aph |

| = [ | ra [ —

— , B the distribution graph at the position
Projection Brightness Area corresponding to the projection position of the
position c D F clicked grid.
Read the distribution data of a graph-specified
‘ T point
e __Bak | @ Click on the point of distribution data (F) desired
E i o for reference in the distribution graph.
Q The cursor (G) appears at the clicked point in the
Edit Binary | distribution graph.
G Set Serenn | The brightnt_ass integ_rati_on gnd area of the poipt
clicked on in the distribution graph appear in
eyl | Distribution Data (H). At this time, the projection
Distribution Data e | position corresponding to the clicked point is
Projection_|Brightness | Arsa displayed in reverse order.
0 252 ﬂ
; Egi Carm Image |
3 4 32
4 ? 3z
5 24 3z -l
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[4] Setting Measuring Conditions

Level

Specify the level at which to detect the edge. If the detection
system is based on brightness absolute value and differential
value, specify brightness (0 to 255).

If the detection system is based on the area absolute value and
differential value, specify area value (0 to 512).

Binary
processing
level

If the detection system is based on the area absolute value and
differential value, specify area value (0 to 512).

Values greater than the binary value lower limit of the binary value
upper limit shall be judged as white.

Scanning
direction

Set the edge scanning direction.
The definition of + and - directions differ by window shape.

<Oblong window> <Straight line
(between 2 points)>

Mode = 0 (X-axis projection) Mode = 1 (Y-axis projection)

Origin 15 + IStart point
oA S + direction
g8 \A
Height = =
S| S '\
- direction
Width End point
+ direction
- directio%
«—
<Sector> <Straight line length>
Mode .=.O (Pr'ojec'tion in .Mod'e =1 (Projection in Mode = 2 (All)
meridian direction) direction of circumference)
- Straight angle
Origin

e + direction
Starting \ / \
angle irecti

-direcM ® /(;rectlon direct;n\

Origin
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9.4.6.8 Model Search

[1] Model Search Measuring Tool

This function searches and measures the specified search model inside a
specified window.

It is necessary to register, in advance, the search model used for
measurement.

Model search-measuring tool Specifies the window where you specify the range of measurement.

Model Search
— Meazuring Condition
Object Window]/indowl:

Search M odell Modell:
Loincidence XIBD

Detection Qnitl 0-Pizel \

Back _|__Displays the previously displayed tool.

Edit Windm:I__Displays the window edit tool.

EditModel—'——DiSplayS the search model edit tools.

Detection Nurber 1 |__Performs search measurement.

Start angle :|U

NN
End angle : [350 \ \ \
\ N\

pAE LIk 1] 1]

|__Reads camera image.

el
Resul | Displays the camera screen.
Iterns General \1Resultﬂ \ Pay
Processing T 260
MNumber of De 1
& 24z Specifies a search model to search.
¥ \ 237
Coincidence \ 100 Specifies the criterion on concordance.

\Specifies the rotation range of the object to be searched and measured.
Specifies detection unit (pixel/subpixel).
Specifies a maximum number for search-measuring.

Displays the result of measurement.

9-62



Chapter 9 Operating Vision Manager

4 N

- Search -

Search refers to searching for a point of concordance, by moving the standard image data
(search model), registered in advance, within the range for search (within the window range)
of the object to be measured. (Refer to Fig. 1) With the puVision board, the standard image
data is called “search model” which consists of image data and reference coordinates (OX,
OY). (Refer to Fig. 2) Numeral to express the degree of concordance between the search
model and measure object image is called “concordance”. If acquired concordance is greater
than the specified value, coordinates for the point of concordance between the search model
and the measure object image can be obtained. The minimum unit for coordinate detection
accuracy for pixel is one pixel. With sub-pixel, measuring result can be obtained with an
accuracy of under one pixel. If measured by sub-pixel, the measuring time will be longer than

the measurement by pixel.
Fig. 1 Fig. 2

Search

o= || W 1

Image data

/

Search model Window
\ J

Note: ©: Only the rectangular window can be selected (angle = 0).
@: If the Robot Controller is not capable of angle measurement,
you cannot set any data at Start Angle or End Angle.
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[2] Model Search Measuring

Model search measure tool
® Model search measure tool Q_] in the tool bar.

Model Search

M aasteing Condiion The Model Search window appears.
Bt Windonfwindowd. | =l Back | The window shape appears on both the teaching
Search Madel] Mod=IT = panel and the vision monitor.
o T \\\ 2| B | @ Select Object Window (A).
DetestonUni 0P\ \ \ =l Edit ol | The specified window range will be the object for
DelectlonNumberh :|| E measuring_
Star: ane ;[0 = ® Select Search Model (B).
End angle:[360 % =) || @ Specify Coincidence (C).
hze;i" — _ Commege | ® Select Detection unit (D) from Pixel or Sub-pixel.
el T ® Specify Detection number (E).
Mumber of De @ SpeCIfy Start Angle (F)
ij Specify End Angle (G).
— © Click on Execute.

The Vision Manager measures the currently
selected processing screen and displays the results
in the Result table (H).

The processing results appear on the vision
monitor.

I\

- Measurement result -

Search model

5 l 5 g
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[3] Setting Measuring Conditions

9.4.6.9

Object window

The range of a specified window shall be the object of measuring.

Search model

Runs the search/process inside the window by using a specified
search model.

Concordance

Position having the concordance value greater than specified will
be handled as the result.

Unit of detection

Specifies accuracy (pixel or sub-pixel) of the coordinates to be
search-measured. If measured with sub-pixels, longer measuring
time is required.

Maximum
number of
detection

Specifies the number of results obtained from a search-measuring.
If the number of results reaches the value specified with the
maximum number of detection, the measurement ends normally.

If the number of result fails to reach a specified maximum number,
TIMEOUT error will be generated. In this case, reduce the
maximum number.

Start Angle
End Angle

Specify the rotation range of the object to be searched and
measured.

The Vision Manager measures the object of which angle from the
origin resides between the preset start and end angles.

Reading Code

[1] Code Reading Measuring Tool
Read the QR code in the specified window.

Code reading measuring tool

]/ measurement.
~Measuring Condtion———————————

ijec‘tWinduwiwmdgwnj

Binary Frocessing Lewel
|V [ Autaomatic

EditEImaryj
Lower: HQher;

fMeasuring Sl&‘e@

ltems Gensgl

[Referonge [F~

Processing T
MNumhber of Ch

\ -
\

Specifies a window for specifying the range of

j Back j——DispIays the previously displayed tool.
Ed“Wi”dﬂf’_‘fI ____Displays the window edit tool.

= -1 Runs code measuring.

—Inputs the camera images.

—Displays the camera screen.

Displays binary-coded register tool.

Displays binary-coded level.

Displays the measuring

Character string.

Specifies the presence of automatic binary-coded.

Specifies the presence of automatic binary-coded measuring.
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[2] Code Reading Measuring

Code reading measuring

|V ™ Automat

Ohject Windowlwmdnwu;

Binary Frocessing Lewvel

~teasuring Condition

IC

<]
Back |
EanindUWl

Input |

| Referen\;e 1| F~1  Camlmage |

\Lc'wer: Highe
\
Meast)(ing Status \
ltems \ General
PrD:essir\g T 330
MNumber Df\)h 1
% \

 Click on “# in the tool bar.
The Read Code window appears.
The window shape appears on both the teaching
panel and vision monitor.

@ Select Object Window (A).
The range of a specified window will be the object
of measuring.

® To perform automatic binary processing, check the
Automatic check box (B). If you do not select
automatic binary processing, set the binary code
level with the binary processing registration tool.

@ Click on Execute.
The Vision Manager measures the current selected
processing screen and displays the status at
Measuring Status (C).
Measured character string is displayed in
Measuring Result (D).
The processing results appear on the vision
monitor.

C
4 N\
- Measurement result -
AME
. 4

[3] Setting Measuring Conditions
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9.5 Visually Calibrating Robot Position

This section describes the procedures for visually correcting the robot position.
In the example shown, a series of operations are performed, that includes: ©
Moving the robot to the standby position (P1), @ Moving the robot to the work
position detected with the camera (P2) and holding the work, @ Moving the
work to the pallet position (P3) and unload.

9.5.1 Work Flow

Set the robot and vision according to the following steps:

Input coordinates (vision,
robot) of points 1to 3

| Refer to Chapter 9, subsection
Execute calibration 9.4.5 “Calibration”

|
Refer to Chapter 9, subsection
Transmit the calibration 9.2.5 “Transfer’.

data to the robot (register)

I
Edit program

Transmit the program to the
robot

Check the robot motion
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9.5.2 Calibration of Robot Coordinates and Vision Coordinates

To visually correct the robot position using measured coordinates, it is
necessary to convert the vision coordinates to robot coordinates. To do this, it
is necessary to obtain the relationship between the vision and the robot
coordinates, in advance. The work for acquiring this relationship is called
camera calibration. It is possible to calculate coordinate conversion coefficients
(calibration data) by entering the vision coordinates (Vx, Vy) of 3 points (S1,
S2, and S3) determined in the camera field of view (vision coordinates) and the
robot coordinates (Rx, Ry and Rz) of the Vision Manager camera calibration
tool. Once obtained, coordinate conversion coefficients needs to be
transmitted to the Controller for registration. With the user program, convert
vision coordinates to robot coordinates by using the coordinate conversion
library (viTran6). The coordinate conversion library uses the coordinate
conversion coefficients registered to the Controller for converting coordinates.

Vision
MESE‘%M coordinates Ry1
\‘ N\ R Rx1, Ry1, Rz1: Robot coordinates of
» Y | Point S1
Vx1, Vy1: Vision coordinates of Point
Wyl -, S1
. A Vx1 S1, S2, S3: Reference points

iy '
Vx
v / ‘ S Rx1
y S2

Ry1 Conversion xxl
Rz1 coefficients x VY
Rx
/ - Calibration Data and Coordinate Conversion - \
d to

Camera calibration data registered to the Controller can be referre
using the VISREFCAL command. (See Table 1) The coordinate
conversion library converts vision coordinates to robot coordinates by
using the calibration data referred to by VISREFCAL command. (See
equation 1)

Table 1 Relationship between VISREFCAL Command and
Vision Manager VISREFCAL (a,b)

b
0 1 213 |4 |5 |6 |7 |89/ 1|11
a=0to 31 | NX | OX | AX|RX|NY |OY | AY |RY |NZ | OZ | AZ | RZ

Equation 1 Conversion of coordinate conversion library (viTran6)

RX NX OX AX RX]| VX RX, RY, RZ : Robot coordinates

VX, VY : Vision coordinates
RY |_|NY OY AY RY|| vY ;
= NX, NY,NZ : Table 1
RZ| |NZ OZ AZ RZ|| 0O OX,0Y,0Z : Table 1

1 0O 0 0 1 1 AX,AY,AZ : Table1

RX,RY,RZ : Table 1 /
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9.5.3 Camera Calibration Procedure

Obtain camera calibration data (coordinate conversion coefficients) according
to the following procedures. This operation will complete preparation for
running visual robot position correction.

:Ry1

pRY

Rx1

Rx
Ry2

Rx3

Rx

Rx, Ry: Robot coordinate
VX, Vy: Visual coordinate

@ Input vision coordinates (Vx1, Vy1) of Point S1 and
the robot coordinates (Rx1, Ry1, Rz1) for Point 1 of
the camera calibration tool.

@ Input vision coordinates (Vx2, Vy2) of Point S2 and
the robot coordinates (Rx2, Ry2, Rz2) for Point 2 of
the camera calibration tool.

® Input vision coordinates (Vx3, Vy3) of Point 3 and
the robot coordinates (Rx3, Ry3, Rz3) for Point 3 of
the camera calibration tool.

@ Click on Calibration of the camera calibration tool
and calculate calibration data (coordinate
conversion coefficients). Refer to Chapter 9 “9.4.5
Calibration” in this manual.

® Transmit the calibration data (coordinate conversion
coefficients) to the Robot Controller. Refer to
Chapter 9 “9.2.5 Transfer” in this manual.
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9.5.4 Program Example

The following program list represents an example of visual robot position
correction. Take note on how to use the coordinate conversion library. This
program enables you to check the method for moving a robot by converting the
coordinates measured with vision to the robot coordinates.

Program List “PRO1”

“Robot position correction”
#INCLUDE "dio_tab.h"

1N

PROGRAM PR1 Specify the 1/0 macro definition file. For details, refer to Chapter
TAKERRM 3, subsection 3.4.2 “Defining 1/0 Macro” of this Owner’s Manual.
TAKEVIS
CHANGETOOL 1 'Set the tool for vision calibration
MOVE L, Pl 'Move to the standby position (P1)

VISSCREEN 1,0,1 'Specify drawing screen0 as the object screen for drawing
VISCLS 0 'Clear drawing screen0
VISOVERLAY 1 'Display drawing screen0
CAMIN 1,0,0 'Input camera images to processing screen0
VISWORKPLN 0 'Specify process object to processing screen0
VISPLNOUT 0,1 'Display processing screen0
WINDMAKE R ,1,512,480,0,2 'Set window
VISMEASURE 1,0,0,1,1,100,255 'Measure center of gravity (work position)
IF VISSTATUS(0) = 0 THEN

F1 = VISPOSX(0) 'Store vision coordinate X to F1

F2 = VISPOSY(0) 'Store vision coordinate Y to F2

P2 = P1 'Copy the data of standby position attitude

CALL viTrané (0, F1, F2 , P2) 'Convert vision coordinates to the robot coordinates
(by using “0” of vision calibration data)

APPROACH P,P2,100

MOVE L, P2 'Move to the position measured by vision
GOSUB *ChuckItem 'Part chuck
DEPART L, 100
APPROACH P, P3,100 Coordinate conversion library
MOVE L, P3 'Move to pallet P3 position “viTrans6” is registered to
GOSUB *UnchuckItem 'Part unchuck the Vision class in the
DEPART L, 100 program bank. To convert
CHANGETOOL 0 coordinates, add the library
END IF “viTrans6” to the project. For
GIVEVIS the method of addition, refer
GIVEARM to Chapter 5 “5.6.2 Program
END Bank” in this manual.
'===== Part chuck =====
*ChuckItem:

SET IO [ioChuck]
RESET IO[ioUnChuck]
RETURN

*UnchuckItem:
RESET IO [ioChuck]
SET IO [ioUnChuck]
RETURN

9-70



Chapter 9 Operating Vision Manager
_________________________________________________________________________________________________________|

9.5.5 Executing Program

Execute the program according to the following procedures:

O Create a new project.

@ Create a new program and input the program from Chapter 9, subsection
9.5.4 “Program Example” of this instruction manual.

® Add the “viTrans6” library to the project from the program bank.

@ Define macro names “ioChuck, ioUnChuck” to be used with the hand chuck
for general output of the DIO Manager.

® Create the DIO Manager macro definition file.

® Create the execution program.

@ Transmit the program to the Controller.

Teach the robot standby position (P1) and the pallet position (P3).

® Check the program motion.
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9.6 Help Menu

The Help menu provides explanation on how to use WINCAPSII.

Help

Lizenze Fey

About Syztem kM anager

Fig. 9-8 Help Menu

9.6.1 About Vision Manager

Displays the version information on Vision Manager.
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@ —————
Operating Log
Manager

This chapter describes the WINCAPSII software
Log Manager that is used with the personal
computer teaching system.







Chapter 10 Operating Log Manager

10.1 Outline of Log Manager

10.1.1 Outline of Functions

The Robot Controller holds the record of operation as a log. The personal
computer teaching system Log Manager inputs this log to the personal
computer and controls it in batch. The Log Manager can run log search,
display graphics, or reproduce action with the Arm Manager, error monitor, etc.
It can implement the initial stage of the maintenance operation from a remote
location by using the communication function.

Start Log Manager by clicking on button of the System Manager or from the

WINDOW menu.
When started the Log Manager window will appear on the screen.
The Log Manager window displays the logs as described in the following:

10.1.1.1 Document

Click the Document tab to record the history of maintenance operation, service
operation, etc.

Note: As for the history of program changes, users are recommended to
record changes in document in the project setting of the PAC
Program Manager. Refer to 5.2.5.1 “Document”.

i® C:\Program Files\WINCAPS 2\IRA-D0005BA-0000 log - Log Mana._. =] [E3

File Edit Actions Toolz Help
A|D|Q| o = =@ ] &

[ Camm. log ? Wersion ?- Errar detection ? Camim. spec. 1
‘Document; 3’ Errar log 3/ Operation log T Contral log

Use this area to mainly record the results of
maintenance or services.

Fig. 10-1 Document
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10.1.1.2 Error Log

If an error is generated during robot operation, this log records the content of
the error together with the time of generation. To acquire the error log, run the
operation given in 10.2.5 “Receive Data” on page 10-11 and receive the Error
Log from the robot controller.

i C:AWINCAPS 2\PROJECTAVM-6070D\VM-6070D log - Log Manager =] [E3

File Edit Actonz Toolz Help

el =2 N L A ]

[ Comm. Log T YWRrsion T Error Detection T Camm. Spec.
Document T Error Log T Operation Log T Contraol Log )
Mao.|Date |Time |I'v1::udu|e |Code |Message N
119| 20000616 160627 25700 | J4 encoder phase Fa
120| 20000616 160627 24884 |4 encoder cable dis
121| 20000616 160627 26701 | J5 encoder phase R
122| 20000616 160627 24885  J5 encoder cable dis
123| 20000616 160627 26702 | J6 encoder phase P
124| 20000616 160627 24886 | Jb encoder cahle dis_l
125] 20000616 160627 2hG2? 1 J3 encnderphasei:i;l
1 » —

Fig. 10-2 Error Log

10.1.1.3 Operation Log

10-2

Click the Operation Log to record the content of operation from the teach
pendant. To acquire the operation log, run the operation given in 10.2.5
“Receive Data” on page 10-11 and receive the Operation Log from the robot
controller.

i C:AWINCAPS 2\PROJECT\WM-6070D\WM-6070D log - Log Manager Mi=] B3

File Edit Actiohz Toolz Help

[ DD oz| = | w @& o] ]

[ Comm. Log T Wersion T Error Detection T Comm. Spec.

Document T Error Log TEOpentinl I.ng;T Contral Log |
Mo, | Date |Time |Clien1 |C|:|de |Dperaﬁon conten
54| 2000061 TEOEZ5 -26010 | Mode setting

Bh| 2000061 160627 -26010 | Mode setting

56| 2000061 TR06R27 -26043  |Machine lock OMN
57| 2000061 TROGE31 26010 | Mode setting

B&| 2000061 161407 -26032  Setting communic
59| 2000061 161407 -26032 | Setting communic
BO| 2000061 167415 -2B032  Setting communic
RI1L2NNNNRT TRTATR =2RN37 | Sattinn comminie

Fig. 10-3 Operation Log
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10.1.1.4 Control Log

Click the Control Log to record the command value, encoder value, current
value and load ratio for each respective operating axis. Although the number
of control axes differs by model, the record for the number of control axes is
retained. To acquire the control log, run the operation given in 10.2.5 “Receive
Data” on page 10-11 and receive the Control Log from the robot controller.

i C:AWINCAPS 2\PROJECTAVM-6070D\VM-6070D log - Log Manager =] [E3

File Edit Actonz Toolz Help

& DD 57| = ||| ||

[ Comm. Log T YWRrsion T Error DetectinnT Camm. Spec.
Document | Errorlog | Operstion Log | Comtrol Log |

™

Ma.|J1 - Command value|J1 —Enn:n:udervalue|J1 —Currentvalue|J1ﬂ
a a a

1]
1]
1]
1]
1]

‘ol
| o H

Fig. 10-4 Control Log

b i O R Y e )
L e e e Y s Y e |
oo o o o O

10.1.1.5 Communication Log

This log is used for checking the status of communication. It is the same thing
as the communication log in Communication Manager. To acquire the
communication log, run the operation given in 10.2.5 “Receive Data” on page
10-11 and receive the Communication Log from the robot controller.

i C:\Program Files\WINCAPS 2\IRA-D000ABA-0000 log - Log Mana._. [H=] E3

File Edit Actions Toolz Help
#lE|=| | w|w|w| ] &

[ Docurment T Errar Log T Cperation Log T Contral Log 1
[:nmang T Warsion T Error Detection T Comrm. Spec. 1

—ROBOTalk Communication Fecard

Total Number of Transmitted Fackets:
Total Murmber of Received Packets:
Murmber of Transmitted MNAKs:
Mumber of Beceived MAaks:

Mumber of Received NAKs (Standby):

o o o o o O

Mumber of Timeout Errors:

Fig. 10-5 Communication Log
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10.1.1.6 Version

Records the version of each respective section of the Robot Controller. To
acquire the version log, run the operation in 10.2.5 “Receive Data” on page 10-
11 and receive the Version Log from the robot controller.

i C:\Program Files\wWIMCAPS 2\ RBA-OD00 RA-0000.log - Log Mana. .. [ 9[=] E3

File Edit Actions Tool: Help

ol =] ] ] R

( Ciocument T Errar log T Operation log T Control log
Camm. log T Mersion: T Errar detection T Comm. spec.

kaodule name Sarsion

<R wersion> 0.0n

Main binard nnn

DD board 0.0.0

“ision bhoard 0.oan

Device nethinard nnn

Teaching pendant 0.0.0

Clperation panel 0.0.0

PAC language processing module |0.0.0

Interim code processing module  [0.0.0 B

Fig. 10-6 Version

10.1.1.7 Error Detection

If an error occurs, the error detection lamp in the Log Manager window
changes from green to red and the detected error appears in the Search
conditions (C) dialogue box.

The error detecting conditions correspond to the error detection settings in the
Set dialog box which is displayed using the Set command in the Tools menu.
Clicking on Program starts the application specified as the start program in
Error detection of the Set dialog box.

For information regarding Error detection in the Set dialog box, refer to 10.5.1.4
“Error Detection”.

Note: No error is detected unless the error and monitor buttons are
turned ON.

i C:\Program Files\WINCAPS2\RA-DDO0MRA-0000. log - Log Manager =] [E3

File Edit Actions Took Help

A== | =& =] &
[ Document T Error Log T Cperation Log T Control Log

camrm. Log T Wersion TErrurDete[tmnI caomrm, Spec,

Error detection lamp ~Detail of Detected Errar
Green: No error -
Red: Error detected ] Error | |

/‘
Search conditions (C)
dialog box

Program start — |

T Pragram | -

Fig. 10-7 Error Detection
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10.1.1.8 Communication Specifications

Click the Comm.spec.tab to record the contents of the Robot Controller
communication setting. For communication use, run the operation in 10.2.5
“Receive Data” on page 10-11 and receive the Communication Application Log
from the robot controller.

i C:\Program Files\'WINCAPS 2\IRA-D000ARBA-0000 log - Log Mana... =] E3

Fil= Edt Actons Tool: Help
A DD w| »|w || o] ]

[ Document T Error log TOperatiunlugT Contral log
Comrm. log T Yarsion T Error detection Tf;(:umm. spec.i'

Froperty “alue
Time-outtime (msec) 4000
Mo, of retrials on occurrence of time

Mo. of retrials on oceurrence of NAE
DI0. Cormrunication right
RSEZ32C01). Communication right
RS232C01). Baud rate

RSE32C01). Parity (0: Even, 1: NMone
Fz5232C01). Data length
RS232C0170. Stop bit (0: 1hit, 1: 1.5kbit,

Fig. 10-8 Communication Specification
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10.1.2 Tool Bar (Log Manager)

10-6

Tool bar

i® C:\Program Files\WINCAPS 2\IRA-D0005BA-0000 log - Log Mana._. =] [E3

Fil= Edit Actions Toaol: Help

T #mg] o = w] x| &]k]

[ Camm. log T Wersion T- Errar detection T Camim. spec. 1
‘Document; T Errar log T Operation log T Contral log 1

Use this area to mainly record the results of
maintenance or services.

Fig. 10-9 Tool Bar

#| CONNECT button: Establishes connection to the Robot Controller. When

connected, this button is displayed as if depressed.

SNAPSHOT button: Records the current status of the Robot Controller
once.

MONITOR button: Records the status of the Robot Controller in
succession.

RECEIVE button: Receives the Controller data.

CONTROL LOG START button: Starts the recording of the control log at
the Robot Controller. This serves the same function as the STOPLOG
command in the PAC command set.

CONTROL LOG STOP button: Stops the recording of control log at the
Robot Controller. This serves the same function as the STOPLOG
command in the PAC command set.

CONTROL LOG CLEAR button: Erases Robot Controller control log
record. This serves the same function as the CLEARLOG command in the
PAC command set.

CONTROL LOG MOTION REPRODUCTION (1 cycle) button:
Reproduces robot action for one cycle using the Arm Manager based the
command values recorded to log at intervals of 8 msec.

CONTROL LOG MOTION STOP button: Stops reproduction motion if the
control log motion is being reproduced.

CONTROL LOG GRAPHIC button: Graphically displays data recorded to
the Control Log.



10.1.3 Basic Usage

During monitoring

Connect to Robot
Controller

l

Select and receive a
log desired to acquire

l

Log analysis

Chapter 10 Operating Log Manager

Refer to “10.4.1 Connect”.

Refer to “10.2.5 Receive Data”.

Refer to “10.3.9 Search on Grid”.
(Another tool may be used as an option)
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10.1.4 Files to Be Managed

The Log Manager manages log files (*.LOG) as shown in Fig. 10-10.

X

Log Manager

Fig. 10-10 File Managed by Log Manager

10.1.4.1 Log File (*.LOG)

10-8

A log file stores the log information of project.
Since log information is stored in separate files for each project, the log

information can be managed without confusion even when multiple projects are
involved.

The extension of the file reads “.LOG”.
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10.1.5 Menu List (Log Manager)

The command menu of the Log Manager has the following tree structure:

File
New *1
Open 1
Save
Save As *1
Receive
Print
Import
Export
Close

Edit
Undo
Cut
Copy
Paste
Delete
Select All
Search
Replace
Search on Grid

Actions
Connect
Snapshot
Monitor
Begin Control Log
End Control Log
Clear Control Log
Reproduce Control Log Action
Graph Control Log

Tools
Options
Analyze by Control Log
Servo Joint Graph

Help
About Version

*1:

Fig. 10-11 Menu Tree of Log Manager

To be displayed only when the file extension menu of the display option is
checked. To set the display option, re-login on the programmer level,
select Tool, Options, and View, and then check the option file extension
menu.
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10.2 File Menu (Log Manager)

The Log Manager File menu is used for managing files of saved logs.
A file used for saving the content of a log is attached with “log” as the
extension.

Fil= Edit Actions Tool

New

Open... Ctrl+0
Save Ctrl+5
Save As...

Eesewe,. [EhiF]

Frint. .. Ctrl+F
Import 3
Export [
Close

Fig. 10-12 File Menu

10.2.1 New (Programmer Level)

Newly creates a LOG file for saving the contents of a log. The extension reads
H.log”'

10.2.2 Open (Programmer Level)

Opens an already existing LOG file.
When the standard Windows dialog box appears, select a log file to open, and
click on Open to open the file.

k0pen
Lack in: | ‘=3 Ira-0000

IR &-0000 lag

File name:

| Open I
Files af tupe: ILDE[iIe[*,Igg] j Cancel |

Fig. 10-13 Open Dialog Box

v

10.2.3 Save

Saves the contents of the current log to the currently selected file.
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10.2.4 Save As (Programmer Level)

Saves the content of the current log to a new file.
When the standard Windows dialog box appears, select a path, input the file
name, and click on SAVE to save the log data.

Save As
Lok ine | ‘=3 Ira-0000 -l B @Al e =

IR &-0000 lag

File name:

| Open I
Files af tupe: ILDE[iIe[*,Igg] j Cancel |

Fig. 10-14 Save As Dialog Box

v

10.2.5 Receive

Receives log data in the Robot Controller.

This command can be operated using Receive.

When the Receive Table dialog box appears, check select the desired item and
click on Receive.

The log data is input to the personal computer.

@ Receive Table |

— Transfer Table -
{Err|:|rL|:||;1} ................................................. £ Beceive
<Cperation Log? Cancel

<Control Log»
<Communication Logz
<ersions

<Communication Specificatic
<Servo Joint Log»

SelectAll

[ Flash area

Fig. 10-15 Receive Table Dialog Box
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10.2.6 Print

Prints each log.

10.2.6.1 Print Object

When the Print Manager dialog box appears, check select the desired item and
click on PRINT.

Clicking on PREVIEW allows the printed image to be reviewed on the screen.
Check selecting the optional PRINT LINE NUMBER adds the line number for

printing.
Print ObjectT Option ]
Printer Canon LEP-430
— Print Object |
|| Operation Log
1 Control Log
| Version
| Communication Spec.
Print Cancel Prewiew Set
Fig. 10-16 Print Manager Dialog
e Select All: Selects all objects for printing simultaneously.
e Set: Displays the printer setting dialogue and makes various
printer settings.
e Preview: Allows the user to see the print format before actual printing.
e Cancel: Closes the dialogue box without printing.
e Print: Prints variable tables.
e Option: Displays printing options.

TIP: To print specified pages only, click the printer button |£ after
previewing. You may specify the print range in the printing
preview.

Note: If you select more than one object to be printed, Preview is not
usable.
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E Yersion [_ (O]

5

Lag Managar 199971 0re?
<Vanoo -
rodalc 13nc Vermina
=R vanon - (ISR GELELT]
oo bood I 000 adesarl9hE
D% bood [T L EL T
Yiainn bood 2 OO0 025902
Dericz oo bomd [T L EL R
Teeching pradm
[ ——
FAT Impumg= pioc=aing oodule W d 09l delnn
huromim emde pioc=maing madule [IRAER LB R ET L]
Tool pab piocmaiog oadule 1220 el 2ol oid
Zaro piocmaog module
Communicune pioe=aieg maduls 1 21a adesaeloph
Feadoo proc=aiog oaduls I2ed Lol erleph
Viaion don piocmaiog madule 1250 090l 51999
Y2100 momm piocaaog ocoduls [T RN E R T
Dewicgio pln::um u:dulc 1 020 0972301993 LI
] a1 D ][concel][ & [2]E0] 0] [Close ] 2#ei24 Ta:
Fig. 10-17 Preview Window
4 | M | Moves to the head/tail end of the page.
4 | 4 | Moves to the immediately preceding/following page.
fll Selects display (Reduction/Standard/Expansion)
= Sets print execution
The printing range (specific pages) of an object file can be
specified.
Print

Frirter; Suystern Printer [Canon LEP-730]
Frint Range Lancel |
" Pages Copies: I 13:

From: I 1 Ie: I 3 v Callate Copies

Fig. 10-18 Print Window
B3| &l :  Exports the object file.

The selected object file will be converted into the file format
specified in Format and outputted (saved) to the Destination.

E xport

Format: Deztination:

| Disk file

k. I Cancel |

Fig. 10-19 Export Window
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10.2.6.2 Option

Selecting the Option tab will display the print options.

'!'_-, Print Manager

PrintObject |  Option’ |

= Bt Eantinyons]y
¥ Erirt Lire o,

Print Cancel Prewiew Set

Fig. 10-20 Option Tab (Print Manager Dialog Box)

e Print Line No.: Selecting this with a check mark will print the selected
program together with the line numbers.

10.2.7 Import

Reads "Servo Single-Axis Data Log" data stored in the CSV format. The
read data can be displayed graphically with "Servo Single-Axis Data
Graph" on the TOOL menu.

The Windows standard dialog box appears. Select a desired file and also
select a read file, then click on Open.

10.2.8 Export

Stores "Servo Single-Axis Data Log" data in a CSV-format file. The stored
file is available for "Import" on the FILE menu or another application.

The Windows standard dialog appears. Select a path, enter the file name, and
click on Save.

10.2.9 Close

Ends Log Manager.
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10.3 Edit Menu (Log Manager)

This EDIT menu has the standard editing menu functions as are in any
application software used for Windows 95.

[l Action: Tool: Help

Undo Chrl+Z
Cut Chrl+=
Copy Chrl+IC
Past Chrl+4f
Delete Del
Selact Al

Search... Chrl+F
Feplace... Ctrl+H
Search on Grid Chl+:

Fig. 10-21 Edit Menu

10.3.1 Undo

Cancels immediately preceding operation to "document" to restore the original
status.

10.3.2 Cut

Cuts out a selected range of data of the “document.” Cut data can be used by
the Paste command.

10.3.3 Copy

Temporarily stores the selected data in the Error Log, Control Log, Version,
Error Detection, and Communication Specification. Data temporarily stored by
copying can be used in the PASTE command.

10.3.4 Paste

Temporarily stored data by cutting-out or copying is pasted to a specified
location in the “Document.”

10.3.5 Delete

Deletes the selected data in the “document.”

10.3.6 Select All

Selects all the data displayed when the “Document” tab is clicked on.
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10.3.7 Search

Searches for the specified character string in the “document.”
When the Retrieve dialog box appears, specify the necessary item and click on
Find Next. Detected character strings are displayed in reverse.

Ik Search
Eind Yhart: Ii j Find Mewt

Cibject Search IAII "I Cancel

" Document
" Belected Range

0.

[ katch Cage

Fig. 10-22 Search Dialog Box

e Find What: Input the desired character string for search here.

e Replace With: Input character string desired for replacement here.

e Search Direction: Specify the direction of the search. If All is selected,
search runs downward to the end, then it runs downward from the top of the
data.

e Object: Select the range of search; all the document or within a selected
range.

¢ Maintain cases: If you check this box, upper and lower case letters will be
distinguished in searching character strings.
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_______________________________________________________________________________________________________________|

10.3.8 Replace

Replaces the specified character string in the “document” with the separately
specified character string.

When the Replace dialog box appears, specify the necessary item and click on
Find Next. Detected character strings are displayed in reverse.

Clicking on Replace replaces the character string currently being displayed in

reverse.
Clicking on Replace All replaces every applicable element in the selected
object.
I Replace
Einet what: [ ~| | FindMext
Replace With: | j Cancel

Object Search IAII v] Replace

& Document

 Selected Bange Feplace All

il

[ kdatch Case

Fig. 10-23 Replace Dialog Box

e Find What: Input the desired character string for search here.

e Replace With: Input the character string desired for replacement here.

e Search Direction: Specify the direction of search. If ALL is selected, search
runs downward to the end, then it runs downward from the top of the data.

e Object: Select the range of search; all the document or within a selected
range.

¢ Maintain cases: If you check this box, upper and lower case letters will be
distinguished in replacing character strings.
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]
10.3.9 Search on Grid

Searches the Error log and Operation log grids.
The basic operation is the same as described in 10.3.7 “Retrieving” on page

10-14, but the field name is added to the retrieving condition. The search runs
for the field specified in the Field Name box. If a matching character string is

found the appropriate page is displayed.

e Search on Grid

Eind‘What: j | Find Mext I
search on |Epor Log j Cancel
Field Mame: | ot j 4|
Object Search ] v
oA
) Seleated Eange [~ datch Cage

Fig. 10-24 Search on Grid Dialog Box
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10.4 Actions Menu (Log Manager)

Commands arranged in this Actions menu can be also specified by the buttons
shown below.

m Tool: Help
Connect
Shapzhot
Moritar

End Cantral Log

Clear Contral Log
R eproduce Control Log Action Start 1-Step

Graph Contral Log Start 1-Cucle
Stop Step

Eegin Cantral Log F& ‘

£=]=] 2] »|n] 8] 2|2

Fig. 10-25 Actions Menu and Buttons

10.4.1 Connect

Makes connection for communication with the Robot Controller.

When connected, the menu has a check mark.

The CONNECT button ﬁl works the same way as the CONNECT command.
When connected, it is displayed as if depressed.

10.4.2 Snapshot

Acquires the instantaneous data from the Robot Controller.
The SNAPSHOT button works the same as the SNAPSHOT command.
To run the snapshot command communication must be set up in advance.

10.4.3 Monitor

Acquires data in succession from the Robot Controller.
The MONITOR button works the same as the MONITOR command.
To run the monitor command communication must be set up in advance.
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10.4.4 Begin Control Log

Starts recording the control log at the Robot Controller.

To run the Begin Control Log command, it is necessary for the communication
to be set up in advance.

The START LOG button :l works the same as the Begin Control Log
command. It has the same function as the PAC STARTLOG command. Refer
to “19.2 STARTLOG (Statement)” in Part 2 of Owner’s Manual (Programming).

10.4.5 End Control Log

Stops recording the control log at the Robot Controller.

The STOP LOG button ll works the same way as the End Control Log
command. It has the same function as the PAC STOPLOG command. Refer to
“19.2 STOP LOG” in Part 2 of Owner’s Manual (Programming).

10.4.6 Clear Control Log

Erases the content of the control log at the Robot Controller.

The Clear Control Log button ﬁl works the same way as the Clear Control Log
command. It has the same function as the PAC CLEARLOG command. Read
19.2 “CLEARLOG (Statement)” on page 12-6, Part 2, Owner's Manual
(Programming).

10.4.7 Reproduce Control Log Action

Prepares the Arm Manager and Log Manager using the following procedure to
reproduce motion by control log:

} STEP 1 I Click on ﬁl button of System Manager.

» STEP 2

10-20

The Arm Manager starts.

Set Zf| button of Arm Manager to the disconnected status.

STEP 2 STEP 3 Arm manager

4 C:%Pragram Files\wircaps 2\ RA-00005BA-0000.arm - Arm Manager [M=] B3

dit  Action Afew Tool Help

A1 ElE RS R RS

|Typ eF x| 50 1265.0.0.0.3) |

L [l =]

il

[

l

=
1
L—
=
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Click the button of Arm Manager to enter Monitor status.
» STEP3 |

Click the Xr| button.
} STEP 4 okt e_hl e STEP 4 Log Manager

% C:\Program Files\WINCAPS 24 RA-D000\RA-0000.log - Log Manager =] E3
Fil=  Edit Actions Toolz Help

Ao 2| 17| = v & =] &

f Comm. log T Wersion T Errar detection T COmm. Spec.
Document | Erorlay | Operaisnlog | Control log

MNo.[J1 - Command value|.J1 = Encodervaluel.ﬂ - Current valuel.ﬂ = L;l
175
176 [
177
178
174
180
181

182 i
K _'I_| B

This completes the preparation. Run respective reproduction operation
according to the following descriptions:

Start 1-Step

Reproduces one step portion of the currently selected control log.

Start 1-Cycle

Reproduces robot action using the Arm Manager and the command value
recorded in the control log of Log Manager every 8 msec.

The playback button =] works the same way as the Reproduce Control Log-
Start 1-Cycle command.

Stop Step

When reproducing the current control log motion this will stop such motion.
The control log motion stop button 2| works the same way as the Reproduce
Control Log-Stop Step command.

10.4.8 Graph Control Log

Graphically displays the data recorded in the control log.
The graph button &4 works the same way as the Graph Control Log command.
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10.5 Tools Menu (Log Manager)

The Tools menu has these commands.

Toolz Help

i Options....

Analyze by Contral Log

Servo Jaoint Graph

Fig. 10-26 Tools Menu

10.5.1 Options

Selecting Options command in the Tools menu and the Options dialog box
appears. Clicking on the table displays the respective option items.

Note: Items that can be edited vary depending on the user level. For
restrictions by user level, refer to “1.3 Security”. For the method of
changing the access level, refer to “4.3.3 Re-Log In”.

10.5.1.1 Monitor

#E Options E3
Mumtnrl Editn:nrl Filel Erraor Detecﬁnn' Display'

~Options

Timer Intervals: '_J ________ 2000] ms

K. | Cancel

Fig. 10-27 Monitor (Options) Dialog Box

e Timer intervals: Sets the data input intervals for monitoring. Initial status is
2000 msec.
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10.5.1.2 Editor

-Ifl- Options

Momitor E ]
~Faont Tah

EDmNamBISystem v| ( Tah Intervals] B

§ize|1D vI

~Color

EDregroundIBlack 'l

Eackgmunlehite 'l

Ik | Cancel

Fig. 10-28 Editor (Options) Dialog Box

e Font name: Specifies font to be used in the document. Clicking on ﬂ arrow
opens the list of selection items.

e Size: Specifies the font size to be used in the document. Clicking on ﬂ
arrow opens the list of selection items.

e Foreground: Specifies the color of foreground to be used in the document.
Clicking on ﬂ arrow opens the list of selection items.

e Background: Specifies the color of background to be used in the document.

Clicking on ﬂ arrow opens the list of selection items.

Tab intervals: Specifies the number of half size spaces for one tab interval.

10.5.1.3 File

#F Options

Monit0r| Editor 2 I Ertor Detection | Displayl

~Preload

[ Load Log Data from File at Startup

QK | Cancel

Fig. 10-29 File (Options) Dialog Box

e Load log data from the file at start: Specifies whether to read past data
saved in the log file when the Log Manager is started.

Note: Reading takes some length of time. The Log Manager automatically
starts when WINCAPSII is started.
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10.5.1.4 Error Detection

10-24

Click the Error Detection tab to specify the processing performed upon
generation of an error.

The detection condition of errors displayed in ERROR DETECTION in the main
Log Manager window, conforms to the setting in ERROR DETECTION of the
SET dialog box.

For more information on Error Detection in the Log Manager window, refer to
“10.1.1.7 Error Detection”. For actual error detection, the Controller must be
constantly supervised. Detect errors by turning ON the MONITOR button in the
Log Manager window.

#E Options E3

Monitor | Editor | File |

—Error Detecting Conditions
& Detect by Errar Lamp (Lamp CR)

" Detect by Error Lesvel (Ower Setialug)  Detection |3—j

—Processing after Detection
¥ Stop Detection
Star Prograrm: |C:“-,WINCAPSE"-,EIIN'\flash.exe

K. | Cancel

Fig. 10-30 Error Detection (Set) Dialog Box

Servo error: If checked, executes the PROCESSING AFTER DETECTION
setting when a servo error occurs.

Control log buffer full: If checked executes the Processing after detection
setting when the control log buffer becomes full.

Stop detection: If checked, disregards the error after the second time the
same error occurs.

Start program: If an error is detected, specifies an application to start.
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10.5.1.5 Display (Programmer Level)

Click the Display tab to set the display options between show and Hide.
This item only displays on the programmer level.

-IEI- Options |
Mnnitnrl Editnr| File | Ettor Detection Dlsplayl
—Dptian
M|File Expansion kenu

|1 Automatic refreshiAutomatic snapshaf)

Ik | Cancel |

Fig. 10-31 Display Tab (Options Dialog Box)

¢ File extension menu: Extends File menu
For details, refer to “10.1.5 Menu List."

¢ Auto Update (automatic acquisition of snapshot): If you change the window
size or scroll the screen when the Log Manager is connected or in the
process of connection to the Robot Controller, the Manager automatically
monitors the snapshot.
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10.5.2 Control Log Analysis

Performs analysis on the basis of control log data and displays the expected
load ratio, maximum load ratio and expected rotational resistance load ratio of
each respective axis.

J1: Estimated load ratio = 0%, Max. load ratio = 7.062957%% (Ma. 1)

o

2: Estimated load ratio = 024, Max. load ratio = 4.048316% (Mo, 1)
3 Estimated load ratio = 0%, Max. load ratio = 21.77763% (No. 1)
4: Estimated load ratio = 0%, Max. load ratio = B.456076% (Mo, 1)
b Estimated load ratio = 0%, Max. load ratio = 4.71852% (Mo, 1)

f: Estimated load ratio = 034, Max. load ratio = 4.71852% (No. 1)

7: Estimated load ratio = 0%, Max. load ratio = 4.895358% (Ma. 1)
&: Estimated load ratio = 024, Max. load ratio = 5.389116% (Mo, 1)

Estimated Regenerative Resistance Load Ratio = 0%

o -

¥ Faste Analysis Results to Document

Fig. 10-32 Analysis Results Dialog Box

Paste the results of analysis in the document, check (d) and click on OK. The
analytical results of the displayed control log will then be added to the
document described in “10.1.1.1 Document”.

10.5.3 Servo Joint Graph

Graphically displays "Servo Single-Axis Data Log" received from the controller
or imported on the FILE menu.

Note: For details on how to specify the receive data axis number and
item, refer to the Robot Instruction Manual.

B2 Servo Joint Graph =1 E3

Fosition Deviation Current Ratio 6

offset <] | Interval

scale T

| H=0.135 IY1=6654.132  [Wi=pb.541 4
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10.6 Help Menu

Descriptions on how to use WINCAPSII can be viewed using the Help menu.

ek

Lizenze ey

About System Manager

Fig. 10-33 Help Menu

10.6.1 About Log Manager

Displays the version information of the Log Manager.
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10.7

10.7.1

New Control Log (Ver. 1.20 or newer)

New Control Log Function

WINCAPSII version 1.20 or newer supports a new control log whose operation
status will change as illustrated below.

Error

occurrence | or ClearLog

Power ON

StartLog
—

Recording data
(in non-buffer mode)

Recording data
(in ring buffer mode)

ClearLog

Error occurrence Buffer file full

Error recovery StopLog or StopLog

Recording stopped
due to error

Recording stopped
due to full buffer

Saving instructed from the teach Saving instructed from the
pendant or operating panel teach pendant or operating
panel

Saving into flash
memory

N

Log data deletion
instructed from the
teach pendant.

10-28

NOTE: A flash memory refers to an area which preserves data even if power
supply is cut off.

When the power is on, control log is always recording data in ring buffer mode.
The buffer size for this can be specified by the user.

Data recording will be aborted due to an error occurrence (Error 6000's Level 3
or higher) or by StartLog or StopLog.

ClearLog or removing error will start data recording. (ClearLog will be
automatically called up when data is preserved from the ring buffer to the flash
area or to WINCAPSIIL.) Control log can be fetched only from WINCAPSII.

If recording is aborted, data can be fetched from the ring buffer or the flash
area.
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NOTE 1: If the log is switched from a recording stop (recording aborted) to the
ring buffer mode after the removal of an error, data can be fetched until the ring
buffer will stop next. If ClearLog is executed, data can be no longer fetched.

NOTE 2: If the log is switched to a recording stop due to a full buffer by user
operation, it cannot be switched back to the ring buffer mode until it gets
ClearLog.

NOTE 3: If any error occurs during data fetching from the ring buffer, the error
log will not be recorded.

10.7.2 User's Operations While Using Control Log

User's operations which the user performs related to control log are as follows:
- Setting the ring buffer for preserving data. (Subsection 10.7.3)

- StartLog (Subsection 10.7.4)

- StopLog (Subsection 10.7.5)

- ClearLog (Subsection 10.7.6)

- Saving or deleting control log to/from the flash area. (Subsection 10.7.7)

- Fetching control log (Subsection 10.7.8)

- Saving control log to floppy disks (Subsection 10.7.9)
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10.7.3 Setting the Ring Buffer for Preserving Data

You may change the ring buffer settings from the teach pendant or in
WNCAPSII. The ring buffer settings include two types of parameters--control
log record mode and control log sampling interval. The new settings you made
will take effect when power supply is turned on next time.

Control log record mode

Any of integers 1 to 3. The number of sampling times will change according to
the mode.

1: 1250 times
2: 2500 times
3: 3750 times

NOTE: Depending upon the mode, memory sometimes cannot be secured. If
this happens, an error occurs at the time of project loading. Downgrade the
mode and restart the controller.

Control log sampling interval

Any of 8, 16, 24, and 32. The unit is millisecond.

NOTE: If you specify a value other than the above four integers, the entered
value will be automatically raised to the nearest higher value. (e.g., if you
specify 12, the sampling interval will be set to 16.)

Defaults

Control log record mode: 1
Control log sampling interval: 8
The sampling time is 10 seconds.
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Chapter 10 Operating Log Manager

Parameter setting procedure from the teach pendant
Access: Top screen —[F2 Arm]—[F6 Aux.]-[F7 Config.]

Mg o § Us-D | Joint woTR|[ 1

User Preferences [No. of parameters: 66]

20: Encoder pulse count for positioning allow 20

21: Operation end time—out (ms) 5600

22: Control log mode 1

23: Control log sampling time 8

24: Efficiency of gravity effect m

Cancel | 0K
F5: Change the selection, OK: Exit with saving AR} 1/0)

® &‘ Back Next | Jurp To | Change.

Setting the Ring Buffer that Preserves Data

Modify the Control log mode and Control log sampling time parameters.

Parameter setting procedure in WINCAPSII
3F Options

]|

Froperty setwvalue
Encoder pulse count for positioning allowanc 20
Encoder pulse count for positioning allowanc 20
Operation end time-out (ms) hEON
Contral log mode 1
Control log sampling time 8
Efficiency of grawvity effect 0
cutlmt function cancellation switch 0
Feserved 0

Ik, Cancel

Setting the Ring Buffer that Preserves Data

Enter into WINCAPSII by 1-Programmer level. Open Arm Manager and select
[Tool] [Options] [Config.]. Set the control log record mode and control log
sampling interval parameters, then send those settings to the controller.
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10.7.4 StartLog

After execution of StartLog, if the

Ti
ring buffer becomes full, the me Startlog command
process will be stopped. ]

[y
That is, the log of process from @:_ .
StartLog to the full buffer state hg?e"s recorded
can be fetched.

10.7.5 Stoplog

The current ring buffer can be
stoped at the same time as
StopLog.

10.7.6 ClearLog

Restarts the ring buffer.

Restarts the sampling process which has been stopped with StartLog or
StopLog.

10.7.7 Saving or Deleting Control Log to/from the Flash Area

If the control log cannot be immediately read in WINCAPSII, then use this
function to take a backup.

Control log preserved in the flash memory is secured even after the power
supply of the controller is cut off.

You may save control log from the teach pendant or operating panel. Deletion
of control log is possible only from the teach pendant.

NOTE: There may be changes of failure in save process due to insufficient
flash memory.

NOTE: If you save control log again after saving it, the log data will be
overwritten.
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Chapter 10 Operating Log Manager

Log saving/deleting procedure from the teach pendant
Access: Top screen —[F2 Arm]—-[F6 Aux.]-[F11 Log]

Mg o [ K- | Joint weTO|[ 12

Control Log Menu

Strtlog  Stoplog ClrLog
[F1] [F2] [Fel
o \ o \
Savelog. DelLog.
[FA [F121
Cancel: Close this window iR} 1/0)

@ A‘ StrtLog [ StopLog | | | ClrLog

Control Log Menu

[F7 SavelLog.] Saves the control log into the flash memory.
[F12 DelLog.]  Deletes the control log from the flash memory.

10.7.8 Fetching Control Log

You may fetch the control log only in WINCAPSII. Receive the control log from
LogManager.

& Receive Table |
— Transfer Table .
| | <Error Log> < Feceive

| 1 <Operation Log>
<Control Log»
[ 1 <Comrmunication Log»
[ 1 <ersion Select All

| | <Communication Specificatic

Cancel

Fetching Control Log in WINCAPSII

To fetch the control log from the flash memory, you need to check the flash
memory beforehand.

NOTE: Checking the flash memory is possible only with control log. It has no
effect on sending/receiving other data.
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10.7.9 Saving Control Log to Floppy Disks

If you fetch log data with the FDD function, the control log will also be saved
onto the floppy disk. For details, refer to the OWNER'S MANUAL, "Setting-up."

To fetch the control log from the flash memory, press [F7 SavelLog] on the
controller log menu, then select "Enable" option, making the Saving of control
log possible.

Mg o B K- Joint WOTO|[ 12

Control log save setting

@ Save control log from flash area

("~ Disahle

(e Enable

Cancel | 0K |

[Fi1]

Disable : default Enable: from flash area ﬂR) @

o o | ]

Enabling Control Log Saving

NOTE: When the controller starts, the parameter for saving the control log in
the flash area is set to Disable.
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The purpose of this manual is to provide accurate information in the handling and operating of the
robot. Please feed free to send your comments regarding any errors or omissions you may have
found, or any suggestions you may have for generally improving the manual.
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